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What is PSpice?

PSpice1 is a simulation program that models the behavior of a circuit containing any mix of 
analog and digital devices. You can think of PSpice as a software-based breadboard of your 
circuit that you can use to test and refine your design before ever touching a piece of 
hardware.

Because the analog and digital simulation algorithms are built into the same program, PSpice 
simulates mixed-signal circuits with no performance degradation because of tightly coupled 
feedback loops between the analog and digital sections.

PSpice can perform the following types of analyses:

■ AC, DC, and transient analyses, so you can test the response of your circuit to different 
inputs

■ Parametric, Monte Carlo, and sensitivity/worst-case analyses, so you can see how your 
circuits behavior varies with changing component values

■ Digital worst-case timing analysis to help you find timing problems that occur with only 
certain combinations of slow and fast signal transmissions

Models

PSpice includes model libraries that feature over 15,000 analog and 1,600 digital models of 
devices manufactured in North America, Japan, and Europe. Among these libraries are 
numerous models with parameters that you can tweak for a given device. These include 
independent temperature effects.

PSpice also supports analog and digital behavioral modeling, so you can describe functional 
blocks of circuitry using mathematical expressions and functions.

The range of models built into PSpice include not only those for resistors, inductors, 
capacitors, and bipolar transistors, but also the following:

1. Depending on the license and installation, either PSpice or PSpice Simulator is installed. However, all 
information about PSpice provided in this manual is true for PSpice Simulator.
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■ transmission line models, including delay, reflection, loss, dispersion, and crosstalk

■ nonlinear magnetic core models, including saturation and hysteresis

■ eight MOSFET models, including BSIM4 version 4.1, BSIM3 version 3.2, and EKV 
version 2.6

■ five GasFET models, including Parker-Skellern and TriQuints TOM2 model

■ IGBTs

■ digital components with analog I/O models

Related Topics

What is Probe?

After completing the simulation, PSpice plots the waveform results so you can visualize the 
circuits behavior and determine the validity of your design. You can use the waveform analysis 
features of PSpice to visually analyze and interactively manipulate the waveform data 
produced by circuit simulation. This built-in waveform analyzer is referred to as Probe.

Probe uses high-resolution graphics so you can view the results of a simulation both on the 
screen and in printed form. On the screen, waveforms appear as plots displayed in Probe 
windows within the PSpice workspace.

In effect, waveform analysis is a software oscilloscope. Performing a PSpice simulation 
corresponds to building or changing a breadboard, and performing waveform analysis 
corresponds to looking at the breadboard with an oscilloscope. Taken together, simulation 
and waveform analysis is an iterative process. After analyzing simulation results, you can 
refine your design and simulation settings and then perform a new simulation and waveform 
analysis.

For information 
about…

Click this topic…

What Probe is… What is Probe?

The types of 
analyses you can 
run with PSpice …

Types of analyses you can run with PSpice

More resources and 
training for PSpice 
…

Additional sources of information about PSpice
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With waveform analysis you can:

■ view simulation results in multiple Probe windows

■ compare simulation results from multiple circuit designs in a single Probe window

■ display simple voltages, currents, power, and noise data

■ display complex arithmetic expressions that use the basic measurements

■ display Fourier transforms of voltages and currents, or of arithmetic expressions 
involving voltages and currents

■ display analog and digital waveforms simultaneously with a common time base (for 
mixed analog/digital simulations)

■ add text labels and other annotation symbols for clarification

What you can plot in Probe depends on the types of analyses you run. Bode plots, phase 
margin, derivatives for small-signal characteristics, waveform families, and histograms are 
only a few of the possibilities. You can also plot other waveform characteristics such as rise 
time versus temperature, or percent overshoot versus component value.

PSpice generates two forms of output: the simulation output file and the waveform data file. 
The calculations and results reported in the simulation output file act as an audit trail of the 
simulation. However, the graphical analysis of information in the waveform data file is the 
most informative and flexible method for evaluating simulation results. The waveform data file 
is used by Probe to generate the waveforms displayed in the PSpice workspace.
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Related Topics

Types of analyses you can run with PSpice

Basic analyses

Click any of the following analysis types for more information:

■ AC sweep and noise 

■ DC sweep & other DC calculations 

■ Transient and Fourier

Advanced multi-run analyses

The multi-run analyses-parametric, temperature, Monte Carlo, and sensitivity/worst-case-
result in a series of DC sweep, AC sweep, or transient analyses, depending on which basic 
analyses you enabled.

Click any of the following analysis types for more information:

■ Parametric and temperature

■ Monte Carlo and sensitivity/worst-case

■ Frequency Response Analysis

For information 
about…

Click this topic…

How to view 
simulation results…

Viewing results

How to configure 
the display of 
simulation results…

Configuring PSpice Display of Simulation Results

Using and 
configuring Probe 
windows…

Using Probe windows
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AC sweep and noise

These AC analyses evaluate circuit performance in response to a small-signal alternating 
current source. The table below summarizes what PSpice calculates for each AC analysis 
type.

Caution

To run a noise analysis, you must also run an AC sweep analysis.

DC sweep & other DC calculations

These DC analyses evaluate circuit performance in response to a direct current source. The 
table below summarizes what PSpice calculates for each DC analysis type.

For this AC 
analysis...

PSpice computes this...

AC sweep Small-signal response of the circuit (linearized around the bias 
point) when sweeping one or more sources over a range of 
frequencies. Outputs include voltages and currents with 
magnitude and phase; you can use this information to obtain 
Bode plots.

Noise For each frequency specified in the AC analysis: 

■ Propagated noise contributions at an output net from every 
noise generator in the circuit 

■ RMS sum of the noise contributions at the output 

■ Equivalent input noise

For this DC 
analysis...

PSpice computes this...

DC sweep Steady-state voltages, currents, and digital states when 
sweeping a source, a model parameter, or temperature over a 
range of values

Bias point detail Bias point data in addition to what is automatically computed in 
any simulation

DC sensitivity Sensitivity of a net or part voltage as a function of bias point
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Transient and Fourier

These time-based analyses evaluate circuit performance in response to time-varying 
sources. The table below summarizes what PSpice calculates for each time-based analysis 
type.

Caution

To run a Fourier analysis, you must also run a transient analysis.

Parametric and temperature

For parametric and temperature analyses, PSpice steps a circuit value in a sequence that you 
specify and runs a simulation for each value. The table below shows the circuit values that 
you can step for each kind of analysis.

Small-signal DC 
transfer

Small-signal DC gain, input resistance, and output resistance 
as a function of bias point

For this time-based 
analysis...

PSpice computes this...

Transient Voltages, currents, and digital states tracked over time 

For digital devices, you can set the propagation delays to 
minimum, typical, and maximum. If you have enabled digital 
worst-case timing analysis, then PSpice considers all possible 
combinations of propagation delays within the minimum and 
maximum range

Fourier DC and Fourier components of the transient analysis results

For this 
analysis...

You can step one of these...
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Monte Carlo and sensitivity/worst-case

Monte Carlo and sensitivity/worst-case analyses are statistical. PSpice changes device 
model parameter values with respect to device and lot tolerances that you specify, and runs 
a simulation for each value. The table below summarizes how PSpice runs each statistical 
analysis type.

Frequency Response Analysis

Frequency Response Analysis is typically used to get frequency response of the non-linear 
switching circuits having varying operating point. This analysis injects transient signals into 

Parametric ■ global parameter

■ model parameter

■ component value 

■ DC source 

■ operational temperature

Temperature ■  operational temperature

For this 
statistical 
analysis...

PSpice does this...

Monte Carlo For each simulation, randomly varies all device model 
parameters for which you have defined a tolerance

Sensitivity/worst-
case

Computes the probable worst-case response of the circuit in 
two steps:

1. Computes component sensitivity to changes in the device 
model parameters. This means PSpice varies device model 
parameters in a non-random manner for which you have 
defined a tolerance, one at a time for each device and runs 
a simulation with each change. 

2. Sets all model parameters for all devices to their worst-case 
values (assumed to be at one of the tolerance limits) and 
runs a final simulation.
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the loop of interest and then extracts frequency data using Fourier analysis to plot gain/phase 
response.

Following options have been added in Capture – PSpice flow to enable Frequency Response 
Analysis:

■ MINSIMPTS

Specifies minimum number of time points used for a transient simulation. More the 
number of points better would be the output resolution.

To use MINSIMPTS, add the following comment text on the Capture Schematic:

@PSpice:

.options MINSIMPTS=1000

■ .PROBE64 P(<>)

Writes parameter defined using .PARAM command on the probe.

To use .PROBE64 command, add the following comment text on the Capture Schematic:

@PSpice:

.PROBE64 P(FREQ)

Note: The text following @PSpice: is treated as SPICE directive.

For more information on the usage of MINSIMPTS option and .PROBE64 command in 
Frequency Response Analysis, see the example at <Installation Directory> 
\tools\pspice\capture_samples\anasim\fra.

Files used by PSpice (input files)

To simulate your design, PSpice needs to know about:

■ the parts in your circuit and how they are connected

■ what analyses to run

■ the simulation models that correspond to the parts in your circuit

■ the stimulus definitions to test with

This information is provided in various data files. 
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Some of these are generated by schematic editors1, others come from libraries, and still 
others are user-defined.

Files Generated by Schematic Editors or Design Entry Programs

Capture is a design entry program in which you need to prepare your circuit for simulation. 
This means:

■ placing and connecting part symbols

■ defining component values and other attributes

■ defining input waveforms

■ enabling one or more analyses

■ marking the points in the circuit where you want to see simulation results

For more information about designing circuits with Capture, see their respective online helps.

When you begin the simulation process, the design entry programs first generate files 
describing the parts and connections in your circuit. These files are the netlist file and the 
circuit file that PSpice reads before doing anything else. 

The netlist file contains a list of the device names and their values, and the connections 
between the devices. The name that design entry programs generate for this file is 
DESIGN_NAME.net. The netlist file is located in the directory:

<project_directory>\worklib\<design_name>

sp_sim_1\

The circuit file contains commands describing how to run the simulation. This file also refers 
to other files that contain netlist, model, stimulus, and any other user-defined information that 
apply to the simulation. The name that the design entry programs generate for this file is 
PROFILE_name.cir.

Other Input Files

Before starting the simulation, PSpice needs to read other files that contain simulation 
information for your circuit. These are model files, and if required, stimulus files and include 
files. 

1. Schematic editor or design entry programs refer to OrCAD Capture.
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Related Topics

Model libraries

A model library is a file that contains the electrical definition of one or more parts. PSpice uses 
this information to determine how a part will respond to different electrical inputs. 

These definitions take the form of either a:

■ model parameter set, which defines the behavior of a part by fine-tuning the underlying 
model built into PSpice, or

■ subcrcuit netlist, which describes the structure and function of the part by interconnecting 
other parts and primitives

The most commonly used models are available in the PSpice model libraries shipped with 
your programs. The model library names have a .LIB extension.

Stimulus files

A stimulus file contains time-based definitions for analog and/or digital input waveforms. You 
can create a stimulus file using a standard text editor, to create the definition (a typical file 
extension is .STM).

Note: Not all stimulus definitions require a stimulus file. In some cases, like DC and AC 
sources, you must use a schematic symbol and set its properties.

For information 
about

Click this topic…

What model 
libraries are

Model libraries 

What stimulus files 
are

Stimulus files 

What include files 
are

Include files 

Preparing and 
configuring input 
files

Preparing and configuring input files 
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Include files

An include file is a user-defined file that contains:

■ PSpice commands, or 

■ supplemental text comments that you want to appear in the PSpice output file

You can create an include file using any text editor, such as Notepad. Typically, include file 
names have a .INC extension.

Preparing and configuring input files

You must first prepare the circuit design using Capture as the primary design entry program. 
Entering the design in Capture is the most efficient way to draw up the circuit and define the 
various parameters required for simulation. Once the circuit is entered in the design entry 
programs, you can configure the input files for analysis by PSpice.

Along with the netlist and circuit files generated by the design entry programs, PSpice 
searches model libraries, stimulus files, and include files for any information it needs to 
complete the definition of a part or to run a simulation.

How you configure your model libraries and other files determines the way PSpice uses those 
files. Much of the configuration is set up for you automatically. However, you can do the 
following yourself:

■ add and delete files from the configuration

■ change the scope of a file: that is, whether the file applies to one profile only, one design 
only (local) or to any design (global)

■ change the search order

For more detailed information about designing circuits and configuring files, see the Capture 
Help.

Files generated by PSpice (output files)

After reading the circuit file, netlist file, model libraries, and any other required inputs, PSpice 
starts the simulation. As simulation progresses, PSpice saves results to two files-the 
waveform data file and the PSpice output file.
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Waveform data file

The waveform data file contains simulation results that can be displayed graphically. PSpice 
reads this file automatically and displays waveforms reflecting circuit response at nets, pins, 
and parts that you marked in your schematic (cross-probing). You can set up your design so 
PSpice displays the results as the simulation progresses or after the simulation completes.

There are two ways to add waveforms to the display:

■ from within PSpice, by specifying trace expressions

■ from within the design entry programs, by placing markers for cross-probing

After PSpice reads the data file and displays the initial set of results, you can add more 
waveforms and perform post-simulation analysis of the data.

PSpice output file

The PSpice output file is an ASCII text file that contains:

■ the netlist representation of the circuit

■ the PSpice command syntax for simulation commands and options (such as the enabled 
analyses)

■ simulation results

■ warning and error messages for problems encountered during read-in or simulation

Its content is determined by:

■ the types of analyses you run

■ the options you select for running PSpice

■ the simulation control symbols (like VPRINT1 and VPLOT1) that you place and connect 
to nets in your design

Documentation

To access online documentation, you must open the Cadence Help window.

1. From the programs folder in the Windows Start menu, choose PSpice for TI 2020 – 
PSpice for TI 2020 Help.

2. From the Library pane, click the PSpice category to show the documents in the category.
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3. Double-click a document title to open that document.

You can also open PSpice specific documents by choosing Help – Documentation from the 
PSpice window.

Additional sources of information about PSpice

Recommended textbooks

Many textbooks and technical articles have been written in several languages about how to 
use PSpice when doing circuit analysis. The following is a brief list of some useful resources.

■ Goody, Roy W., PSpice for Windows, A Circuit Simulation Primer, Prentice-Hall, 1995

■ Goody, Roy W., PSpice for Windows, Vol. II, Operational Amplifiers & Digital Circuits, 
Prentice-Hall, 1996.

■ Herniter, Marc E., Schematic Capture with PSpice, Macmillan, 1994.

■ Kielkowski, Ron, Inside SPICE, Overcoming the Obstacles of Circuit Simulation, 
McGraw-Hill, 1994.

■ Kielkowski, Ron, SPICE, Practical Device Modeling, McGraw-Hill, 1995.

■ Tuinenga, Paul W., Spice, A Guide to Circuit Simulation & Analysis Using PSpice, 2nd 
Ed., Prentice-Hall, 1992.
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PSpice is a mixed analog/digital electrical circuit design simulator that can calculate the 
behavior of analog-only, mixed analog/digital, and digital-only circuit designs with speed and 
accuracy. PSpice simulates mixed analog/digital circuit designs, calculates voltages and 
currents of the analog devices and nodes, and calculates the states of digital nodes (nodes 
connected to digital devices only).

Creating designs for simulation

In order to simulate a design with PSpice that is created in the design entry programs, 
Capture, you must begin the project as an analog type intended for simulation. Existing 
projects in the design entry programs cannot be simulated without special modifications.

To create a new project for simulation

1. From the File menu in Capture’s Project Manager, point to New and select Project.

The New Project dialog box appears.

2. In the Name text box, enter the name for the new project.

3. Under the Create a New Project Using frame, select Analog or Mixed-Signal Circuit 
Wizard.

Note: You must create a project (not a design) and select the Analog or Mixed-Signal 
Circuit Wizard option in order to be able to simulate the new design with PSpice.

4. In the Location text box, enter the path where you want the new project files to be stored, 
or use the Browse button to locate the directory.

5. Click OK.

6. Enter any special libraries to be included, if necessary, and click Finish to create the new 
project directory and open the schematic page editor.

A design that is targeted for simulation has:

■ parts for which there are simulation models available and configured 

■ sources of stimulus to the circuit 
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The part libraries for PSpice are in the PSpice subfolder in the tools\Capture\Library 
directory in your main installation directory. Each part must have a PSPICETEMPLATE 
property in order to netlist correctly for use with PSpice.

When creating designs for both simulation and printed circuit board layout, some of the parts 
you use are for simulation only (that is, simulation stimulus parts like voltage sources), and 
some of the parts you use have simulation models that only model some of the pins of a real 
device.

The parts that are to be used for simulation, but not for board layout, have a 
PSPICEONLY=TRUE property.

You can add this (or any) property to your own custom parts to make them simulation-only.

Placing stimulus sources

Parts for stimulus sources for simulation are in the SOURCE.OLB part library. You can place 
a source in the design as you would any other part. 

Creating a simulation netlist

A netlist is the connectivity description of a circuit, showing all of the components, their 
interconnections, and their values. When you create a simulation netlist from Capture, that 
netlist describes the current design.

The flat netlist is generated for all levels of hierarchy, starting from the top, regardless of 
whether you are pushed into any level of the hierarchy. Flat netlists are most commonly used 
as input to PCB layout tools. The flat simulation netlist format for PSpice contains device 
entries for all parts on a subcircuit (child) schematic multiple times, once for each instance of 
the hierarchical part or block used.

Creating the netlist

You can generate a simulation netlist in one of two ways: 

■ from Capture’s Project Manager by using the Create Netlist command under the Tools 
menu. 

or 

■ directly from within Capture by using the Create Netlist command under the PSpice 
menu
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During the netlist process, Capture creates files with different extensions: the .NET file 
contains the netlist; the .ALS file contains alias information for cross-probing.

Note: For detailed information about generating simulation netlists from design entry 
programs, refer to Capture User Guide.
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Setting up analyses

Unless you intend to run the simulation using a circuit (.CIR) file, you must create a simulation 
profile (or edit an existing one) before you can set up a PSpice simulation. See Creating a 
new simulation profile for more information.

To set up a PSpice simulation:

1. From design entry program PSpice menu, choose New Simulation Profile.

Note: In order to access the PSpice menu and set up simulations, you must be working 
with a PSpice project in the design entry program. The project type is defined when you 
begin a new project.

2. In the Simulation Settings dialog box, click the Analysis tab.

3. Make your selections. The options are:

❑ Setting up an AC analysis

❑ Setting up a parametric analysis 

❑ Setting up the loading of bias points 

❑ Setting up a sensitivity analysis 

❑ Setting up the saving of bias points 

❑ Setting the temperature 

❑ Setting up a DC analysis 

❑ Setting the bias point detail 

❑ Setting up a Monte Carlo/worst-case analysis 

❑ Setting digital options 

❑ Setting up a transient analysis 

4. Click OK. 

Setting up an AC analysis

The AC analysis calculates the small-signal frequency response of the circuit (linearized 
around the bias point) over a range of frequencies. 
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To set up an AC analysis

1. In the Simulation Settings dialog box, click the Analysis tab.

2. From the Analysis type list, select AC Sweep/Noise.

3. From the Options list, select General Settings.

4. In the AC Sweep Type frame, choose either Linear or Logarithmic. (If Logarithmic, also 
select Decade or Octave.) Enter the start frequency, end frequency, and points in the text 
boxes.

5. To have noise analysis enabled, under Noise Analysis, select the Enabled check box. 
Enter the output voltage, I/V source, and interval in the text boxes. 

6. Click OK. 

To run the active simulation

1. From the Simulation menu, choose Run.

Setting up the loading of bias points

The Load Bias Point analysis option includes a .LOADBIAS statement in the circuit file and 
loads the contents of the bias point file. Normally the bias point file is produced by a previous 
circuit simulation using the Save Bias Points option. 

This option is available for the Time Domain (Transient), DC Sweep, and Bias Point analyses.

To set the bias load point

In the Simulation Settings dialog box, click the Analysis tab. 

1. From the Analysis type list, select Time Domain (Transient), DC Sweep, or Bias Point.

2. From the Options list, select Load Bias Point.

3. In the Load Bias Information from filename text box, enter the name of a file that contains 
a .LOADBIAS statement. 

4. Click OK.

To run the active simulation

1. From the Simulation menu, choose Run.
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Setting up the saving of bias points

The Save Bias Point analysis option inserts a .SAVEBIAS statement into the circuit file, and 
the bias point node voltages for the specified analysis (DC, OP, or TRAN) is saved to the file 
you specify. 

To set the save bias load point

1. In the Simulation Settings dialog box, click the Analysis tab. 

2. From the Analysis type list, select Time Domain (Transient), DC Sweep, or Bias Point.

3. From the Options list, select Save Bias Point.

4. In the Save Bias Information in Filename text box, enter a file name in which to save the 
bias point information. 

5. Under Options, type values in the text boxes for when to save bias information during the 
analysis:

❑ Primary Sweep value

❑ Secondary Sweep value

❑ Parametric Sweep value

❑ Monte Carlo options

❑ Temperature Sweep temperature

6. Under Options, select Do Not Save Subcircuit Voltages and Currents if you do not want 
to save the node voltages and currents for subcircuits. 

7. Click OK. 

To run the active simulation

1. From the Simulation menu, choose Run.

Setting up a DC analysis

The DC analysis performs a DC sweep. The DC sweep analysis calculates the circuit’s bias 
point over a range of values. 
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To set up the DC Sweep

1. In the Simulation Settings dialog box, click the Analysis tab.

2. From the Analysis type list, select DC Sweep.

3. From the Options list, select Primary Sweep.

4. Under Sweep variable, choose Voltage source, Current source, Global parameter, Model 
parameter, or Temperature. 

5. Under Sweep type, choose Linear, Logarithmic, or Value list. (If Logarithmic, also select 
Decade or Octave.)

6. Click OK. 

To run the active simulation

1. From the Simulation menu, choose Run.

Setting up a Monte Carlo/worst-case analysis

Monte Carlo/Worst Case analyses vary the lot or device tolerances of devices between 
multiple runs of an analysis (DC sweep, AC sweep, or transient). 

You can run either a Monte Carlo or a worst-case analysis, but not both at the same time. 
Before running either analysis, you must set up the device and lot tolerances of the model 
parameters to be investigated.

To set the Monte Carlo/Worst Case options

1. In the Simulation Settings dialog box, click the Analysis tab.

2. From the Analysis type list, select DC Sweep, AC Sweep/Noise, or Time Domain 
(Transient).

3. From the Options list, select Monte Carlo/Worst Case.

4. Choose either Monte Carlo or Worst-case/Sensitivity. 

5. In the Output Variable text box, type the output variable, using the following format:

V(<net name> [,<net name>]) 
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where <net name> must be a fully qualified net name. For example, V(sense) 
represents the voltage at a net, and V(a,b) represents the output voltage across two nets 
a and b.

6. Enter the Monte Carlo or Worst-case/Sensitivity options as described below.

7. Click OK.

Monte Carlo options

You can set the following options:

❑ Number of runs 

❑ Use distribution and custom distributions with the Distributions button 

❑ In the Random number seed text box, type an odd integer ranging from 1 to 32767.

❑ In the Save data from list, select one of the following:

Worst-case/Sensitivity options

1. From the Vary Devices That Have list, select Vary both DEV and LOT, Vary DEV, Vary 
LOT. 

2. In the Limit devices to type(s) text box, type a list of devices to include in the analysis.

3. Select the Save data from each sensitivity run check box to save data from each 
sensitivity run.

<none>

All Forces all output to be generated, including the nominal run.

First Generates output only during the first n runs. Type the value for 
n in the Runs text box.

Every Generates output every nth run. Type the value for n in the 
Runs text box.

Runs (list) Performs an analysis and generates output only for listed runs. 
Up to 25 values can be specified in the Runs text box. Prints out 
at the beginning of each run the model parameter values 
actually used for each component during that run.
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Output file options

1. Click the More Settings button.

2. From the Find list, select one of the following collating functions: 

3. Under Worst-Case direction, choose either Hi or Low.

4. Select the List model parameter values check box to produce a list of the model 
parameters actually used for each run.

History support options

1. Click the MC Load/Save button.

2. To enable saving of the randomly generated model parameter values for each run, 
complete the following steps.

a. In the Load/Save Monte Carlo Parameter File dialog box, select the Save parameter 
values in the filename check box. 

b. In the text box that is enabled, specify the name and the location of the file in which 
the parameter data is to be saved. If required, you can use the Browse button to 
navigate to the required location. 

The model parameter values are saved in a Monte Carlo parameter (.mcp) file. When 
you simulate the design, a .mcp file with the complete history of variation of parameter 
values with in the tolerance range will be generated.

3. To reuse model parameter values generated and saved during a previous Monte Carlo 
analysis, complete the following sequence of steps.

YMAX Finds the greatest difference in each waveform from the 
nominal run.

MAX Finds the maximum value of each waveform.

MIN Finds the minimum value of each waveform.

RISE_EDGE Finds the first occurrence of the waveform crossing above the 
threshold value. Type a threshold value in the Threshold value 
text box.

FALL_EDGE Finds the first occurrence of the waveform crossing below the 
threshold value. Type a threshold value in the Threshold value 
text box.
June 2020 37 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



PSpice Help
Preparing your design for simulation
a. In the Load/Save Monte Carlo Parameter File dialog box, select the Load parameter 
values in filename check box.

b. In the text box that is enabled, specify the name and the location of the .mcp file 
from which the parameter data is to be read. You can use the Browse button to 
navigate to the required location.

When you now simulate the circuit, all the parameter values stored in the .mcp file will 
be reused during the simulation.

4. Click OK to save your settings. 

To run the active simulation

1. From the Simulation menu, choose Run.

Setting the bias point detail

The Bias Point analysis saves detailed bias point information to the simulation output file.

The information reported to the output file includes the following:

❑ a list of all the analog node voltages

❑ a list of all the digital node voltages

❑ the currents through all the voltage sources, and their total power

❑ a list of the small-signal parameters for all the devices

To save detailed bias point information to the output file

1. In the Simulation Settings dialog box, click the Analysis tab. 

2. From the Analysis type list, select Bias Point. 

3. Under Output File Options, select any of the following that you want saved to the output 
file:

❑ Include detailed bias point information for nonlinear controlled sources and 
semiconductors 

❑ Perform Sensitivity analysis 

❑ Calculate small-signal DC gain 
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4. Click OK.

To run the active simulation

1. From the Simulation menu, choose Run.

Setting digital options

Set digital options for DC analyses. 

To set the digital options

1. In the Simulation Settings dialog box, click the Options tab. 

2. From the Category list, select Gate-level Simulation.

3. Under Timing Mode, choose Minimum, Typical, Maximum, or Worst-case (min/max).

4. Select Suppress simulation error messages to not include error messages in the 
waveform data file generated for this simulation.

5. From the Initialize All Flip-Flops To list, select X, 0, or 1. 

6. In the Default I/O level for Interfaces box, enter a default propagation delay mode.

7. Click OK. 

To run the active simulation

1. From the Simulation menu, choose Run.

Setting up a parametric analysis

A parametric analysis performs a sweep analysis while varying a global parameter. The 
simulator performs a series of simulations; there is one for each value of the parameter. All 
expressions in the circuit are re-evaluated with the new parameter value at the beginning of 
each run. 

To set the parametric options

1. In the Simulation Settings dialog box, click the Analysis tab.
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2. From the Analysis type list, select Time Domain (Transient), DC Sweep, or AC Sweep/
Noise to use as the basic analysis.

3. Under Options, select Parametric Sweep.

4. Under Sweep variable, choose a variable to sweep during the analysis:

❑ Voltage source

❑ Current source

❑ Global parameter

❑ Model parameter

❑ Temperature

5. Under Sweep type, choose one of the following:

❑ Linear

❑ Logarithmic: Decade or Octave

❑ Value list

6. Under Sweep type, the values in the Start Value and End Value text boxes vary 
depending upon which sweep variable type you select. The Start Value can be greater or 
less than the End Value. 

7. Click OK.

To run the active simulation

1. From the Simulation menu, choose Run.

Setting up a sensitivity analysis

Performs a DC sensitivity analysis. One or more output variables can be specified. The 
<output variable>, if it is a current, is restricted to be current through a voltage source. 

Device sensitivities are provided for the following device types only: 

❑ resistors

❑ independent voltage and current sources

❑ voltage and current-controlled switches
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❑ diodes

❑ bipolar transistors

To set the sensitivity analysis

1. In the Simulation Settings dialog box, click the Analysis tab. 

2. From the Analysis type list, select DC Sweep.

3. From the Options list, select Monte Carlo/Worst Case.

4. Choose Worst-case/Sensitivity. 

5. In the Output variable text box, type an output variable, using the following format:

V(<net name> [,<net name>])

where <net name> must be a fully qualified net name. It has the form such as: V(sense), 
the voltage at a net; or a form such as: V(a,b), the output voltage across two nets a and b.

6. Click OK. 

To run the active simulation

1. From the Simulation menu, choose Run. 

Setting the temperature

Set the temperature to specify the temperature or list of temperatures at which all analyses 
are performed. The temperatures are in degrees Centigrade. If more than one temperature is 
given, then all analyses are done for each temperature. 

You can type either a single value for the Temperature box, or a list of temperatures. When a 
list is typed, the circuit is simulated multiple times, once for each temperature in the list. 
Running an analysis at multiple temperatures can also be done as a parametric analysis. With 
parametric analysis, the temperatures can be specified either by list or by range and 
increments within the range. 

The default temperature for simulation is 27 degrees Celsius.

Note: The statistical analyses perform multiple runs, as does the Temperature analysis when 
a temperature range is typed. Conceptually, the Monte Carlo and worst case loops are inside 
the Temperature loop. However, since both temperature and tolerances effect the model 
parameters, the interaction of the two can become complicated. 
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Therefore, it is recommended that you should not use the Temperature analysis option to 
sweep multiple temperatures when using Monte Carlo or worst case analyses in a circuit. For 
the same reason, sweeping the temperature with a DC Sweep analysis while performing one 
of these statistical analyses is not recommend. In addition, putting tolerances on temperature 
coefficients is not recommended.

To set the temperature

1. In the Simulation Settings dialog box, click the Analysis tab.

2. From the Analysis type list, select a basic analysis type.

3. From the Options list, select Temperature (Sweep).

4. Choose one of the following:

❑ Run the simulation at temperature, to run the simulation at a constant temperature. 
Enter a value in the text box.

❑ Repeat the simulation for each of the temperatures, to repeat the simulation at 
different temperatures. Type a list of temperatures in the text box. 

5. Click OK. 

To run the active simulation

1. From the Simulation menu, choose Run. 

Setting up a transient analysis

A transient analysis calculates the behavior of the circuit over time. 

To set the transient option 

1. In the Simulation Settings dialog box, click the Analysis tab.

2. From the Analysis Type list, select Time Domain (Transient). 

3. In the Run to Time text box, type the length of the transient analysis. 

4. Select Run in resume mode if you want to pause the simulation after running for a 
specific time. You can enter the time to run in the RunFor text box of the PSpice toolbar. 
After the simulation pauses, you can change parameters and restart the simulation.
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5. To perform a Fourier Analysis, click the Output File Options button, then select (?) Enable 
Fourier. 

A Fourier Analysis performs a decomposition into Fourier components of the transient 
analyses results. 

6. Click OK. 

To run the active simulation

1. From the Simulation menu, choose Run. 

To check if a part has a simulation model defined

1. In schematic page editor, double-click a part on the schematic page. If a simulation 
model is available for a part, the part has:

❑ a PSPICETEMPLATE property specifying the PSpice simulation netlisting syntax for 
the part

❑ an Implementation type PSpice model and an Implementation property specifying 
the name of the model or subcrcuit

2. The PSPICETEMPLATE contains @MODEL somewhere along the line.

The simulation model specified by the Implementation property must be contained in a model 
library that is configured.

Simulating your circuit

Simulating performs a PSpice circuit analysis on the current design. This command 
automatically performs an Electrical Rule Check (DRC), and netlist generation. 

You must create a simulation profile (or edit an existing one) before you can set up a PSpice 
simulation. See Creating a new simulation profile for more information.

To simulate your circuit from within PSpice

1. From PSpice’s Simulation menu, choose Run. 

The simulation creates output files with a .OUT extension, and if the simulation 
completes successfully, produces a file with a .DAT extension. The output (.OUT) file 
contains bias point information, model parameter values, and so on. The .DAT file is the 
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waveform data file containing the simulation results to be displayed by PSpice. All 
viewpoint and sensor displays are automatically updated.

Note: Waveform data is only produced if you run an AC, DC, or a transient analysis.

2. A Probe window appears and displays the results of the simulation (if you have this 
option enabled in the Probe windows settings of your simulation profile). 

3. If there are errors during the simulation, from the View menu, choose Output File. 

To simulate your circuit from within Design Entry Programs

1. From the PSpice menu, choose Run.

Interacting with a simulation 

Overview

PSpice includes options for interacting with a simulation by changing certain runtime 
parameters in the course of the analysis. With the interactive simulation feature, you can do 
the following:

❑ Extend a transient analysis after TSTOP has been reached in order to achieve the 
desired results.

❑ Interrupt a bias or transient analysis, change certain runtime parameters, and then 
resume the simulation with the new settings.

❑ Schedule changes to certain runtime parameters so that they are made 
automatically during a simulation.

Note: You cannot interact with a simulation while it is running. You must first pause an 
active simulation in order to change a parameter, then resume it for the changes to take 
effect.

For more details about interactive simulation, click the Related Topics below.

Caution

The ability to interact with a simulation only applies to bias point and 
transient analyses. You cannot interact with other analysis types.
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What the various versions of PSpice support

The following table identifies what interactive functionality is available with each version of 
PSpice.

Related Topics

Extending a transient analysis 

Overview

Often, a long transient analysis will run to the completion time (TSTOP) without achieving the 
desired simulation results (achieving a steady state, for instance). To achieve better results, 
the value for TSTOP would have to be increased and the entire simulation would have to be 
rerun from the beginning. This was time-consuming and inefficient for large simulations.

You can set up a transient analysis so that it will pause automatically when it reaches the 
TSTOP value. Once paused, you can review the results and determine if the simulation 
should run longer. If desired, you can increase the value of TSTOP and resume the transient 
analysis from the point at which it paused, thus saving a good deal of processing time. 

Note: For more details about using TSTOP, see the PSpice Reference Guide.

PSpice version Interactive simulation functionality

PSpice ❑ extend transient analysis 

❑ interrupt a simulation, change parameters, and resume 
the simulation 

❑ schedule automatic changes to parameters during 
simulation

For information about Click this topic…

Extending a transient analysis Extending a transient analysis

Interrupting a simulation and 
changing runtime parameters

Interrupting a simulation

Scheduling changes to runtime 
parameters

Scheduling changes to runtime parameters
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To help clarify under what conditions simulations will either be terminated or paused, the 
following table explains the different behaviors of PSpice for particular simulation scenarios:

How the RunFor value for TSTOP controls the simulation

When you enter a value for TSTOP in the RunFor text box on the simulation toolbar in 
PSpice, you can control the simulation in various ways:

❑ If the RunFor text box is blank, the original value for TSTOP in the Simulation 
Profile will be used. The simulation will run to completion and then stop.

Simulation scenario Behavior of PSpice

Running a single 
transient simulation 
using a profile or a 
circuit file containing 
one circuit.

PSpice will stop (terminate) after a successful 
simulation if the RunFor text box is blank. -or- 
PSpice will pause if there is a value for RunFor, or 
if a convergence error occurs, allowing you to 
change certain runtime parameters and resume 
the analysis.

Running a single AC/DC 
simulation using a 
profile or a circuit 
file containing one 
circuit.

PSpice will stop (terminate) after a successful 
simulation. 

-or-

PSpice will pause if a convergence error occurs, 
allowing you to change certain runtime parameters 
and resume the analysis.

Running a single 
simulation with a 
profile or a circuit 
file containing outer 
loops.

PSpice will stop (terminate) after a successful 
simulation, or if a convergence error occurs.

Running a queued 
simulation.

PSpice will stop (terminate) after a successful 
simulation, or if a convergence error occurs.

Launching a new 
simulation when another 
one is already active 
in PSpice.

If the old simulation has completed, PSpice will 
load the new simulation and run it.

-or-

If the old simulation is running or paused, PSpice 
will prompt you to choose whether to run the new 
simulation instead, place it in the queue or cancel 
it.
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❑ If you enter a value in the RunFor text box, the RunFor value will override any value 
for TSTOP in the Simulation Profile. The simulation will run until it reaches the 
RunFor value and then pause.

❑ If the simulation is paused before RunFor (TSTOP) is reached, you can enter a new 
value in the RunFor text box, then click the Run toolbar button. PSpice will resume 
the simulation, run for the additional time specified (RunFor), and then pause again.

❑ If you pause a simulation, and want to restart it using the original value for TSTOP 
in the Simulation Profile, clear the RunFor text box and press the Pause button 
again.

Note: For more information about running and managing multiple simulations, click Running 
multiple simulations.

To extend a transient analysis

1. Click in the RunFor text box on the PSpice toolbar and enter a value for TSTOP.

2. Click the Run toolbar button to run the simulation.

The simulation will run and pause when it reaches the value you entered for TSTOP in 
the RunFor text box. (The original value for TSTOP in the simulation profile is overridden 
and ignored if you enter a value in the RunFor text box.)

3. Change any parameters you need to adjust. (See Interrupting a simulation.)

4. Change the value of TSTOP in the RunFor text box, if needed.

5. Click the Run toolbar button to resume the simulation.

The simulation will resume from the point at which it last paused, and then run for the 
amount of time specified in the RunFor text box, at which point it will pause again.

6. Repeat Steps 3 – 5 as needed.
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Interrupting a simulation 

Overview

You can interrupt (pause) a simulation, change certain runtime parameters, and then resume 
the simulation from the point at which it was paused using the new parameters. 

Caution

The new parameters are temporary values and are not saved in the 
simulation profile. However, they are logged in the output file so that you 
can refer to them later.

After you pause a simulation, you can change the following runtime parameters using the 
PSpice Runtime Settings dialog box:

❑ RELTOL

❑ ABSTOL

❑ VNTOL

❑ GMIN

❑ TSTOP

❑ TMAX

❑ ITL1

❑ ITL2

❑ ITL4

❑ Autoconvergence

❑ Enable Advanced Convergence Algorithm

Note: For more details about using these runtime parameters, see the PSpice Reference 
Guide.

The PSpice Runtime Settings dialog box will appear automatically whenever a simulation fails 
to converge. (In such cases, the simulation will be paused automatically.) It will also appear if 
you attach PSpice to a simulation that was paused in the background. (For more information 
about managing background simulations, click Using the Simulation Manager.)
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Caution

In cases where you have paused a simulation and intend to resume it, 
PSpice will only recognize changes you make in the PSpice Runtime 
Settings dialog box. Any changes you make to the Simulation Profile will 
not be applied until the simulation is restarted again from the beginning.

To interrupt a simulation and change parameters

1. In PSpice, from the Simulation menu, choose Edit Runtime Settings.

The PSpice Runtime Settings dialog box appears.

2. If you want to use the original value for a particular parameter, click the Use Original 
Value check box for that parameter. 

The original parameter values are derived from the simulation profile. By default, the Use 
Original Value check boxes are checked (enabled).

3. If you want to change one or more parameters, enter new values for each of the runtime 
parameters you want to change in the text boxes under the column Change To.

If a Change To text box is grayed out, uncheck the Use Original Value check box.
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4. Select Autoconverge to specify that PSpice should try to converge the simulation.

5. Click OK & Resume Simulation to resume the simulation with the new parameters.

Note: If you do not want to resume the simulation, but merely want to exit this dialog box and 
preserve the values you entered, click OK. If you run the simulation later, the new parameters 
will be applied. If you want to exit this dialog box without preserving the values, click Cancel.

Scheduling changes to runtime parameters 

Overview

In certain situations, you may want to predefine a set of values for a parameter and schedule 
these values to take effect at various time intervals during a long simulation. For instance, you 
may want to use a smaller time step value during periods where the input stimulus changes 
rapidly, but otherwise use a larger value.

You can set up automatic changes to certain runtime parameters that will occur at scheduled 
times during a simulation. By scheduling the changes, you don't have to interrupt the 
simulation manually, and can even run it in a batch mode in the background.

The following runtime parameters can be changed at scheduled times during a simulation. 
Note that these only apply to transient analysis; you cannot interact with other analysis types.

❑ RELTOL

❑ ABSTOL

❑ VNTOL

❑ GMIN

❑ ITL4

Note: For more details about using these runtime parameters, please see the PSpice 
Reference Guide.

PSpice command syntax for scheduling parameter changes

You can schedule parameter changes by entering them either in the Simulation Profile or in 
a text file using the new expression SCHEDULE, and then including that file in the simulation 
profile settings. 
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The expression SCHEDULE is a piecewise constant function (from time x forward use y) and 
takes the form:

SCHEDULE(x1,y1,x2,y2...xn,yn)

where x is the time value, which must be > 0, and y is the value of the associated 
parameter. You must include an entry for time=0.

When used with the .OPTION command, the syntax is as follows:

.OPTIONS <Parameter Name>={SCHEDULE(<time-value>, <parameter value>, <time-value>, 
<parameter value>, …)}

For example,

.OPTIONS RELTOL={SCHEDULE( 0s,.001,2s,.005)}

indicates that RELTOL should have a value of 0.001 from time 0 up to time 2s, and a 
value of 0.005 from time 2s and beyond (that is: RELTOL=.001 for t, where 0 < t < 2s, 
and RELTOL=.005 for t, where t < 2s).

To schedule changes to runtime parameters

1. Open a standard text editor (such as Notepad) and create a text file with the command 
syntax shown above, using the appropriate values for the different parameters.

2. In design entry program, open the design you want to simulate.

3. From the PSpice menu, choose Edit Simulation Profile.

4. Click the Configuration Files tab.

5. Click Include in the Category field.

6. Under the Filename text box, enter the name of the text file you created in Step 1, or click 
the Browse button to locate the file and enter the full path and filename.

7. Click the Add to Design button to include the file as part of the circuit.

8. Click OK.

When you run the simulation, the scheduled parameter changes will be included as part of 
the circuit file and the simulation will run to completion automatically.
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Related Topics

Running multiple simulations 

Overview

PSpice includes a Simulation Manager that provides enhanced control over how multiple 
simulations are processed. With the Simulation Manager, you can now control when 
particular simulations in a batch queue will actually be run. You can also preempt the current 
simulation to run another one first. Or, you can use the Simulation Manager to monitor the 
progress of a set of batch simulations that were set up and launched earlier. 

None of the earlier functionality of batch processing has been lost. With the Simulation 
Manager, you now have even greater control and flexibility in setting up multiple simulations.

For information about Click this topic…

Including files Include files settings for simulation 
profiles

Pausing a simulation manually 
to change parameters

Interrupting a simulation

Running multiple simulations in 
the background

Running multiple simulations
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Related Topics

Using the Simulation Manager 

Overview

The PSpice Simulation Manager provides a familiar, easy-to-use interface for controlling how 
multiple simulations are processed. 

The Simulation Manager allows you to do the following:

❑ add or delete simulations

❑ start, stop or pause simulations

❑ rearrange the order of the simulations in the queue

❑ attach PSpice to a simulation to make it the active display

❑ view the status and progress of simulations running in the background

For information about… Click this topic…

Using the Simulation Manager… Using the Simulation Manager

Setting up multiple simulations… Setting up multiple simulations

Starting, stopping, and pausing 
simulations…

Starting, stopping, and pausing 
simulations

Attaching PSpice to a simulation… Attaching PSpice to a simulation
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You can accomplish most of these functions by selecting the desired simulation in the list, 
then clicking on the appropriate toolbar button to execute the command. For detailed 
procedures on performing these tasks, see the Related Topics section below.

Note: For simulations that are queued in the Simulation Manager, the setting in the 
Simulation Profile to start Probe automatically is ignored. When a queued simulation runs to 
completion and finishes, it will not be loaded into Probe. You must do this manually if you want 
to see the results of that simulation.

Accessing the Simulation Manager

The Simulation Manager is invoked whenever you start a new simulation, either from PSpice 
or from a front-end design entry tool. Since it is active as long as a simulation is running in 
the background, you can also call up the Simulation Manager from the Windows system tray.

You can also launch the Simulation Manager by itself from the Windows Start menu. You do 
not need to have PSpice running in order to work with the Simulation Manager.

Understanding the menu commands

The main menu bar for the Simulation Manager is shown below. For a detailed description of 
a particular menu, click the name of that menu in the image.
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Related Topics

Understanding the Simulation Manager

Understanding the information presented by the Simulation Manager

Every job listed in the Simulation Manager will have a specific entry for Schedule, Status and 
Percent Complete. In addition, certain color-coded icons are shown to the left of each 
simulation file name to indicate their current state. A quick glance over the list of jobs will tell 
you immediately where any particular job is and how it will be processed. The following tables 
explain the meanings of the various categories and states.

For information about Click this topic…

Understanding the status of 
jobs in the queue

Understanding the Simulation Manager

What the various versions of 
PSpice support

Available functionality of the Simulation Manager

How the Simulation Manager 
handles errors

Error message handling by the Simulation 
Manager

Setting up multiple 
simulations

Setting up multiple simulations

Starting, stopping, and 
pausing simulations

Starting, stopping, and pausing simulations

Attaching PSpice to a 
simulation

Attaching PSpice to a simulation

Setting the default options 
for the Simulation Manager

Setting options in the Simulation Manager

Icon Explanation

The simulation is either in the queue and has not been run yet, 
or has been run to completion.

The simulation is currently running.

The simulation has been paused and is on hold, waiting to 
either be continued or stopped.
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The simulation has been stopped and is not completed.

Schedule column Explanation

queued The simulation is in the queue. It will be run in the order in which 
it is listed in the queue. (This is the default setting.)

running The simulation is currently running and ongoing status 
information is displayed.

on hold The simulation has been paused.

stopped The simulation has been run completely, or was stopped 
because of an error.

Note: You must manually restart a stopped simulation if you 
want it to run again at a later time.

Status column Explanation

not run The simulation has not been started yet. (This is the default 
setting.)

<status information> Basic status information about the progress of the analysis will 
be displayed for a simulation that is currently running.

paused The simulation has been paused either manually or 
automatically by the Simulation Manager. 

If you change the default option that automatically resumes 
paused simulations in the queue, then you must remember to 
manually resume a paused simulation if you want it to continue 
at a later time.

complete - no errors The simulation has run to completion and no errors were 
encountered.

errors The simulation ran partially but stopped automatically because 
errors were encountered.
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Available functionality of the Simulation Manager

What the various versions of PSpice support

The following table identifies what functionality in the Simulation Manager is available with 
each version of PSpice.

Error message handling by the Simulation Manager

How the Simulation Manager handles errors during simulation

Since each simulation that runs in the background runs independently, an error that occurs 
during one simulation will not prevent the remaining jobs in the queue from running 
subsequently, in order. The following common error conditions may arise, but these will not 
prevent the Simulation Manager from running the remaining simulations pending in the 
queue.

■ Simulation crash: If a simulation crashes for whatever reason, the Simulation Manager 
will stop receiving progress updates. After a certain period, the Simulation Manager will 
stop that simulation and will automatically start the next job in the queue.

■ Simulation pause: If a simulation pauses automatically and requires manual intervention 
to continue, the Simulation Manager will automatically start the next job in the queue.

■ Simulation stop: If a simulation stops automatically, the Simulation Manager will 
automatically start the next job in the queue.

Percent Complete 
column Explanation

<percentage> The percentage of completion for a simulation. This number 
increases as a simulation progresses.

PSpice version Functionality of Simulation Manager

PSpice ■ One simulation may be running and multiple simulations 
may be paused. 

■ The queue is run sequentially.
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Caution

You must manually restart a stopped or paused simulation if you want it 
to run again at a later time. You will not be able to shut down the 
Simulation Manager until all stopped and paused simulations have been 
deleted.

Setting up multiple simulations

Overview

With the Simulation Manager, you can set up any number of batch simulations to be run 
sequentially in the background while you do other work in PSpice. Each new simulation that 
you set up will be added to the bottom of the simulation queue and will be assigned the 
schedule category “queued”. It will be run after all other queued jobs ahead of it have been 
run. 

Once a job has been added, you can change its position in the queue, start, stop or pause it, 
or make other modifications to its status. See the Related Topics below for more details on 
modifying jobs in the Simulation Manager. 

To add a simulation to the queue

1. From the File menu, choose Add Simulation or click the Add Simulation button on the 
tabular. 

2. Locate the file (.SIM, .CIR) you wish to add to the queue.

Alternately, you can add a simulation to the queue by starting the PSpice simulation directly 
from within the front-end tool you are using, such as Capture.

Caution

If one simulation is already running in the Simulation Manager and you 
start another one, you will be prompted to direct the Simulation Manager 
in how to proceed with the new simulation. For more information about 
the different ways to handle this situation, click Setting options in the 
Simulation Manager.
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Related Topics

Starting, stopping, and pausing simulations 

Overview

In the Simulation Manager, you can easily manage the various batch simulations in the 
queue. The most fundamental controls that are provided are the ability to start a simulation, 
stop it, or pause it temporarily.

To start a simulation from the Simulation Manager

1. Select a simulation in the list.

2. From the Simulation menu, choose Run or click the Run Selected button on the toolbar.

To stop a simulation from the Simulation Manager

1. Select the simulation that is currently running.

2. From the Simulation menu, choose Stop or click the Stop Selected button on the toolbar.

To pause a simulation from the Simulation Manager

1. Select the simulation that is currently running.

2. From the Simulation menu, choose Pause or click the Pause Selected button on the 
toolbar.

For information about... Click this topic…

Starting, stopping, and pausing 
simulations...

Starting, stopping, and pausing simulations

Attaching PSpice to a 
simulation...

Attaching PSpice to a simulation

Setting the default options for 
the Simulation Manager...

Setting options in the Simulation Manager
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Attaching PSpice to a simulation 

A simulation that is running in the Simulation Manager will not be loaded into PSpice or 
displayed in Probe while it is running. This allows you to work on a different design in the 
PSpice application while a simulation is running in the Simulation Manager.

Note: If you start a new simulation from within PSpice while another is running in the queue 
in the Simulation Manager, the Simulation Manager must decide how to treat the new job. You 
will be prompted to choose whether you want the new job to preempt the current simulation 
and start running immediately. For more details, click Setting options in the Simulation 
Manager.

If you want to display a different simulation in PSpice by choosing from the list of jobs in the 
Simulation Manager, you can attach PSpice to a particular job in the queue.

To attach PSpice to a simulation

1. In the Simulation Manager, select the simulation you want to attach to PSpice.

2. From the View menu, choose Simulation Results.

The PSpice program will activate and the results of the simulation you selected will become 
the current display in Probe. If the simulation is currently running, you will be able to view the 
marching waveforms.

Setting options in the Simulation Manager 

Each time you add a new simulation while another one is running, the Simulation Manager 
must decide how to treat the new job. The default setting is to add the new simulation to the 
bottom of the queue and continue running whatever job is currently being simulated. 

You can change this default so that the Simulation Manager will start each new simulation 
immediately and either stop or pause whatever job is currently running. The options you can 
choose from are explained in the procedure below.

You can also choose to have the Options dialog box display each time you add a new 
simulation, or not show this anymore. If you disable the prompting, you can always enable it 
again using the following procedure.

In addition, you can define how paused simulations should be handled by the Simulation 
Manager. You can configure them to be resumed automatically after the previous simulation 
stops, or you can choose to leave them in a paused state until you manually resume them.
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To set the default options for the Simulation Manager

1. From the Tools menu, choose Options.

The Options dialog box appears.

2. In the top frame dealing with simulations that are already running, click the appropriate 
radio button for the option you wish to set.

Radio button… Function…

Display the 
simulation in the 
queue.

The simulation that is currently running will be displayed in 
PSpice. The new simulation will be added to the bottom of the 
queue and will be run after all other jobs in the queue have 
been run. (This is the default setting.)

Pause the current 
simulation and run 
the new one.

The simulation that is currently running will be paused. The new 
simulation will be started immediately.

Stop the current 
simulation and run 
the new one.

The simulation that is currently running will be stopped. The 
new simulation will be started immediately. You must remember 
to restart the stopped simulation later if you want it to run again.
June 2020 61 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



PSpice Help
Preparing your design for simulation
3. If you want the Options dialog box to appear as a reminder each time you add a new 
simulation, be sure to check the Always Prompt box. (The default setting is to enable this 
feature.)

4. In the bottom frame dealing with paused simulations, click the appropriate radio button 
for the option you wish to set.

5. Click OK to save the settings.

The Simulation Manager File menu

The File menu provides basic file management functions.

Radio button… Function…

Resume simulating. The first paused simulation in the list will automatically resume 
after the previous simulation has stopped. (This is the default 
setting.)

Wait for user 
intervention.

The Simulation Manager will not resume any paused 
simulations automatically. 

Note: If you enable this radio button, you must remember to 
intervene manually if you want paused simulations to resume 
later.

Menu command... Function…
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The Simulation Manager Edit menu

The Edit menu provides functions for modifying the list of jobs in the queue. Most of these 
commands are reproduced in the toolbar as well. For a description of the toolbar commands, 
click The Simulation Manager Toolbar.

The Simulation Manager View menu

The View menu provides controls for what is displayed in the Simulation Manager.

Add Simulation Opens a simulation file (.SIM) or circuit file (.CIR) and adds it to 
the queue. 

Shortcut: INS

<MRU list> Lists the most recently used file(s).

Exit Exits the Simulation Manager.

Menu command… Function…

Delete Deletes the selected file from the queue. 

Shortcut: DEL

Move Up Moves the selected file up one position in the queue.

Move Down Moves the selected file down one position in the queue.

Select All Selects all files in the queue.

Delete All Deletes all files in the queue.
June 2020 63 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



PSpice Help
Preparing your design for simulation
The Simulation Manager Simulation menu

Overview

The Simulation menu provides controls for how the different simulations are processed by the 
Simulation Manager.

Menu command… Function…

Simulation Results Displays the simulation results in PSpice for the selected 
simulation.

Output File Opens the output file for the selected simulation and displays it 
in PSpice.

Toolbar When checked, this enables the display of the Toolbar. (The 
default setting is enable the display.)

Status Bar When checked, this enables the display of the Status Bar. (The 
default setting is enable the display.)

Always On Top Keeps the Simulation Manager on top of all other open 
applications.
June 2020 64 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



PSpice Help
Preparing your design for simulation
The Simulation Manager Tools menu

Overview

The Tools menu allows you to change certain default settings used by the Simulation 
Manager when starting a simulation.

Menu command… Function…

Run Runs the selected simulation(s).

Pause Pauses the selected simulation(s).

Stop Stops the selected simulation(s).

Run Queued Items Runs all of the simulations that are queued. The simulations will 
run in the order in which they are listed in the queue.

Queue Selected Changes all selected simulations to "queued".

Reset Queue Resets any "done" simulations to "queued".

Edit Settings Opens the simulation profile for the selected simulation and 
allows you to change the analysis settings.

Menu command... Function…

Options Allows you to change certain default settings.

Customize Allows you to customize toolbars and commands.
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Related Topics

The Simulation Manager Toolbar

The Toolbar provides quick access to the most commonly used functions in the Simulation 
Manager. All of the buttons on the Toolbar have tooltips to help remind you of what they do – 
just pass the cursor over the button to see the tooltip.

For information 
about...

Click this topic…

Options that can be 
set in the 
Simulation 
Manager...

Setting options in the Simulation Manager

Toolbar button Function

Always On Top

Keeps the Simulation Manager on top of all other open 
applications.

Add Simulation

Adds a file to the queue. Shortcut: INS

Move Down arrow

Moves the selected file down one position in the queue.

Move Up arrow

Moves the selected file up one position in the queue.

Delete

Deletes the selected file from the queue. Shortcut: DEL
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Entering distributions

To enter your own distribution

1. Under Monte Carlo Options, click the Distributions button.

2. In the Distribution name text box, type a name for the distribution, then click Save to 
save the distribution with the current simulation profile.

3. In the Distribution curve values text box, type distribution curves, using the format:

Edit Simulation 
Profile

Opens the simulation profile for the selected simulation and 
allows you to change the analysis settings.

Run Queued Items

Runs all of the simulations that are queued. The simulations will 
run in the order in which they are listed in the queue.

Run Selected

Runs the selected simulation(s).

Stop Selected

Stops the selected simulation(s).

Pause Selected

Pauses the selected simulation(s).

View Simulation 
Results

Displays the simulation results in PSpice for the selected 
simulation.

View Output File

Opens the output file for the selected simulation and displays it 
in PSpice.
June 2020 67 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



PSpice Help
Preparing your design for simulation
(<deviation>,<probability>)

4. To remove a distribution from the current simulation profile, under Existing 
distributions, select the distribution name and click Delete.

5. Click OK to close the Distributions dialog box and return to the Simulation Settings dialog 
box.

For more information on distributions, refer to the .DISTRIBUTIONS section of the 
Commands chapter of the PSpice Reference Manual.

Using markers

You can place markers in your design to indicate the points for which you want to see 
simulation waveforms displayed in PSpice. You can place markers before or after simulation 
is done. 

When placed before simulation, markers can be used to limit results written to the waveform 
data file and to automatically display those traces in PSpice. After simulation results appear 
in PSpice, placing additional markers on the design automatically displays traces in the 
current Probe window.

Power markers allow you to measure the power dissipation of a particular device. You can use 
these markers in the same way you use current and voltage markers. Power markers are 
annotated with "W" and are placed on devices that have PSpice models. The corresponding 
power dissipation waveforms for the devices will be calculated and displayed in Probe.

Markers can be placed on subcrcuit nodes as well. This allows you to perform cross-probing 
between the front-end design entry tool and PSpice at the lower level circuits of a hierarchical 
design.

The available markers are as follows:

Waveform Markers menu command Advanced submenu 
command

voltage Voltage Level (not required)

digital signal Voltage Level (not required)

voltage 
differential

Voltage Differential (not required)

current Current Into Pin (not required)
June 2020 68 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



PSpice Help
Preparing your design for simulation
Caution

Quiescent power information will be shown only for devices with analog 
interface pins. It is not currently possible to determine the exact power 
consumption for devices with digital interface pins.

Limiting waveform data file size

When PSpice performs a simulation, it creates a waveform data file. The size of this file for a 
transient analysis is roughly equal to:

(# transistors) * (# simulation time points) * 24 bytes

The size for other analysis types is about 2.5 times smaller. For long runs, especially transient 
runs, this can generate waveform data files that are several megabytes in size. Even if this 
does not cause a problem with disk space, large waveform data files take longer to read in 
and take longer to display traces on the screen. You can limit the file size by suppressing part 
of the data from a transient run. For more details, click Suppressing data from a transient run.

You can also limit the waveform data file size by setting options that determine how much data 
is collected. For more details on these data collection options, click Setting data collection 
options.

dB Advanced dB Magnitude of Voltage 

dB Magnitude of Current

phase Advanced Phase of Voltage 

Phase of Current

group delay Advanced Group Delay of Voltage 

Group Delay of Current

real Advanced Real Part of Voltage 

Real Part of Current

imaginary Advanced Imaginary Part of Voltage 
Imaginary Part of Current

power Power Dissipation (not required)
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Setting data collection options

One reason that waveform data files are large is that, by default, PSpice stores all net 
voltages and device currents for each step (for example, time or frequency points). However, 
if you have placed markers on your schematic prior to simulation, PSpice saves only the 
results for the marked wires and pins.

To limit file size by setting collection options

1. Choose PSpice – Edit Simulation Profile to display the Simulation Settings dialog box.

2. Click the Data Collection tab.

3. In the Data Collection Options section, choose the desired option for each type of 
marker (Voltages, Currents, Power, Digital, Noise).

4. Select Save data in the CSDF format (.CSD) if you want the data to be stored in this 
format.

Note: By default, the probe data has an accuracy of 64-bit. You can change this to 32-
bit.

5. Click OK to close the Simulation Settings dialog box.

6. From the PSpice menu, point to Markers, then choose the marker type you want to place.

7. Point to the wires, pins or devices you wish to mark and click to place the chosen 
markers.

8. Right-click and select End Mode to stop placing markers.

9. From the PSpice menu, choose Run to start the simulation.

When the simulation is complete, the corresponding waveforms for the marked nodes or 
devices will be displayed in Probe.

Option Description

All All data will be collected and stored. (This is the default setting.)

All but Internal 
Subcircuits

All data will be collected and stored except for internal 
subcircuits of hierarchical designs (top level data only).

At Markers Only Data will only be collected and stored where markers are 
placed.

None No data will be collected.
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Suppressing data from a transient run

Long transient simulations create large waveform data files because PSpice stores many 
data points. You can suppress a part of the data from a transient run by setting the simulation 
analysis to start the output at a time later than 0. This does not affect the transient calculations 
themselves – these always start at time 0. This delay only suppresses the output for the first 
part of the simulation.

To limit file size by suppressing the first part of transient simulation output

1. Choose PSpice – Edit Simulation Profile to open the Simulation Settings dialog box.

2. Select the Analysis tab.

3. From the Analysis Type list, select the Time Domain (Transient) option.

4. In the Start saving data after text box, specify a delay time.

5. Click OK to close the Simulation Settings dialog box.

6. Choose PSpice – Run to start the simulation.

The simulation begins, but no data is stored until after the delay has elapsed.

Assigning marker colors

When you place markers, they are initially grey. Once PSpice completes the simulation and 
displays the marked traces, colors are automatically assigned to them. The color assigned to 
a marker will also be the color of its trace in PSpice. 

To assign a new marker color 

1. In PSpice, right-click a trace and choose Properties.

2. Select the color you want for the trace from the drop-down Color list.

3. Click OK.

The color you assign for the trace in PSpice will then be associated with the 
corresponding marker in schematic page.

Viewing results

Use PSpice to view and perform waveform analysis of the simulation results.
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To view results for the current design

1. From the PSpice menu, choose View Simulation Results. 

To automatically start PSpice after simulation

1. Choose PSpice – Edit Simulation Profile to display the Simulation Settings dialog for 
the currently active profile. 

2. Click the Probe Window tab, then select Display Probe window after simulation has 
completed. 

3. Select any other options you want to use. 

4. Click OK.

Viewing results as you simulate

You can configure PSpice to run automatically when the simulation has finished, or to monitor 
waveforms as the simulation progresses.

To start PSpice and monitor results during a simulation

1. To enable waveform monitoring, do the following:

❑ Choose PSpice – Edit Simulation Profile.

❑ Click the Probe Window tab, then select Display Probe window during simulation.

❑ Click OK.

2. From the PSpice menu, choose Run to start the simulation. PSpice starts automatically 
and displays one window in monitor mode.

3. In PSpice, select the waveforms to be monitored by using the Add Trace command on 
the Trace menu or by placing markers.

4. During a multiple run simulation (such as Monte Carlo, parametric or temperature), only 
the data for the first run is displayed. To view the curves for several runs:

❑ To close the data file, choose Close from the File menu, then choose Open from the 
File menu to reload it.

❑ Specify the data sections (runs) to load.

❑ Select the traces to monitor. Waveforms for all loaded sections are displayed.
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Configuring PSpice Display of Simulation Results

To configure what PSpice displays when it is started, choose PSpice – Edit Simulation 
Profile, click the Probe Window tab, and then select one the following options under the 
Show frame:

❑ All markers on open schematics

Displays the waveforms at the points on the design which have markers.

❑ Last plot

Restores the display characteristics from the last session of PSpice.

Viewing Monte Carlo histograms

Monte Carlo analysis is frequently used to predict yields on production runs of a circuit. You 
can display data derived from Monte Carlo waveform families as histograms. This is part of 
the performance analysis feature of PSpice.

The data file generated by a Monte Carlo analysis can become quite large. You can limit what 
is displayed and view just a particular node by placing a voltage probe marker at the desired 
node in the circuit, and then collect data for only that node.

To display a histogram

1. From PSpice’s Plot menu, choose Axis Settings.

2. Select the X Axis tab.

3. In the Processing Options frame, select the Performance Analysis check box.

4. Click OK.

5. From the Trace menu, select a measurement definition and a trace.

The histogram display appears.
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The Y axis is the percent of samples. The statistics for the histogram are shown along the 
bottom of the display. The statistics show the number of Monte Carlo runs, the number of 
divisions or vertical bars that make up the histogram, mean, sigma, minimum, maximum, 10th 
percentile, median, and 90th percentile.

Copying histogram data

You can use the copy function to transfer the raw histogram data points for a particular trace 
to the Windows clipboard. This allows you to save the data as a standard ASCII text file, or 
paste it directly into a report or other document for later reference.

To copy histogram data to the clipboard

1. Select the trace name in the histogram.
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2. From the Edit menu, choose Copy (or press Ctrl + C).

The histogram data points for the trace will be transferred to the Windows clipboard.

To copy the histogram display to the clipboard

1From the Window menu, choose Copy to Clipboard.

The histogram graph will be transferred to the Windows clipboard.

 

Defining part properties needed for simulation

The part properties Implementation and PSPICETEMPLATE (for simulation) may already 
be defined for your parts, or you may have to edit them yourself, depending on which method 
you used to create the parts. In addition, you can add other simulation-specific properties: 
PSPICEONLY, IO_Level, MNTYMXDLY, and PSpiceDefaultNet. 

Note: Refer to the Defining Part Properties Needed for Simulation section of your PSpice 
User’s Guide for further information regarding part properties.

For a complete index of all the part properties and what they are used for, see Index of PSpice 
symbol and part properties on page 275

This property… Defines this…

Implementation the name of the model that PSpice must use for simulation. 
Implementation type must be set to PSpice Model.

PSPICEONLY an indicator that the part or special part applies only to 
simulation with PSpice.

PSPICETEMPLATE the PSpice syntax for the symbol’s netlist entry.

IO_Level what level of interface subcircuit model PSpice uses for a digital 
part that is connected to an analog part.

MNTYMXDLY the digital propagation delay level that PSpice must use for a 
digital part.

PSpiceDefaultNet the pin property specifying the net name to which a power 
(invisible) pin is connected.

■ Whenever you define a hidden pin for a part, the part editor 
automatically creates an PSPICEDEFAULTNET property.
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Handling unmodeled pins

There are parts that have some pins that are not modeled. To see an example of this, place 
an instance of the PM-741 part from the OPAMP.OLB part library. The OS1 and OS2 pins are 
not modeled, so only the +, -, V+, V-, and OUT pins are netlisted for simulation.

For the simulator, these pins are treated as a large resistor connected to ground. They have 
a pin property of FLOAT=Unmodeled.

Double-click the part to see the Property Editing dialog box. Note that the 
PSPICETEMPLATE property for the part only calls out the +, -, V+, V-, and OUT pins. The 
OS1 and OS2 pins are not called out in the PSPICETEMPLATE because those two pins are 
not modeled in the simulation model for the PM-741 part. You can view the simulation model 
definition for the PM-741 part.

To view a part’s simulation model

1. Click the part to select it.

2. Right-click and select View PSpice Model.

The model definition opens in a new tab and cannot be edited.

Saving a copy of your project

Use the Project Manager in Capture to save all of your simulation settings and analysis setup, 
as well as your schematic. To save a copy of a project

1. In the Project Manager in Capture, from the File menu, choose Archive Project.

2. Select Library files, Output files and/or Referenced projects, depending on what types of 
files you want to archive. Typically, you will want to include all file types to be sure you 
save everything related to the project.

3. In the Archive directory text box, enter the path where you want the new archive copy to 
be stored, or use the Browse button to locate the directory.

4. Click OK to create the archive of your project in the specified directory.

Note: The .DAT and .ALS files are not saved with the project.

Note: 
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Files needed for simulation

To simulate your design, PSpice needs to know about:

■ the parts in your circuit and how they are connected, 

■ what analyses to run, 

■ the simulation models that correspond to the parts in your circuit, and 

■ the stimulus definitions to test with. 

This information is provided in various data files. Some of these are generated by the design 
entry program such as Capture, others come from libraries, and still others are user-defined.

Files that Design Entry Programs generate

When you begin the simulation process, the design entry programs first generate files 
describing the parts and connections in your circuit. These files are the netlist file and the 
circuit file that PSpice reads before doing anything else.

Netlist file

The netlist file contains a list of device names, values, and how they are connected with other 
devices. The name that design entry program generate for this file is DESIGN_NAME-
DESIGN_NAME.NET. The netlist file is located in the directory:

<project_directory>\worklib\<design_name>\cfg_analog\

Other files that you can configure for simulation

Before starting simulation, PSpice needs to read other files that contain simulation 
information for your circuit. These are model files, and if required, stimulus files and include 
files.
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The simulation profile contains references to the other user-configurable files that PSpice 
needs to read.

Model library

PSpice uses this information in a model library to determine how a part will respond to 
different electrical inputs. These definitions take the form of either a:

■ model parameter set, which defines the behavior of a part by fine-tuning the underlying 
model built into PSpice, or 

■ subcrcuit netlist, which describes the structure and function of the part by interconnecting 
other parts and primitives.

The most commonly used models are available in the PSpice model libraries shipped with 
your programs. The model library names have a.LIB extension.

If needed, however, you can create your own models and libraries, using a text editor like 
Notepad

Stimulus file

You can create a stimulus file by using a standard text editor to create the definition (a typical 
file extension is .STM).

Include file

An include file is a user-defined file that contains:

■ PSpice commands, or 

■ supplemental text comments that you want to appear in the PSpice output file.

You can create an include file using any standard text editor. Typically, include file names have 
a .INC extension.

Tip

An include file can contain definitions, using the PSpice.FUNC command, for 
functions that you want to use in numeric expressions elsewhere in your design.
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Configuring model library, stimulus, and include files

PSpice searches model libraries, stimulus files, and include files for any information it needs 
to complete the definition of a part or to run a simulation.

The files that PSpice searches depend on how you configure your model libraries and other 
files. Much of the configuration is set up for you automatically, however, you can do the 
following yourself:

■ Add and delete files from the configuration.

■ Change the scope of a file: that is, whether the file applies to a profile only, a design only 
(local) or to any design (global).

■ Change the search order.

To configure these, edit the simulation profile by using the Configuration Files tab in the 
Simulation Settings dialog box.

Files that PSpice generates

After reading the circuit file, netlist file, model libraries, and any other required inputs, PSpice 
starts the simulation. As simulation progresses, PSpice saves results to two files—the data 
file and the PSpice output file.

Probe data file

The data file contains simulation results that can be displayed graphically. PSpice reads this 
file automatically and displays waveforms reflecting circuit response at nets, pins, and parts 
that you marked in your design (cross-probing). You can set up your simulation so PSpice 
displays the results as the simulation progresses or after the simulation completes.

After PSpice has read the data file and displays the initial set of results, you can add more 
waveforms to perform post-simulation analysis of the data.

There are two ways to add waveforms to the display: 

■ From within PSpice, by specifying trace expressions.

■ From within the design entry program, by cross-probing.

PSpice output file

The PSpice output file is an ASCII text file that contains:
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■ the netlist representation of the circuit, 

■ the PSpice command syntax for simulation commands and options (like the enabled 
analyses),

■ simulation results, and

■ warning and error messages for problems encountered during read-in or simulation.

Its content is determined by:

■ the types of analyses you run, 

■ the options you select for running PSpice, and

■ the simulation control parts (like VPRINT1 and VPLOT1) that you place and connect to 
nets in your design.

Checklist for simulation setup

This section describes what you need to do to set up your circuit for simulation. 

1. Find the topic that is of interest in the first column of any of these tables.

2. Go to the referenced section. For those sections that provide overviews, you will find 
references to more detailed discussions.

Note: You must create a new project (not a design) and select the Analog or Mixed-Signal 
Circuit Wizard option in order to be able to simulate the new design with PSpice.

Typical simulation setup steps

For more 
information 
on this 
step...

See this... To find out this...

Set 
component 
values and 
other 
properties.

Using parts that you can simulate An overview of vendor, passive, 
breakout, and behavioral parts.

Specifying values for part properties Things to consider when 
specifying values for part 
properties
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When netlisting fails or the simulation does not start

If you have problems starting the simulation, there may be problems with the design or with 
system resources. If there are problems with the design, PSpice displays errors and warnings 
in the Simulation Status window. You can use the Simulation Status window to get more 
information quickly about the specific problem.

To get information about an error or warning shown in the Simulation Status window

1. Select the error or warning message.

2. Press F1.

Using global parameters and 
expressions for values 

How to define values using 
variable parameters, functional 
calls, and mathematical 
expressions.

Define 
power 
supplies.

Defining power supplies An overview of DC power for 
analog circuits and digital power 
for mixed-signal circuits.

Define 
input 
waveforms.

Defining stimuli An overview of DC, AC, and time-
based stimulus parts.

Set up one 
or more 
analyses.

Setting up analyses Procedures, general to all 
analysis types, to set up and start 
the simulation. 

Detailed information about DC, 
AC, transient, parametric, 
temperature, Monte Carlo, 
sensitivity/worst-case, and digital 
analyses.

Place 
markers.

Using Markers How to display results in PSpice 
by picking nets in your design.

Limiting 
data file 
size

Data collection options for simulation 
profiles 

How to limit the data file size.
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The following tables list the most commonly encountered problems and where to find out 
more about what to do.

Things to check in your design

Things to check in your system configuration

Make sure that... To find out more, see this...

The model 
libraries, stimulus 
files, and include 
files are 
configured.

Configuring model libraries 

The parts you are 
using have models.

Unmodeled parts and Defining part properties needed for 
simulation 

You are not using 
unmodeled pins.

Unmodeled pins 

You have defined 
the grounds.

Missing ground 

Every analog net 
has a DC path to 
ground.

Missing DC path to ground 

The part template 
is correct.

Defining part properties needed for simulation 

Hierarchical parts, 
if used, are 
properly defined.

The Capture User Guide 

Ports that connect 
to the same net 
have the same name.

The Capture User Guide

Make sure that... To find out more, see this...

The directory 
containing your 
design has write 
permission.

Your operating system manual
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Using parts that you can simulate

The part libraries for PSpice supply numerous parts designed for simulation. The PSpice 
libraries are located in the PSpice sub-folder in the tools\capture\library directory under 
your main installation directory. They include: 

■ vendor-supplied parts 

■ passive parts 

■ breakout parts 

■ behavioral parts 

■ special simulation-only parts 

At minimum, a part that you can simulate has these properties:

■ A simulation model to describe the part’s electrical behavior; the model can be:

■ explicitly defined in a model library, 

■ built into PSpice, or

■ built into the part (for some kinds of analog behavioral parts).

■ A part with modeled pins to form electrical connections on your schematic.

■ A translation from design part to netlist statement so that PSpice can read it in.

Note: Not all parts in the libraries are set up for simulation. For example, connectors are parts 
destined for board layout only and do not have these simulation properties. The libraries 
contained in the PSpice subfolder are the only ones set up for simulation.

Note: You must use the ‘0’ (zero) ground part in designs intended to be simulated by PSpice. 
If you have used other ground parts, you can rename them to ‘0’ so that they will be accepted 
by PSpice.

Your system has 
sufficient free 
memory and disk 
space.

Your operating system manual
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Special simulation-only parts

The PSpice part libraries also include special parts that you can use for simulation only. 
These include:

■ stimulus parts to generate input signals to the circuit (see Defining stimuli)

■ ground parts required by all analog and mixed-signal circuits, which need reference to 
ground

■ simulation control parts to do things like set bias values

■ output control parts to do things like generate tables and line-printer plots to the PSpice 
output file 

Vendor-supplied parts

The PSpice libraries provide an extensive selection of manufacturers’ analog and digital 
parts. Typically, the library name reflects the kind of parts contained in the library and the 
vendor that provided the models. For example, MOTOR_RF.OLB and MOTOR_RF.LIB 
contain parts and models, respectively, for Motorola-made RF bipolar transistors.

Libraries are provided with PSpice: Standard PSpice libraries

Standard PSpice libraries

The standard PSpice libraries feature over 16,000 analog and 1,600 digital and mixed-signal 
models of devices manufactured in North America, Japan, and Europe.

Use parts from standard PSpice libraries if you want to analyze the part with PSpice.

The standard PSpice libraries are installed in the following locations in the installation 
directory:

■ Capture symbols for standard PSpice libraries at

\tools\capture\library\pspice

■ Standard PSpice model libraries at

\tools\psice\library\

You can find some information about a particular library (.lib) when you open it in a text editor 
and read the comments in the file.
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Part naming conventions

The part names in the PSpice libraries usually reflect the manufacturers’ part names. If 
multiple vendors supply the same part, each part name includes a suffix that indicates the 
vendor that supplied the model.

Finding the part that you want

If you are having trouble finding a part, you can search the libraries for parts with similar 
names by using the part browser in Capture and restricting the parts list to those names that 
match a specified wildcard text string.

From Capture, select Place – PSpice Component – Search. The PSpice Part Search 
window opens.

To find parts using the parts browser

1. In Capture, from the Place menu, choose Part.

2. In the Part Name text box, type a text string with wildcard characters that approximates 
the part name that you want to find. Use this syntax:

<wildcard><part_name_fragment><wildcard>

where <wildcard> is one of the following:

The parts browser displays only the matching part names.

Tip

This method finds any part contained in the current part libraries configuration, 
including parts for user-defined models. 

Passive parts

The PSpice libraries supply several basic parts based on the passive device models built into 
PSpice. These are summarized in the following table.

* to match zero or more characters

? to match exactly one character
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To find out more about how to use these parts and define their properties, look up the 
corresponding PSpice device letter in the Analog Devices chapter in the PSpice Reference 
Manual, and then see the Capture Parts sections.

Breakout parts

The PSpice libraries supply passive and semiconductor parts with default model definitions 
that define a basic set of model parameters. This way, you can easily:

■ assign device and lot tolerances to model parameters for Monte Carlo and sensitivity/
worst-case analyses, 

■ define temperature coefficients, and

■ define device-specific operating temperatures.

These are called breakout parts and are summarized in the following table.

These parts 
are 
available..
.

For this device type... Which is this PSpice 
device letter...

C C_VAR capacitor C

L inductor L

R R_VAR resistor R

XFRM_LINEAR 
K_LINEAR

transformer K and L

T ideal transmission line T

TLOSSY Lossy transmission line T

TnCOUPLED 
TnCOUPLEDX1 
KCOUPLE1

1. For these device types, the PSpice libraries supply several parts.
Refer to the PSpice Reference Manual for the available parts.

coupled transmission line T and K
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To find out more about how to use these parts and define their properties, look up the 
corresponding PSpice device letter in the Analog Devices chapter in the PSpice Reference 
Manual, and then see the Capture Parts sections.

* For this device type, the PSpice libraries supply several breakout parts. Refer to the PSpice 
Reference Manual for the available parts.

Behavioral parts

Behavioral parts allow you to define how a block of circuitry should work without having to 
define each discrete component.

Use this 
breakout 
part...

For this device type... Which is this PSpice device 
letter...

BBREAK GaAsFET B

CBREAK capacitor C

DBREAKx diode D

JBREAKx* JFET J

KBREAK inductor coupling K

LBREAK inductor L

MBREAKx* MOSFET M

QBREAKx* bipolar transistor Q

RBREAK resistor R

SBREAK voltage-controlled switch S

TBREAK transmission line T

WBREAK current-controlled switch W

XFRM_NONL
INEAR

transformer K and L

ZBREAKN IGBT Z
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Analog behavioral parts

These parts use analog behavioral modeling (ABM) to define each part’s behavior as a 
mathematical expression or lookup table. The PSpice libraries provide ABM parts that 
operate as math functions, limiters, Chebyshev filters, integrators, differentiators, and others 
that you can customize for specific expressions and lookup tables. You can also create your 
own ABM parts.

Digital behavioral parts

These parts use special behavioral primitives to define each part’s functional and timing 
behavior. These primitives are:

Many of the digital parts provided in the PSpice libraries are modeled using these primitives. 
You can also create your own digital behavioral parts using these primitives.

Defining part properties needed for simulation

If you want to use a part for simulation, then your part should have the PSPICETEMPLATE 
property defined for it:

You can also add other simulation-specific properties for digital parts: IO_LEVEL, 
MNTYMXDLY, and PSPICEDEFAULTNET.

Here are the things to check when editing part properties:

■ Does the PSPICETEMPLATE specify the correct number of pins/ nodes?

■ Are the pins/ nodes in the PSPICETEMPLATE specified in the proper order?

■ Do the pin/ node names in the PSPICETEMPLATE match the pin names on the part?

For examples of how to use the PSPICETEMPLATE property, see PSPICETEMPLATE 
examples.

LOGICEXP to define logic expressions

PINDLY to define pin-to-pin delays

CONSTRAINT to define constraint checks
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Editing simulation properties

To edit a property needed for simulation

1. In the schematic page editor, select the part to edit.

2. From the Edit menu, choose Properties to display the Parts spreadsheet of the Property 
Editor.

3. Click in the cell of the column you want to change (for example, PSPICETEMPLATE), or 
click the New button to add a property (and type the property name in the Name text box).

4. If needed, type a value in the Value text box.

5. Click Apply to update the design, then close the spreadsheet.

PSPICETEMPLATE property

The PSPICETEMPLATE property defines the PSpice syntax for the part’s netlist entry. When 
creating a netlist, Capture substitutes actual values from the circuit into the appropriate 
places in the PSPICETEMPLATE syntax, then saves the translated statement to the netlist 
file.

Any part that you want to simulate must have a defined PSPICETEMPLATE property. These 
rules apply:

■ The pin names specified in the PSPICETEMPLATE property must match the pin names 
on the part. 

■ The number and order of the pins listed in the PSPICETEMPLATE property must match 
those for the associated .MODEL or .SUBCKT definition referenced for simulation. 

■ The first character in a PSPICETEMPLATE must be a PSpice device letter appropriate 
for the part (such as Q for a bipolar transistor). 

PSPICETEMPLATE syntax

The PSPICETEMPLATE contains:

1. regular characters that the schematic page editor interprets verbatim, and

2. property names and control characters that the schematic page editor translates.
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Regular characters in templates

Regular characters include the following:

■ alphanumerics

■ any keyboard part except the special syntactical parts used with attributes (@ & ? ~ #).

■ white space

An identifier is a collection of regular characters of the form:

alphabetic character [any other regular character]*.

Property names in templates

Property names are preceded by a special character as follows:

[@|?|~|#|&]<identifier>

The schematic page editor processes the property according to the special character as 
shown in the following table.

* s is a separator character. 

Separator characters include commas (,), periods (.), semi-colons (;), forward slashes (/), 
and vertical bars (|). You must always use the same character to specify an opening-closing 
pair of separators.

This syntax... Is replaced with this...

@<id> Value of <id>. Error if no <id> property or if no value assigned.

&<id> Value of <id> if <id> is defined.

?<id>s...s Text between s...s separators if <id> is defined.

?<id>s...ss...s Text between the first s...s separators if <id> is defined, else the 
second s...s clause.

~<id>s...s Text between s...s separators if <id> is undefined.

~<id> s...ss...s Text between the first s...s separators if <id> is undefined, else 
the second s...s clause.

#<id>s...s Text between s...s separators if <id> is defined, but delete rest 
of template if <id> is undefined.
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Tip

You can use different separator characters to nest conditional property clauses.

The ^ character in templates

The schematic page editor replaces the ̂  character with the complete hierarchical path to the 
device being netlisted. 

Caution—Recommended scheme for netlist templates

Templates for devices in the part library start with a PSpice device letter, followed by the 
hierarchical path, and then the reference designator (REFDES) property. 

It is recommended that you adopt this scheme when defining your own netlist templates.

Example: R^@REFDES for a resistor

The \n character sequence in templates

The part editor replaces the character sequence \n with a new line. Using \n, you can specify 
a multi-line netlist entry from a one-line template.

The % character and pin names in templates

Pin names are denoted as follows:

%<pin name>

where pin name is one or more regular characters.

The schematic page editor replaces the %<pin name> clause in the template with the name 
of the net connected to that pin. 

The end of the pin name is marked with a separator. To avoid name conflicts in PSpice, the 
schematic page editor translates the following characters contained in pin names.

This pin name 
character... Is replaced with this...

< l (L)

> g
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Note: To include a literal % character into the netlist output, type %% in the template.

PSPICETEMPLATE examples

Simple resistor (R) template

The R part has:

■ two pins: 1 and 2

■ two required properties: REFDES and VALUE

Template

R^@REFDES %1 %2 @VALUE

Sample translation

R_R23 abc def 1k 

where REFDES equals R23, VALUE equals 1k, and R is connected to nets abc and def.

Voltage source with optional AC and DC specifications (VAC) template

The VAC part has:

■ two properties: AC and DC

■ two pins: + and -

Template

V^@REFDES %+ %- ?DC|DC=@DC| ?AC|AC=@AC|

Sample translation

V_V6 vp vm DC=5v

where REFDES equals V6, VSRC is connected to nodes vp and vm, DC is set to 5v, and AC 
is undefined.

= e

\XXX\ XXXbar
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Sample translation

V_V6 vp vm DC=5v AC=1v

where, in addition to the settings for the previous translation, AC is set to 1v.

Parameterized subcircuit call (X) template

Suppose you have a subcircuit Z that has:

■ two pins: a and b

■ a subcircuit parameter: G, where G defaults to 1000 when no value is supplied

To allow the parameter to be changed on the schematic page, treat G as an property in the 
template.

Template

X^@REFDES %a %b Z PARAMS: ?G|G=@G|

  ~G|G=1000|

Equivalent template (using the if...else form)

X^@REFDES %a %b Z PARAMS: ?G|G=@G||G=1000|

Sample translation

X_U33 101 102 Z PARAMS: G=1024

where REFDES equals U33, G is set to 1024, and the subcircuit connects to nets 101 and 
102. 

Sample translation

X_U33 101 102 Z PARAMS: G=1000

where the settings of the previous translation apply except that G is undefined.

Digital stimulus parts with variable width pins template

For a digital stimulus device template (such as that for a DIGSTIM part), a pin name can be 
preceded by a * character. This signifies that the pin can be connected to a bus and the width 
of the pin is set to be equal to the width of the bus.
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Template

U^@REFDES STIM(%#PIN, 0) %*PIN

  \n+ STIMULUS=@STIMULUS

where #PIN refers to a variable width pin.

Sample translation

U_U1 STIM(4,0) 5PIN1 %PIN2 %PIN3 %PIN4

+ STIMULUS=mystim

where the stimulus is connected to a four-input bus, a[0-3].

Pin callout in subcircuit templates

The number and sequence of pins named in a template for a subcircuit must agree with the 
definition of the subcircuit itself—that is, the node names listed in the .SUBCKT statement, 
which heads the definition of a subcircuit. These are the pinouts of the subcircuit.

IO_LEVEL property

The IO_LEVEL property defines what level of interface subcircuit model PSpice must use for 
a digital part that is connected to an analog part. 

If you are creating a digital part, you need to

1. Add the IO_LEVEL property to the part and assign a value shown in the table below.

2. Use this property in the PSPICETEMPLATE property definition (IO_LEVEL is also a 
subcircuit parameter used in calls for digital subcircuits).

Assign this value... To use this interface subcircuit (level)...

0 circuit-wide default

1 AtoD1 and DtoA1

2 AtoD2 and DtoA2

3 AtoD3 and DtoA3

4 AtoD4 and DtoA4
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MNTYMXDLY property

The MNTYMXDLY property defines the digital propagation delay level that PSpice must use for 
a digital part.

If you are creating a digital part, you need to do the following

1. Add the MNTYMXDLY property to the part and assign a value shown in the table below.

2. Use this property in the PSPICETEMPLATE property definition (MNTYMXDLY is also a 
subcircuit parameter used in calls for digital subcircuits).

PSPICEDEFAULTNET property

The PSPICEDEFAULTNET pin property defines the net name to which a power or ground 
(invisible) pin is connected.

For example, if the power and ground pins on a digital part are connected to the digital nets 
$G_DPWR and $G_DGND respectively, then the properties are defined as follows:

PSPICEDEFAULTNET=$G_DPWR

PSPICEDEFAULTNET=$G_DGND

If you are creating a digital part, you need to do the following

1. For each power pin, create a PSPICEDEFAULTNET property and assign the name of the 
digital net to which the pin is connected.

2. Use the appropriate pin name in the PSPICETEMPLATE property definition.

Assign this value... To use this propagation delay...

0 circuit-wide default

1 minimum

2 typical

3 maximum

4 worst-case (min/max)
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Specifying values for part properties

Note the following when specifying values for part properties:

■ Do not leave a space between the value and its unit, if the unit is a scale symbol. For 
example, specify 5K instead of 5 K. 

For a listing of the scale symbols, see Numeric value conventions in the Before you begin 
chapter of the PSpice Reference Guide.

■ Do not use the European notation for specifying values. For example, if you specify 3K3 
(the European notation for 3.3K), PSpice reads the value as 3K. Use 3.3K instead.

■ Specify tolerance values as percentages. If you specify an absolute value, the tolerance 
value will be read as an absolute number. For example, if you specify the value of the 
POSTOL property as a percentage, say 10%, on a 10K resistor, the distribution values will 
be taken in the range of 10K?1K. If you specify the tolerance value as an absolute 
number, say 10, the distribution values will be taken in the range of 10K?10?.

Using global parameters and expressions for values

In addition to literal values, you can use global parameters and expressions to represent 
numeric values in your circuit design.

Global parameters

A global parameter is like a programming variable that represents a numeric value by name. 

Once you have defined a parameter (declared its name and given it a value), you can use it 
to represent circuit values anywhere in the schematic; this applies to any hierarchical level.

Some ways that you can use parameters are as follows:

■ Apply the same value to multiple part instances.

■ Set up an analysis that sweeps a variable through a range of values (for example, DC 
sweep or parametric analysis).

When multiple parts are set to the same value, global parameters provide a convenient way 
to change all of their values for “what-if” analyses. 

For example, if two independent sources have a value defined by the parameter VSUPPLY, 
then you can change both sources to 10 volts by assigning the value once to VSUPPLY.
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Declaring and using a global parameter

To use a global parameter in your design, you need to:

■ define the parameter using a PARAM part from SPECIAL.OLB

■ use the parameter in place of a literal value somewhere in your design.

To declare a global parameter

1. Place a PARAM part in your design.

2. Double-click the PARAM part to display the Parts spreadsheet, then click New.

3. Do the following for each global parameter:

❑ Click New, then enter NAMEn in the Property Name text box, then click OK. This 
creates a new property for the PARAM part, NAMEn in the spreadsheet.

❑ Click in the cell below the NAMEn column and enter a default value for the 
parameter.

❑ While this cell is still selected, click Display. In the Display format frame, select 
Name and Value, then click OK.

Caution

System variables have reserved parameter names. Do not use these 
parameter names when defining your own parameters.

❑ Click Apply to update all the changes to the PARAM part, and then close the 
spreadsheet.

For example, to declare the global parameter VSUPPLY that will set the value of an 
independent voltage source to 14 volts, place the PARAM part, and then create a new 
property named VSUPPLY with a value of 14v.

To use the global parameter in your circuit

1. Find the numeric value that you want to replace: a component value, model parameter 
value, or other property value.

2. Replace the value with the name of the global parameter using the following syntax:

{ global_parameter_name }

The curly braces tell PSpice to evaluate the parameter and use its value.
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Expressions

An expression is a mathematical relationship that you can use to define a numeric or boolean 
(TRUE/FALSE) value. 

PSpice evaluates the expression to a single value every time:

■ it reads in a new circuit, and

■ a parameter value used within an expression changes during an analysis.

For example, a parameter that changes with each step of a DC sweep or parametric analysis.

Specifying expressions

To use an expression in your circuit

1. Find the numeric or boolean value you want to replace: a component value, model 
parameter value, other property value, or logic in an IF function test.

2. Replace the value with an expression using the following syntax:

{ expression }

where {expression} can contain any of the following:

❑ standard operators (listed in the Table below)

❑ built-in functions (listed in the PSpice User’s Guide)

❑ user-defined functions

❑ system variables (listed in the PSpice User’s Guide)

❑ user-defined global parameters

❑ literal operands

The curly braces tell PSpice to evaluate the expression and use its value.

This 
operator 
class...

Includes this 
operator...

Which means...

arithmetic + addition or string concatenation

- subtraction
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* Logical and relational operators are used within the IF() function; for digital parts, logical 
operators are used in Boolean expressions.

For lists of system variables and functions in arithmetic expression, refer to your PSpice 
User’s Guide.

Defining stimuli

To simulate your circuit, you need to connect one or more source parts that describe the input 
signal that the circuit must respond to. 

The PSpice libraries supply several source parts that are described in the tables that follow. 
These parts depend on:

■ the kind of analysis you are running,

■ whether you are connecting to the analog or digital portion of your circuit, and

■ how you want to define the stimulus: using a file specification, or by defining part property 
values.

* multiplication

/ division

** exponentiation

logical ~ unary NOT

| boolean OR

^ boolean XOR

& boolean AND

relational* == equality test

!= non-equality test

> greater than test

>= greater than or equal to test

< less than test

<= less than or equal to test
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Analog stimuli

Analog stimuli include both voltage and current sources. The following table shows the part 
names for voltage sources. 

** VPWL_F_RE_FOREVER and VPWL_F_N_TIMES are file-based parts; the stimulus 
specification is saved in a file and adheres to PSpice netlist syntax.

To determine the part name for an equivalent current source

1. In the table of voltage source parts, replace the first V in the part name with I.

For example, the current source equivalent to VDC is IDC, to VAC is IAC, to VEXP is 
IEXP, and so on.

If you want to specify multiple stimulus types

If you want to run more than one analysis type, including a transient analysis, then you need 
to use either of the following:

■ time-based stimulus parts with AC and DC properties

If you want this 
kind of input...

Use this part for voltage... 

DC bias VDC or VSRC 

AC magnitude and 
phase

VAC or VSRC 

exponential VEXP 

periodic pulse VPULSE 

piecewise-linear VPWL 

piecewise-linear 
that repeats 
forever

VPWL_RE_FOREVER or VPWL_F_RE_FOREVER

piecewise-linear 
that repeats n 
times

VPWL_N_TIMES or VPWL_F_N_TIMES**

frequency-modulated 
sine wave

VSFFM 

sine wave VSIN 
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■ VSRC or ISRC parts

Using time-based stimulus parts with AC and DC properties

The time-based stimulus parts that you can use to define a transient, DC, and/or AC input 
signal are listed below.

In addition to the transient properties, each of these parts also has a DC and AC property. 
When you use one of these parts, you must define all of the transient properties. However, it 
is common to leave DC and/or AC undefined (blank). When you give them a value, the syntax 
you need to use is as follows.

For the meaning of transient source properties, refer to the I/V (independent current and 
voltage source) device type syntax in the Analog Devices chapter in the PSpice Reference 
Guide.

VEXP IEXP

VPULSE IPULSE

VPWL IPWL

VPWL_F_RE_FOREVER IPWL_F_RE_FOREVER

VPWL_F_N_TIMES IPWL_F_N_TIMES

VPWL_RE_FOREVER IPWL_RE_FOREVER

VPWL_RE_N_TIMES IPWL_RE_N_TIMES

VSFFM ISFFM

VSIN ISIN

This property... Has this syntax...

DC DC_value[units]

AC magnitude_value[units] [phase_value]
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Using VSRC or ISRC parts

The VSRC and ISRC parts have one property for each analysis type: DC, AC, and TRAN. You 
can set any or all of them using PSpice netlist syntax. When you give them a value, the syntax 
you need to use is as follows.

where time-based_type is EXP, PULSE, PWL, SFFM, or SIN, and the parameters depend on 
the time-based_type.

For the syntax and meaning of transient source specifications, refer to the I/V (independent 
current and voltage source) device type in the Analog Devices chapter in the PSpice 
Reference Guide.

 

Digital stimuli

If you want this kind of input...Use this part.... 

This property... Has this syntax...

DC DC_value[units]

AC magnitude_value[units] [phase_value]

TRAN time-based_type (parameters)

For transient 
analyses

signal or bus (any 
width)

DIGSTIMn

clock signal DIGCLOCK

1-bit signal STIM1

4-bit bus STIM4

8-bit bus STIM8

16-bit bus STIM16

file-based signal 
or bus (any width)

FILESTIMn
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Things to watch for

This section includes troubleshooting tips for some of the most common reasons your circuit 
design may not netlist or simulate.

Common reasons for simulation problems include:

Unmodeled parts 

Unconfigured model, stimulus, or include files 

Unmodeled pins

Missing ground

Missing DC path to ground 

Using the FLOAT property 

Note: You must use the ‘0’ (zero) ground part in designs intended to be simulated by PSpice. 
If you have used other ground parts, you can rename them to ‘0’ so that they will be accepted 
by PSpice.

Unmodeled parts

If you see messages like this in the Capture Session Log:

Warning: Part part_name has no simulation model

then you may have done one of the following things:

❑ Placed a part from the PSpice libraries that is not available for simulation (used only 
for board layout).

❑ Placed a custom part that has been incompletely defined for simulation.

Do this if the part in question is from the PSpice libraries

Replace the part with an equivalent part from an analog library or digital library with modeled 
parts.

■ Make sure that you can simulate the part by checking the following:

■ That it has a PSPICETEMPLATE property and that its value is non-blank.
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■ That it has Implementation type=PSpice Model and an Implementation property with 
a non-blank value.

Note: The libraries listed in the tables that follow all contain parts that you can simulate. 
Some files also contain parts that you can only use for board layout. That’s why you need to 
check the PSPICETEMPLATE property if you are unsure or still getting warnings when you 
try to simulate your circuit.

Check for this if the part in question is custom-built

■ Are there blank (or inappropriate) values for the part’s MODEL and PSPICETEMPLATE 
properties?

If so, load this part into the part editor and set these properties appropriately. One way 
to approach this is to edit the part that appears in your design.

To edit the properties for the part in question

1. In the schematic page editor, select the part.

2. From the Edit menu, choose part.

The part editor window appears with the part already loaded.

3. From the Edit menu, choose Properties and proceed to change the property values.

Unconfigured model, stimulus, or include files

If you see messages like these in the Capture Session Log,

(design_name) Floating pin: refdes pin pin_name

Floating pin: pin_id

File not found

Can’t open stimulus file

or messages like these in the PSpice output file,

Model model_name used by device_name is undefined.

Subcircuit subckt_name used by device_name is undefined.

Can’t find .STIMULUS “refdes” definition
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then you may be missing a model library, stimulus file, or include file from the configuration 
list, or the configured file is not on the library path.

Check for this

■ Does the relevant model library, stimulus file, or include file appear in the configuration 
list?

■ If the file is configured, does the default library search path include the directory path 
where the file resides, or explicitly define the directory path in the configuration list?

If the file is not configured, add it to the list and make sure that it appears before any other 
library or file that has an identically-named definition.

To view the configuration list

1. In the Simulation Settings dialog box, click the Configuration Files tab and click Include, 
Library and Stimulus in the Category field.

If the directory path is not specified, update the default library search path or change the 
file entry in the configuration list to include the full path specification.

To view the default library search path

1. In the Configuration Files tab, click Library in the Category field.

Unmodeled pins

If you see messages like these in the Capture Session Log,

Warning: Part part_name pin pin_name is unmodeled.

Warning: Less than 2 connections at node node_name.

or messages like this in the PSpice output file,

Floating/unmodeled pin fixups

then you may have drawn a wire to an unmodeled pin.

The PSpice libraries include parts that are suitable for both simulation and board layout. 
These parts may have a mix of modeled pins and unmodeled pins. The unmodeled pins map 
into packages but have no electrical significance; PSpice ignores unmodeled pins during 
simulation.
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Check for this

■ Are there connections to unmodeled pins? 

If so, do one of the following:

■ Remove wires connected to unmodeled pins.

■ If you expect the connection to affect simulation results, find an equivalent part that 
models the pins in question and draw the connections.

Missing ground

If for every net in your circuit you see this message in the PSpice output file,

ERROR -- Node node_name is floating.

then your circuit may not be tied to ground.

Check for this

■ Are there ground parts named 0 (zero) connected appropriately in your design?

If not, place and connect one (or more, as needed) in your design. You can use the 0 (zero) 
ground part in SOURCE.OLB or any other ground part as long as you change its name to 0.

Note: You must use the ‘0’ (zero) ground part in designs intended to be simulated by PSpice. 
If you have used other ground parts, you can rename them to ‘0’ so that they will be accepted 
by PSpice.

Missing DC path to ground

If for selected nets in your circuit you see this message in the PSpice output file,

ERROR -- Node node_name is floating.

then you may be missing a DC path to ground.

Check for this

■ Are there any nets that are isolated from ground by either open circuits or capacitors?

If so, then add a very large (for example, ) resistor either:1GΩ
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■ in parallel with the capacitor or open circuit, or

■ from the isolated net to ground.

Using the FLOAT property

When preparing a circuit for simulation with PSpice, it’s important to be sure that all pins for 
all parts are connected properly. If a pin is intentionally meant to remain unconnected, you 
need to use the PSpice pin property FLOAT, rather than a No Connect symbol. Otherwise, 
the circuit may not netlist correctly for PSpice.

The pin property FLOAT may have one of the following three values:

The FLOAT property can either be defined in the Part Editor when creating a new part, or you 
can edit a pin on an existing part using the Property Editor spreadsheet.

To define the FLOAT property using the Property Editor spreadsheet

1. In Capture, double-click the pin to open the Property Editor spreadsheet.

2. Click the Pins tab.

3. Click New and type FLOAT (upper case) in the Property Name text box, then click OK.

4. Click in the cell under the FLOAT column for the pin, and then type the property value 
you want to use.

5. Click Apply to have the changes take effect.

Value Description

Error The pin will not netlist. An error message will be returned when 
the PSpice simulation netlist is generated. Use Error when you 
want to be reminded that this pin is a "no connect" and should 
be treated in a special way. Error is the default value.

RtoGND The pin is connected to a virtual resistor, whose opposite pin is 
tied to GND. The resistor has a value of 1/GMIN. This value 
allows the simulation netlist to be created and allows PSpice to 
perform the analysis. The virtual resistor will not be processed 
as part of a layout netlist or appear in a BOM.

UniqueNet The pin, when left unconnected, is attached to a unique node 
when the PSpice simulation netlist is generated. Use 
UniqueNet when you want the pin to remain unconnected but 
correspond to the Probe data associated with its part.
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Analyzing waveforms with PSpice 

PSpice offers integrated waveform analysis functionality for viewing simulation results. Use 
waveform analysis for circuit performance analysis and data comparison from multiple files.

What is waveform analysis?

After completing the simulation, PSpice plots the waveform results so you can visualize the 
circuit’s behavior and determine the validity of your design.

Waveform analysis not only displays simple voltages and currents, but also complex 
arithmetic expressions involving voltages and currents and the Fourier Transform of these 
expressions. You can also use waveform analysis for Performance Analysis; see Using 
Performance Analysis for more information.

When a mixed analog/digital simulation runs successfully, PSpice displays analog and digital 
waveforms simultaneously with a common time base. You can add text labels and other 
annotation symbols to plots for clarification.

Taken together, simulation and waveform analysis is an iterative process. After analyzing 
simulation results, you can refine your design and simulation settings and then perform a new 
simulation and waveform analysis.

PSpice saves two kinds of waveform data file formats: ASCII and binary.

Performing post-simulation analysis of the results

This means you can plot additional information derived from the waveforms. What you can 
plot depends on the type of analyses you run. Bode plots, phase margin, derivatives for small-
signal characteristics, waveform families, and histograms are only a few of the possibilities. 
You can also plot other waveform characteristics such as rise time versus temperature, or 
percent overshoot versus component value. 
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Pinpointing design errors in digital circuits

When PSpice detects setup and hold violations, race conditions, or timing hazards, a detailed 
message appears along with corresponding waveforms. PSpice also helps you locate the 
problem in your design.

What are the features of PSpice simulation profiles?

PSpice has the following features in simulation profiles:

Increased reusability of simulation profiles

Previous versions of PSpice allowed you to import settings only from a simulation profile that 
exists in the same project. You can now create a new simulation profile by importing settings 
from a simulation profile that exists in another project also. This increases the reusability of 
simulation profiles. For more information, see Creating a new simulation profile.

Support for profile level configuration

Previous versions of PSpice allowed you to configure model libraries, stimulus files and 
include files only at the global level (applicable to all designs) or at the design level (applicable 
only to the design). You can now configure model libraries, stimulus files and include files at 
the simulation profile level also. 

The ability to configure model libraries, stimulus files and include files at the profile level has 
the following benefits:

■ You can simulate the same circuit with different model libraries for each type of analysis 
and compare results. For example, you may want a part to be modeled using the 
DECODER model in the FRQCHK.LIB model library for AC analysis and using the 
DECODER model in the FRQCHK_1.lib model library for transient analysis. You can 
create two simulation profiles-one for AC and one for transient analysis, configure the 
FRQCHK.LIB model library at the profile level in the simulation profile for AC analysis, 
and configure the FRQCHK_1.LIB model library at the profile level in the simulation 
profile for transient analysis. Previous versions of PSpice required you to configure the 
model libraries at the design level and change the search order of the model libraries in 
a simulation profile before running the simulation, if you wanted to simulate the same 
circuit with different model libraries for each type of analysis.

■ You can simulate the same circuit with different stimuli to test different characteristics like 
small signal response and large signal response, for each type of analysis. For example, 
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you may want to simulate a circuit using the RF_AMP.STL stimulus file for AC analysis 
and the RF_AMP1.STL stimulus file for transient analysis. You can create two simulation 
profiles-one for AC and one for transient analysis, configure the RF_AMP.STL stimulus 
file at the profile level in the simulation profile for AC analysis, and configure the 
RF_AMP1.STL stimulus file at the profile level in the simulation profile for transient 
analysis. Previous versions of PSpice required you to configure the stimulus files at the 
design level and change the search order of the stimulus files in a simulation profile 
before running the simulation, if you wanted to simulate the same circuit with different 
stimuli for each type of analysis.

■ You can simulate the same circuit using different include files for each type of analysis. 
For example, you may want to simulate a circuit using the RF_AMP.INC include file for 
AC analysis and the RF_AMP1.INC include file for transient analysis. You can create two 
simulation profiles-one for AC and one for transient analysis, configure the RF_AMP.INC 
include file at the profile level in the simulation profile for AC analysis, and configure the 
RF_AMP1.INC include file at the profile level in the simulation profile for transient 
analysis. Previous versions of PSpice required you to configure the include files at the 
design level and change the search order of the include files in a simulation profile before 
running the simulation, if you wanted to simulate the same circuit with different include 
files for each type of analysis.

Creating a new simulation profile

A simulation profile (*.SIM) saves your simulation settings for an analysis type so you can 
reuse them easily.

You can use PSpice to create a new simulation profile only by importing settings from a 
simulation profile that exists in the same project or in another project. 

To import settings from an existing simulation profile to create a new simulation profile, do the 
following:

1. From the File menu in PSpice, point to New and choose Simulation Profile.

The New Simulation dialog box appears.

2. In the Profile name text box, specify a name for the profile (such as the name of the 
analysis type for the new profile).

3. Click the Browse button to specify the location and name of an another simulation profile 
(.sim) to import its settings into the new profile.

4. Click Create to create the profile and display the Simulation Settings dialog box. 
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A new simulation profile is created and can bee seen under PSpice Resources – 
Simulation Profiles of the project which you had selected to import the existing 
simulation profile in the Inherit from an existing profile text box.

See the following topics for information on the settings in various tabs of the Simulation 
Settings dialog box:

Using a simulation profile

You can simulate the circuit using any of the simulation profiles you have created in the 
project. To use a simulation profile, open it in PSpice or make it active in the design entry 
program.

To open a simulation profile in PSpice 

1. From the File menu, choose Open Simulation.

2. Select the <profile_name>.SIM file and click Open.

To make a simulation profile active in Capture

Do one of the following:

■ From the PSpice toolbar in Capture, select the simulation profile you want to use. See 
PSpice toolbar in Capture for more information.

■ Select the simulation profile in the Capture Project Manager, and choose Make Active 
from the PSpice menu in Capture. 

The  icon indicates an active simulation profile. 

General General simulation settings for simulation profiles 

Analysis Analysis settings for simulation profiles 

Configuration Files Library settings for simulation profiles

Stimulus settings for simulation profiles 

Include files settings for simulation profiles 

Options Options for simulation profiles 

Data Collection Data collection options for simulation profiles 

Probe Window Probe windows settings for simulation profiles 
June 2020 112 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



PSpice Help
Performing Circuit Analysis
Each simulation profile is associated with a schematic. When you select a simulation profile 
in Capture, the folder for the associated schematic becomes the root schematic folder. When 
you run PSpice, only the pages in the root schematic folder are netlisted. If the schematic 
pages in the root schematic folder refer to pages in another schematic folder (as in the case 
of hierarchical designs), the pages in that schematic folder also get netlisted.

Editing a simulation profile

You can edit an existing simulation profile to change the simulation settings. You can edit the 
current simulation profile in PSpice. In the design entry program, you can edit the current 
simulation profile or select the simulation profile you want to edit. 

To edit a simulation profile in PSpice 

1. From the Simulation menu, choose Edit Profile to display the Simulation Settings dialog 
box.

2. Make the required changes in the Simulation Settings dialog box.

3. Click OK to save the changes.

To edit the current simulation profile in design entry program

1. From the PSpice menu, choose Edit Simulation Profile to display the Simulation Settings 
dialog box.

2. Make the required changes in the Simulation Settings dialog box.

3. Click OK to save the changes.

To select a simulation profile you want to edit in design entry program

1. From the PSpice toolbar in the design entry program, select the simulation profile you 
want to edit. 

2. From the PSpice menu in the design entry program, choose Edit Simulation Profile to 
display the Simulation Settings dialog box.

3. Make the required changes in the Simulation Settings dialog box.

4. Click OK to save the changes.

See the following topics for information on editing the settings in the tabs in the Simulation 
Settings dialog box:
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Deleting a simulation profile

You can delete a simulation profile only from the Capture Project Manager. 

To delete a simulation profile

1. Select the simulation profile in the Capture Project Manager and press Delete

Note: When you delete a simulation profile, the profile is deleted from the project but the 
files related to the simulation profile are not deleted from the project directory. You can 
manually delete the files from the project directory. For example, if you delete a 
simulation profile named TRAN, you must delete the TRAN folder located at 
<project_directory>\<design_name>-
PSpiceFiles\<root_schematic_name>\.

Note: If you delete a simulation profile but do not delete the files related to that profile, 
and later create a profile with the same name for the schematic, Capture displays an 
error message that a profile with the same name exists. You can overwrite the old profile 
or create another profile with a different name.

Viewing the simulation queue

Use the Simulation Queue dialog box to set the order of a batch simulation and to view the 
progress of a batch simulation. 

General tab General simulation settings for simulation profiles 

Analysis Analysis settings for simulation profiles 

Configuration Files Library settings for simulation profiles

Stimulus settings for simulation profiles 

Include files settings for simulation profiles 

Options tab Options for simulation profiles 

Data Collection tab Data collection options for simulation profiles 

Probe window Probe windows settings for simulation profiles 
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To set up a batch simulation 

1. From the File menu, choose Open Simulation.

2. Select multiple .SIM or .CIR files by doing one of the following:

❑ Press CTRL while selecting to select individual files.

❑ Press SHIFT while selecting to select a range of files.

Note: If the files you want to select are located in different directories, click Add in the 
Simulation Queue dialog box to find them in the various directories. The Simulation Queue 
dialog box will appear after you click Open (see below).

To set the batch simulation order

1. After selecting the files for a batch simulation, click Open.

The Simulation Queue dialog box appears. The file at the top of the Pending Simulations 
list is set to be simulated first.

2. To change the order, do one of the following:

❑ Select a filename in the list and click either  or  to move it up or down. 

❑ Click the Reset button to reset the order. 

❑ Click Add to add more files to the simulation.

3. Click the Settings button to display the Simulation Settings dialog box, where you can 
view or change the simulation profile settings.

4. Click the Start button to start the simulations.

General simulation settings for simulation profiles

Use the General tab of the Simulation Settings dialog box to specify the simulation input and 
output files and save a description of the simulation profile.

Profile name

The Profile name text box displays the name of the current profile. You can change the name 
here.
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Input settings

Choose Schematic to have the simulation input come from a Capture design (*.DSN file), or 
choose Circuit File (*.CIR) to have the simulation input come from a circuit file. For either input 
type, enter the name of the file in the text box. 

For a design-based simulation, also select the name of the top-level schematic page. Use the 
Analysis tab of this dialog box to enter simulation settings.

For a circuit-file-based design, the Analysis tab settings are unavailable. You can change the 
simulation settings by editing the commands in the .CIR file. See the PSpice Reference Guide 
for more information about circuit file commands.

Output settings

In the Output Filename text box, enter a file name (*.OUT) for the simulation output to be 
saved to.

In the Waveform Data Filename text box, enter a filename (*.DAT) for the simulation waveform 
data to be saved to. 

Note: Use this text box to describe the design or simulation profile.

Analysis settings for simulation profiles

Use the Analysis tab of the Simulation Settings dialog box to define the basic analysis type 
and set up additional advanced analyses and simulation options.

Analysis Types

From the Analysis Type drop-down list box, select the basic analysis type you want to use. 
For more information about these, see Setting up analyses.

Analysis Options

Under Options, select an advanced analysis you want to use. See Setting up analyses for 
more information about these.
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Configuration Files Tab

Use the Configuration Files tab of the Simulation Settings dialog box to configure and edit 
the following:

■ Stimulus settings for simulation profiles

■ Library settings for simulation profiles

■ Include files settings for simulation profiles

Stimulus settings for simulation profiles

Use the Configuration Files tab of the Simulation Settings dialog box to configure global, 
design and profile level stimulus files.

Click Stimulus in the Category field in the Configuration Files tab, and then configure the 
stimulus files.

Click this button… To do this…

Browse Browse directories for libraries to make available to the profile-
the selected file name appears in the Filename text box

Add as Global Add the file listed in the Filename text box to be available to all 
designs 

Add to Design Add the file listed in the Filename text box to be available to the 
current design only

Add to Profile Add the file listed in the Filename text box to be available to the 
current profile only.

A file added at the design level cannot be added at the profile 
level also. 

 

Note: Profile specific configuration is available only if the project 
was created using Capture from release 10.0 and beyond. This 
feature is also available for the project created using older 
versions of Capture but converted to the Capture 10.0 format. 

Change Change the selected file with the file specified in the Filename 
text box
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Library settings for simulation profiles

Use the Configuration Files tab of the Simulation Settings dialog box configure global, design 
and profile level model libraries. 

1. Click Library in the Category field in the Configuration Files tab, and then configure the 
model libraries.

Remove the selected file from the Variant Files list—this does 
not delete the file from your computer

 and 

Move the selected file up or down in the Variant Files list. 

PSpice locates the stimuli by searching the stimulus files in the 
order in which they are listed in the Variant Files list. PSpice 
locates the stimuli by first searching the stimulus files 
configured at the profile level, then the stimulus files configured 
at the design level and finally the stimulus files configured at the 
global level. 

Note: You can change the search order only within the files 
configured at the same level. For example, you can change the 
search order only within the files configured at the profile level.

Click this button… To do this…

Browse Browse directories for libraries to make available to the profile—
the selected file name appears in the Filename text box

Add as Global Add the file listed in the Filename text box to be available to all 
designs 

Add to Design Add the file listed in the Filename text box to be available to the 
current design only 

Add to Profile Add the file listed in the Filename text box to be available to the 
current profile only A file added at the design level cannot be 
added at the profile level also. 

Note: Profile specific configuration is available only if the project 
was created using Capture from release 10.0 and beyond. This 
feature is also available for the project created using older 
versions of Capture but converted to the Capture 10.0 format. 
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Library search path

The Library Path text box displays the path that PSpice uses to search for models configured 
at the global level. You can edit or replace this path by typing a path in this text box, following 
these rules:

Use a semicolon (;) to separate two path names.

Do not follow the last path name with a semicolon.

Example:

To search first C:\Cadence\SPB_17.4\tools\pspice\library then C:\MYLIBS, 
type the following: 

"C:\Cadence\SPB_17.4\tools\pspice\library";"c:\mylibs" 

Include files settings for simulation profiles

Use the Configuration Files tab of the Simulation Settings dialog box to configure and edit 
include files for simulation.

Change Change the selected file with the file specified in the Filename 
text box

Remove the selected file from the Variant Files list—this does 
not delete the file from your computer

 and 

Move the selected file up or down in the Variant Files list. 

PSpice locates models by searching the model libraries in the 
order in which they are listed in the Variant Files list. PSpice 
locates models by first searching the model libraries configured 
at the profile level, then the model libraries configured at the 
design level and finally the model libraries configured at the 
global level. 

Note: You can change the search order only within the files 
configured at the same level. For example, you can change the 
search order only within the files configured at the profile level.
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1. Click Include in the Category field in the Configuration Files tab, then configure or 
edit the include files.

Options for simulation profiles

Use the Options tab of the Simulation Settings dialog box to fine-tune how PSpice performs 
calculations for analog and gate-level digital simulation, as well as what information to save 
to the simulation output file (*.OUT).

Option categories

From the Category list, select Analog Simulation, Analog Advanced, Gate-level Simulation, 
or Output file to display the settings for each option category. 

Click this button… To do this…

Browse Browse directories for files to include—the selected file name 
appears in the Filename text box

Add as Global Add the file listed in the Filename text box to be used for all 
designs 

Add to Design Add the file listed in the Filename text box to be used for the 
current design only

Add to Profile Add the file listed in the Filename text box to be used for the 
current profile only

A file added at the design level cannot be added at the profile 
level also.

Note: Profile specific configuration is available only if the project 
was created using Capture from release 10.0 and beyond. This 
feature is also available for the project created using older 
versions of Capture but converted to the Capture 10.0 format.

Edit Open the selected file for editing in PSpice.

Change Change the selected file with the file specified in the Filename 
text box.

Remove the selected file from the Variant Files list—this does 
not delete the file from your computer

 and 

Move the selected file up or down in the Variant Files list.
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Analog simulation options

Use the Analog Simulation settings to fine-tune analog simulation accuracy, set iteration 
limits, set operating temperature, and specify MOSFET parameters.

The option names in the text box correspond to the option names used in the PSpice 
.OPTIONS command. For more information about this command, refer to the PSpice 
Reference Guide.

The following tables defines all the options in the tab for the Analog Simulation category:

Click this button… To do this…

General Enter values for speed level, tolerances, and minimum 
conductance.

AutoConverge Suggest relaxed limits for various options that PSpice can 
modify during a simulation to achieve convergence.

MOSFET options Enter values for the default drain area, default source area, 
default length, and default width.

Advanced options Enter values for the total transient iteration limit, relative 
magnitude for matrix pivot, and absolute magnitude for matrix 
pivot.

Flag option Meaning

ADVCONV Enables all convergence algorithms, such as Pseudo Tran, 
STEPGMIN, and step sources. ON by default. 

AutoConverge Suggest relaxed limits for various options that PSpice can modify 
during a simulation to achieve convergence. 

Restart Restart the convergence calculation

PREODER Presorts the matrix diagonal by Markowitz counts.

Options Description Units Default

General 
section..
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SPEED_LEVEL increases simulation performance by 
optimizing switching behavior of models. If 
increase in simulation performance is not 
needed, set SPEED_LEVEL=0.

- 3

RELTOL relative accuracy of V and I 0.001

VNTOL best accuracy of voltages volt 1.0 uV

ABSTOL best accuracy of currents amp 1.0 pA

CHGTOL best accuracy of charges coulomb 0.01 pC

GMIN minimum conductance used for any branch ohm-1 1.0E-12

Auto Converge 
section..

ITL1  Maximum number of iterations of 
convergence calculation during bias point 
analysis

150.0

ITL2 Maximum number of iterations of convergence 
calculation during DC analysis

20

ITL4 Maximum number of iterations of convergence 
calculation at each time step during transient 
analysis

10

TNOM Nominal Temperature value Celsius 27 degrees 
Celsius

THREADS When THREADS=0, PSpice uses the number 
of threads that are equal to the number of 
cores detected in the system.

When THREADS is anything other than 0, 
PSpice uses the exact number of threads as 
specified.

It is recommended to set THREADS to 0 for 
PSpice to decide the optimal number of 
threads to be used.

0

PIVTOL absolute magnitude required for pivot in matrix 
solution

1.0E-13

Options Description Units Default
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Analog Advanced options

Use the Analog Simulation settings to enter values for the total transient iteration limit, relative 
magnitude for matrix pivot, and absolute magnitude for matrix pivot.

The option names shown in the text box correspond to the option names used in the PSpice 
.OPTIONS command. For more information about this command, refer to the PSpice 
Reference Guide.

The following tables defines all the options in the tab for the Analog Advanced category:

MOSFET 
Section..

DEFAD MOSFET default drain area (AD). meter2 0.0

DEFAS MOSFET default source area (AS). meter2 0.0

DEFL MOSFET default length (L). meter 100.0 u

DEFW MOSFET default width (W). meter 100.0 u

Click this… To do this…

General Enter values for speed level, tolerances, and minimum 
conductance.

Bias Point Suggest relaxed limits for various options that PSpice can 
modify during a simulation to achieve convergence.

Transient Enter values for the default drain area, default source area, 
default length, and default width.

Flag option Meaning

NOGMINI Specifies not to add GMIN across current sources.

BRKDEPSRC Sets automatic break-points for behavioral sources.

CONVAID Generates .1OP file for debugging purpose when convergence fails.

Options Description Units Default
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STEPGMIN Enables GMIN stepping. This causes a GMIN stepping algorithm to be 
applied to circuits that fail to converge. GMIN stepping is applied first, 
and if that fails, the simulator falls back to supply stepping.

NOSTEPSRC Do not run source stepping algorithm for bias point convergence.

NOSTEPDEP Do not step dependent sources during source stepping algorithm for 
bias point convergence.

GMINSRC Enables step GMIN inside source-stepping

PSEUDOTRAN Uses Pseudo-Transient Method.

Options Description Units Default

ITL5 total repeating limit for all points for transient 
analysis
(ITL5=0 means ITL5=infinity)

- 0.0

PIVREL relative magnitude required for pivot in matrix 
solution

- 1.0E-3

PIVTOL absolute magnitude required for pivot in matrix 
solution

- 1.0E-13

SOLVER performance package solution algorithm

(Solver = 0 selects the original solution 
algorithm;

Solver = 1 selects the advanced solution 
algorithm)

- 1

DMFACTOR Sets the relative factor for minimum delta. The 
value specifies the relative value by which the 
minimum time step size is changed. The value 
should be less than or equal to 1 and a factor 
of 10, such as .1, .001, or .0001. 

WCDEVIATION worst case deviation. It can have double 
values between 0 and 1. 

- Same as 
RELTOL

Flag option, Meaning, continued
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LIMIT the absolute voltage limit. The default, 0, 
specifies that there is no limit on data values. 
You can modify it to a large value, such as 
1e12, to eliminate overflow errors, especially 
when using exponential sources.

- 0

DIODECJO Minimum value for Diode junction capacitance ohm 0

DIODERS Minimum value for Diode ohmic resistance ohm 0

BJTCJ minimum value for BJT Base-collector zero-
bias depletion capacitance (Cjc), Base-emitter 
zero-bias depletion capacitance (Cje), and 
zero-bias collector substrate capacitance (Cjs)

farad 0

GMINSTEPS the GMIN stepping size in integer (any 
positive value). Set to 0 for engine default.

- Same as 
ITL1

ITL6 the number of steps of the source stepping 
algorithm. Can have any positive integer 
value. Set to 0 for engine default.

- Same as 
ITL1

PTRANSTEP number of steps for a pseudo transient 
analysis to find the operating point. Can be 
any positive integer value. Set to 0 for engine 
default.

- Same as 
ITL1

method integration method 
(values can be either TRAPEZOIDAL or 
GEAR)

- -

TRTOL tolerance for integration error calculated using 
transient analysis. It is a relative tolerance 
where a higher TRTOL value results in bigger 
time steps and reduced accuracy. The TRTOL 
value should NOT be greater than 1/RELTOL.

- 7

CSHUNT shunt capacitance added from all nodes of the 
design to GND. Recommended value is 1pF. 

farad 0

TRANCONV Enables alternate path search if transient 
simulation fails.
June 2020 125 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



PSpice Help
Performing Circuit Analysis
Gate-level simulation options

Use the Gate-level Simulation settings to set timing, I/O levels for interfaces, drive strength, 
and error message limits.

The following tables defines all the options in the tab for the Gate Level Simulation category:

Click this button… To do this…

General Enter values to set delay or initial state in flip-flops or latches. 

Advanced options Enter values for the minimum output drive resistance, maximum 
output drive resistance, overdrive ratio, default delay 
calculation, and error message limits.

Flag option Meaning

NOPRBMSG Suppresses simulation error messages in Probe data file.

DIGMNTYMX default delay selector: 1=min, 2-typical, 
3=max, 4=min/max

- 2.0

DIGINITSTATE sets initial state of all flip-flops and latches in 
circuit: 0=clear, 1=set, 2=X

- 2.0

DIGIOLVL default digital I/O level: 1-4; - 1.0

DIGDRVF minimum drive resistance 
(Input/Output UIO type model, DRVH (high) and 
DRVL (low) values)

ohm 2.0

DIGDRVZ maximum drive resistance 
(UIO type model, DRVH and DRVL values)

ohm 20K

DIGOVRDRV ratio of drive resistances required to allow one 
output to override another driving the same 
node

- 3.0

DIGMNTYSCALE scale factor used to derive minimum delays 
from typical delays

- 0.4

DIGTYMXSCALE scale factor used to derive maximum delays 
from typical delays

- 1.6
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Output file options

Use the Output File settings to select the types of information PSpice saves to the simulation 
output file.

The following tables defines all the options in the tab for the Output file category:

DIGERRDEFAULT default error limit per digital constraint device - 20.0

DIGERRLIMIT maximum digital error message limit - 0

Flag option Meaning

ACCT Summary and accounting information is printed at the end of all the 
analyses (refer to your PSpice User’s Guide for further information 
on ACCT).

EXPAND Lists devices created by subcircuit expansion and lists contents of the 
bias point file.

LIBRARY Lists lines used from library files.

LIST Lists a summary of the circuit elements (devices).

NOBIAS Suppresses the printing of the bias point node voltages.

NODE Lists a summary of the connections (node table).

NOECHO Suppresses a listing of the input file(s).

NOMODE Suppresses listing of model parameters and temperature updated 
values.

NOOUTMSG Suppresses simulation error messages in output file.

NOPAGE Suppresses paging and the banner for each major section of output.

OPTS Lists values for all options.

NUMDGT Number of digits in printed values. This is 4 by default.

WIDTH same as the .WIDTH OUT= statement 
(can be set to either 80 or 132)

Default is 80.
June 2020 127 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



PSpice Help
Performing Circuit Analysis
Data collection options for simulation profiles

Use the Data Collection tab of the Simulation Settings dialog box to restrict the captured 
simulation data. This is especially useful for large circuit designs that produce more data than 
you need for waveform analysis.

You can also set the probe data accuracy from this tab. By default, probe data has 64-bit 
accuracy but you can choose a lower 32-bit accuracy. 

You can choose to apply the options in the table below to apply to Voltages, Currents, Power, 
Digital or Noise data. For more information on setting these options, see Setting data 
collection options.
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Data Collection Options

Waveform data file format option

Select the Save data in the CSDF format (.CSD) check box to save the waveform data file 
in the ASCII Common Simulation Data Format instead of in the default binary format.

Probe Data accuracy options

By default, the probe data has 64-bit accuracy. You can set the accuracy by selecting a 
different radio button for Probe Data. A 64-bit accuracy setting ensures that the output does 
not have ramps. For example, when a small amplitude voltage is superimposed on a large 
amplitude voltage, the resolution might be lost, resulting in ramps.

Probe windows settings for simulation profiles

Use the Probe Windows tab of the Simulation Settings dialog box to set up how Probe 
windows are displayed for a simulation profile. 

For more probe window options, see Setting Probe window options.

Option Description

All All data will be collected and stored. (This is the default setting.)

All but Internal 
Subcircuits

All data will be collected and stored except for internal 
subcircuits of hierarchical designs (top level data only).

At Markers Only Data will only be collected and stored where markers are 
placed.

None No data will be collected.
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Probe window display options

Use this option… To do this…

Display Probe window 
when profile is opened

Display the Probe windows that were displayed the last time the 
profile was opened.

Display Probe window: 

■ during simulation 

■ after simulation has 
completed.

Display the Probe windows when: 

■ the simulation is running, and update the waveforms as the 
simulation progresses. 

■ the simulation is finished.

Show 

■ All markers on open 
schematics 

■ Last plot

Show the traces: 

■ For all the markers that are placed on currently open 
designs in the design entry program. 

■ That were used the last time the profile was opened.
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Adding traces

You can add one or more analog or digital traces to the selected plot in the current Probe 
window. To view information about the trace, including which section and/or file its data came 
from, right-click the trace in the Probe window and choose Information.

Tip

You can add traces that use data from individual data files loaded into PSpice. Click 
here To use a function or arithmetic operator for more information. 

To add one or more traces to a plot

1. On the toolbar, click the Add Trace button to display the Add Traces dialog box:

2. Select the simulation output variable that you want to display by clicking one of the 
variables in the list. Click here Narrowing the list of output variables for information on 
narrowing this list.

3. Optional: Select operators, functions, or macros from the Functions or Macros list box to 
refine the data to be displayed. Depending on what you use, you may need to select more 
than one output variable.

❑ Click here Defining analog trace expressionsfor more information on using 
operators, functions, and macros for analog traces.

❑ Click here Defining digital trace expressions for more information on using 
operators, functions, and macros for digital traces.

4. Click OK.

To modify a trace that is already displayed

1. Double-click the trace name in the plot legend. In the Modify Traces dialog box, you can 
perform the same functions as in the Add Traces dialog box, but apply them to the 
selected trace.
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Viewing trace information

You can view the trace name, the path for the data file from which the trace was generated 
(when you have more than one waveform data file loaded), information about the simulation 
that produced the waveform data file, and the number of data points used.

To view trace information

1. Do one of the following:

❑ Right-click a trace and choose Information.

❑ Double-click the trace symbol in the plot legend.

The Section Information dialog box appears, displaying information for the trace.

Editing trace display properties

When you create a trace and it is assigned a color by your scheme setting, the color stays 
even if you delete a trace; the colors are not reassigned. The same is true if you change the 
color of an individual trace. Color schemes are specified in the Probe Settings dialog box 
(from the Tools menu, choose Options).

Trace colors are reassigned when you apply a new scheme.

To edit the trace properties

1. Select and right-click a trace and choose Properties to display the Trace Properties 
dialog box. (You can also SHIFT+click to select multiple traces or use the Select All 
command from the Edit menu to select all the traces before right-clicking to change them 
all as a group.)

2. Set any of the following options:

❑ From the Color list, select a color to use for the trace.

❑ From the Pattern list, select a pattern to use for the trace.

❑ From the Width list, select a width to use for the trace.

❑ From the Symbol list, select a symbol to associate with the trace in the plot legend. 
Select Show Symbol to display the symbol on the trace itself.

3. Click OK to apply the new settings and close the Trace Properties dialog box.

4. If you do not see the changes immediately, from the View menu, choose Redraw to 
redraw the display.
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Setting grid display properties

You can change the grid properties separately for the major and minor grids on the x- and y-
axes.

To edit the grid properties

1. Right-click a gridline, then choose Properties to display a Grid Properties dialog box.

2. Set any of the following options:

❑ From the Color list, select a color to use for the grid.

❑ From the Pattern list, select a pattern to use for the grid.

❑ From the Width list, select a width to use for the grid.

❑ Select the check box to apply these settings to the grid on the other axis.

3. Click OK to apply the new settings and close the Grid Properties dialog box.

Setting plot edge properties

To edit the plot edge properties

1. Right-click a plot edge, then choose Properties to display a Plot Edge Properties dialog 
box.

2. Set any of the following options:

❑ From the Color list, select a color to use for the grid.

❑ From the Pattern list, select a pattern to use for the grid.

❑ From the Width list, select a width to use for the grid.

3. Click OK to apply the new settings and close the Plot Edge Properties dialog box.

Defining analog trace expressions

When defining analog trace expressions, you can include any combination of analog 
simulation output variables, arithmetic operators, functions, macros, and sweep variables. 

For AC analysis, PSpice uses complex arithmetic to evaluate expressions and displays the 
magnitude of complex results. If the result is real (for example, IMG(V(4)+V(5))), then it can 
be negative. If the result is complex, (for example, V(4)+(5)), then the magnitude is displayed, 
which is always positive.
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For procedures, see the following topics:

❑ To use a function or arithmetic operator

❑ To use a sweep variable

Tip

You can add traces that use data from individual data files that you loaded into 
PSpice. Click here To use a function or arithmetic operator for an example.

Tip

Device noise is available in addition to total input and output noise. These are 
generated only if you run a noise analysis. Click here Device noise variables to 
display the device noise output variables.

Note: Click here How noise units are reported for information on how noise units are 
reported.

Analog Operators

Valid analog arithmetic operators:

Analog Functions

Valid analog arithmetic functions:

( ) grouping

* / multiplication/division 

+ - addition/subtraction 

@ at a specific section and/or data file

# refers to already added traces in the Probe window. 

To refer to a trace use the syntax #n, where n is the number of 
the trace. For example, if V(in) is the first trace and V(out) is 
the second trace in the Probe window, V(in)/V(out) can be 
added just by writing #1/#2 in the Add Trace window.

ABS(x) |x|

ARCTAN(x) arc tangent of x with results in radians
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ATAN(x) arc tangent of x with results in radians

AVG(x) running average of x over the range of the X axis variable

AVGX(x,d) running average of x from X_axis_value(x)-d to X_axis_value(x)

COS(x) cos(x) with x in radians

D(x) derivative of x with respect to the X axis variable

Note: dV(node) is equivalent to d(V(node))

DB(x) magnitude in decibels of x

ENVMAX(x,d) envelope of x. Peaks selected have a minimum number of d 
consecutive datapoints.

ENVMIN(x,d) envelope of x.Valley lows selected have a minimum number of d 
consecutive datapoints.

EXP(x) the natural exponential function of x

G(x) group delay of x with results in seconds

IMG(x) imaginary part of x

LOG(x) ln(x) with log base e

LOG10(x) log(x) with log base 10

M(x) magnitude of x

MAX(x) maximum value of x

MIN(x) minimum value of x

P(x) phase of x with results in degrees

PWR(x,y) x to the power of y

R(x) real part of x

RMS(x) running RMS average of x over the range of the X axis variable

s(x) integral of x over the range of the X axis variable

Note: sIC(node) is equivalent to s(IC(node))

SGN(x) +1 (if x>0), 0 (if x=0), -1 (if x<0)

SIN(x) sin(x) with x in radians

SQRT(x) the square root of x

TAN(x) tan(x) with x in radians
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To use a function or arithmetic operator

In the Add Trace dialog box:

1. From the Functions or Macros list, select Analog Operators and Functions.

2. In the corresponding list, click the operator symbol or function name you want to use.

3. If the selection is a function, fill in the arguments list by doing the following:

a. In the Simulation Output Variables list, click the name of an output variable.

b. Repeat for as many arguments as are needed for the function call.

Examples

■ V(Out1)@1

displays the (VOut1) data contained in the first section of available data. 

■ V(Out2)@f2

displays the V(Out2) data contained in the second file of a set of loaded data files. 

■ V(Out2)@”path_name”

displays the V(Out2) data contained in the specified .dat file, which must already be 
loaded.

■ V(Out1)@1@f2

displays the V(Out1) data in the first section in the second file of a set of loaded data files.

Using analog output variables

To add a trace

1. From the Trace menu, choose Add Trace to display the Add Traces dialog box.

Enter names in the Trace Expression text box using the following notations.

❑ ;<display_name> 

is the (optional) name you want to use to represent this trace expression on the plot.

❑ V(<node_name>) or V(<node_name_1>, <node_name_2>) 

For example, V(3) or V(1,3).
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❑ Vx(<device_name>) and Ix(<device_name>), but not V(<device_name>) or 
Vxy(<device_name>).  

For example, VC(Q5), IB(Q2), and VG(M2) are valid, but not V(R3) or VCE(Q13).

❑ I(device_name) for current value through a device.

❑ VG(x) or IG(x) for group delay for voltage and current values, respectively.

❑ N<noise_type>(<device_name>) for the contribution from <noise_type> of 
<device_name> to the total output noise.

For example, NFID(M1) represents the flicker noise at MOSFET M1.

For noise values, use the variables as shown below:

Total Noise Variables

Note: Device noise is available in addition to total input and output noise. These are 
generated only if you run a noise analysis. Click here Device noise variables to display the 
device noise variables. Click here How noise units are reported for information on how noise 
units are reported.

Device noise variables

Click here About noise units for more information on how noise units are reported.

Use this variable… For this noise value…

V(ONOISE) output voltage 

V(INOISE) input voltage 

I(INOISE) input current 

For this device… Use these variables…

B (GaAsFET) NFID (Idrain flicker noise) 

NRD (RD thermal noise) 

NRG (RG thermal noise) 

NRS (RS thermal noise) 

NSID (Idrain shot noise) 

NTOT (total noise) 
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D (Diode) NFID (Idrain flicker noise) 

NRS (RS thermal noise) 

NSID (Idrain shot noise) 

NTOT (total noise) 

J (JFET) NFID (Idrain flicker noise) 

NRD (RD thermal noise) 

NRG (RG thermal noise) 

NRS (RS thermal noise) 

NSID (Idrain shot noise) 

NTOT (total noise) 

M (MOSFET) NFID (Idrain flicker noise) 

NRB (RB thermal noise) 

NRD (RD thermal noise) 

NRG (RG thermal noise) 

NRS (RS thermal noise) 

NSID (Idrain shot noise) 

NTOT (total noise)

N (Digital Input) NRHI (resistance noise between the digital device output and 
its PWR pin) 

NRLO (resistance noise between the digital device output and 
its GND pin) 

NTOT (total noise)

O (Digital Output) NTOT (total noise)

Q (BJT) NFIB (base current flicker noise) 

NRB (RB thermal noise) 

NRC (RC thermal noise) 

NRE (RE thermal noise) 

NSIB (base current shot noise) 

NSIC (collector current shot noise) 

NTOT (total noise)
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How noise units are reported

Defining digital trace expressions

When defining digital trace expressions, you can include any combination of digital signals, 
buses, signal constants, bus constants, digital operators, and macros. 

The following rules apply:

■ An arithmetic or logical operation between two bus operands results in a bus value that 
is wide enough to contain the result.

■ An arithmetic or logical operation between a bus operand and a signal operand results 
in a bus value.

For procedures, see the following topics:

❑ To add a digital signal

❑ To add a bus

❑ To add a digital signal or bus constant

❑ To use a digital operator

❑ To add a digital signal or bus constant

❑ To use a digital operator

R (Resistor) NTOT (total noise)

S (Vswitch) NTOT (total noise)

W (Iswitch) NTOT (total noise)

This type of noise output 
variable...

Is reported in these units…

device contribution of the 
form Nxxx

total input or output noise 
of the forms V(ONOISE) or 
V(INOISE)

volts( )2 Hz( )⁄

volts( ) Hz( )⁄
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To add a digital signal

In the Add Trace dialog box:

1. Do one of the following:

❑ In the Simulation Output Variables list, click the signal you want to display.

or

❑ In the Trace text box, create a digital expression by either typing the expression, or 
by selecting digital signals from the Simulation Output Variables list and digital 
operators from the Digital Operators and Functions list.

2. If you want to name the signal with a name that is different from the node name:

❑ Click in the Trace text box after the last character in the signal name

❑ Type ; 

❑ Type the name

Syntax

To specify the digital node name or expression to use in adding a digital signal, use the 
syntax:

<digital_node_name>;<display_name>

or:

<digital_expression>;<display_name>

where:

Example

U2:Y;OUT1 

<digital_node_name> is the digital signal from the Simulation Output Variables list.

<digital_expression
>

is the expression using digital signals and operators understood 
by PSpice.

<display_name> is the (optional) name you want to use to represent this signal 
on the plot.
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specifies a digital trace using the node U2:Y, named OUT1 on the plot.

To add a bus

In the Add Trace dialog box:

1. From the Functions and Macros list, select Digital Operators and Functions.

2. Click the { } entry.

3. In the Simulation Output Variables list, click the digital signals in high order to low order 
sequence.

4. If you want to name the bus with a name that is different from the default:

a. Click in the Trace text box after the last character in the signal name.

b. Type ; .

c. Type the name.

5. If you want to set the radix to something other than the default:

d. Click in the Trace text box after the last character in the bus definition.

e. Type ; .

f. Type the radix value.

Syntax

Specify the contained signals and name of the bus using the syntax:

{digital signals list};display name;radix

or:

{bus_prefix[msb:lsb]};display name;radix

where:

{digital signals 
list}

is a comma- or space-separated list of up to 32 digital 
simulation output variables sequenced from high order to low 
order.

{bus_prefix[msb:lsb
]}

is an alternate way to specify up to 32 signals in the bus.
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Examples

{Q2 Q1 Q0};A;O 

specifies a 3 bit bus whose high order bit is the digital value at node Q2. On a plot, PSpice 
names the bus signal A, and values appear in octal notation.

{a3 a2 a1 a0};;d 

specifies a 4 bit bus. On a plot, values appear in decimal notation. Since no display name is 
specified, PSpice names the bus signal with the signal list.

Note: {a[3:0]} is equivalent to {a3 a2 a1 a0}.

radix

Valid radix values:

To add a digital signal or bus constant

For a signal constant

1. If needed, click in the Trace text box at the location where you want the constant.

2. In the Digital Operators and Functions list box, click the signal constant value.

For a bus constant

1. Click in the Trace text box at the location where you want the constant.

2. Type the bus expression using the syntax:

Display name (optional) is the name you want to use to represent this bus on 
the plot.

radix (optional) is the numbering system in which you want to display 
the bus values.

H or X hexadecimal (default)

D decimal

O octal

B binary
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r’ddd

where

Examples

signal constants

bus constant radix

Valid bus constant radix values are all lower case as follows:

r is the lower-case bus constant radix

ddd is the string of digits reflecting the constant value in the 
specified radix

x’3FFFF hexadecimal

h’5a hexidecimal

d’79 decimal

o’177400 octal

b’100110 binary

‘0 low

‘1 high

‘F falling

‘R rising

‘X unknown

‘Z high impedance

h or x hexadecimal

d decimal

o octal

b binary
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To use a digital operator

In the Add Trace dialog box:

1. From the Functions and Macros list, select Digital Operators and Functions.

2. Click one of the digital operators in the corresponding list.

3. If the operator is the grouping operator:

a. Click the name of a node in the Simulation Output Variables list.

b. Repeat step a for each node in the group.

Digital operators

Valid digital arithmetic and boolean operators, listed in order of precedence:

To use a sweep variable

In the Add Trace dialog box, either select the sweep variable from the Simulation Output 
Variables list or type in the name as follows:

❑ For a DC sweep, use the name of the voltage or current source that was swept in 
the analysis.

❑ For an AC sweep, use Frequency.

❑ For a transient analysis, use Time.

Narrowing the list of output variables

To restrict the simulation output variables

( ) grouping

~ logical complement

* / multiplication/division (bus values only)

+ - addition/subtraction (bus values only)

& and

^ exclusive or

| or
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1. In the Simulation Output Variables text box, type a wildcard string that approximates the 
output variables you want to see, then press Enter. 

Valid wildcards:

Note: You can also restrict the list to include only the variable types of interest by selecting 
the check boxes to the right of the Simulation Output Variables list. 

Examples

C* 

matches any output variable starting with C.

C? 

matches any two-character output variable starting with C.

Deleting traces

You can remove one or more analog or digital traces from a given plot in a Probe window.

To delete one or more traces from a plot

1. Do one of the following to select the first trace that you want to delete:

❑ For an analog trace, select the trace name in the legend below the X axis.

❑ For a digital signal, select the trace name to the left of the Y axis.

2. Shift-click other trace names to select more traces for removal.

3. On the toolbar, click the Cut button to remove the trace or traces.

To delete all traces in the current plot

1. From the Trace menu, choose Delete All Traces.

* matches zero or more characters

? matches exactly one character
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Setting the digital plot size

You can set the size of the digital plot to display on the screen to make more (or less) room 
for traces or trace names.

To set the digital plot size using the mouse

1. Display at least one digital trace and one analog trace in the Probe window for which you 
want to set the digital size. 

2. To change the bottom position of the digital Probe window, do the following:

a. Place the cursor between the analog and digital parts of the plot. 

b. Click the plot separator that you want to change. 

c. Drag the plot separator until you have the digital size you want. 

3. To change the left side of the digital Probe window, do the following;

a. Place the cursor at the left edge of the digital Probe window you want to resize. 

b. Click the left edge that you want to move.

c. Drag the left edge of the digital Probe window to adjust the space available for 
displaying digital trace names. 

To set the digital plot size using menu options

1. Display at least one digital trace in the plot for which you want to set the digital size. 

2. From the Plot menu, choose Digital Size.

3. In the Digital Size dialog box, select the following:

a. Percentage of Plot to be Digital 

b. Length of Digital Trace Name

4. Click OK.
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Using cursors

You can display the cursors on the plot, using two cursors per Probe window at a time. Each 
cursor displays the exact value of a single point on a curve. You can also change the number 
of digits displayed in the cursor box. 

Note: If all the selected sections have one data point at the same X value, then the x-axis 
has only one tick mark and one value. 

For more information, see the following topics:

❑ To display both cursors

❑ To move the cursors using the mouse

❑ To apply the cursors to a different trace

❑ To change the number of digits displayed

❑ To move the cursors using the keyboard

To display both cursors

Do one of the following:

■ On the toolbar, click the Toggle Cursor button. 

■ From the Trace menu, choose Cursor – Display.

The dockable cursor window appears on the screen, showing the current position of the 
cursor on the x- and y-axes. Press and hold either the left or right mouse buttons to alternate 
moving one or the other cursor. As you move the cursors, the values in this cursor window 
change. Move the cursor box by dragging the box to another location. 

To move the cursors using the mouse

Do one of the following:

■ Click and drag to move cursor 1.

■ Right-click and drag to move cursor 2.
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To apply the cursors to a different trace

If you want to apply the cursors to a different trace, click the trace symbol in the plot legend 
for the trace you want to change to.

To freeze the cursor, do one of the following:

➡ Choose Trace – Cursor – Freeze to freeze the cursor locations on the current trace.

OR

1. Choose Tools – Options.

The Probe Settings dialog box opens.

2. Select the Cursor Settings tab.

3. Select Show non-dockable(old) cursor window.

The Probe Cursor window appears.

4. Click the Probe Cursor window (below the title bar) to freeze the cursor locations on the 
current trace.

To change the number of digits displayed

1. Choose Tools – Options.

2. Select the Cursor Settings tab.

3. In the Number of cursor digits text box, type a number between 2 and 18.

4. Click OK.

To move the cursors using the keyboard

Use the following key combinations (directional keys on the keyboard) to move the cursors.

To move this… Press this…

Cursor 1 to the right or left Right or left arrow

Cursor 2 to the right or left Shift + right arrow or 

Shift + left arrow
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Moving cursors along a trace

You can move cursors to view the coordinates of any point on a trace.

Move a cursor by moving the mouse to the desired location and clicking the appropriate 
mouse button. The left mouse button controls the first cursor, and the right mouse button 
controls the second cursor. The move is made by the last cursor that was moved. For 
example, if you right-click the plot to move cursor 2 and then click the max button on the 
toolbar, cursor 2 will move to the maximum point on the trace it is positioned on.

There are also default keyboard shortcuts for moving cursors.

The trace each cursor follows is determined by the selected trace symbol. To change the trace 
on which the cursor is on, click a different trace symbol in the legend.

Caution

Cursor movements are not recorded during command logging.

For more information, see the following topics:

❑ To turn cursors on or off

❑ To move the cursor to the next peak

❑ To move the cursor to the next trough

❑ To move the cursor to the next slope

❑ To move the cursor to a minimum or maximum point

❑ To move the cursor to the next data point generated by the simulator

Cursor 1 to the previous or the next trace Ctrl + right arrow or 

Ctrl + left arrow 

Cursor 2 to the previous or next trace Shift + Ctrl + right arrow or 

Shift + Ctrl + left arrow 

Cursor 1 to the beginning or the end of the 
trace

Home or End

Cursor 2 to the beginning or the end of the 
trace

Shift + Home or 

Shift + End
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❑ To move the cursor to the next transition

❑ To move the cursor to the previous transition

❑ To mark every data point with a symbol

❑ To search for a specific cursor location

To turn cursors on or off 

➡ On the toolbar, click the Toggle Cursor button. 

To move the cursor to the next peak

➡ On the toolbar, click the Cursor Peak button. 

A first peak is a location where the points on each side of the peak have a lower Y value.

Peak is defined as the first local maxima (local peak) of the selected trace. If you click the 
Cursor Peak button again, cursor moves to the next local peak of the same trace in the 
forward direction. If you move the cursor in the reverse direction using mouse or arrow 
key, and then click the Cursor Peak button, cursor moves to the local peak in the that 
direction.

To move the cursor to the next trough

➡ On the toolbar, click the Cursor Trough button.

A trough is the opposite of a peak. A first trough is a location where the points on each 
side of the trough have a higher Y value.

A trough is defined as the first local minima (local trough) of the selected trace. If you click 
Cursor Trough button again, it moves to the next local trough of the same trace in the 
forward direction. If you move the cursor in the reverse direction using mouse or arrow 
key, and then click the Cursor Trough button, cursor moves to the local trough in that 
direction.

To move the cursor to the next slope

➡ On the toolbar, click the Cursor Slope button.

The slope is the change in Y over the change in X. The slope can be either positive or 
negative.
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To move the cursor to a minimum or maximum point

➡ To see the minimum value, on the toolbar, click the Cursor Min button.

The minimum value is the minimum Y value of the selected trace.

➡ To see the maximum value, on the toolbar, click the Cursor Max button.

The maximum value is the maximum Y value of the selected trace.

To move the cursor to the next data point generated by the simulator

➡ On the toolbar, click the Cursor Point button. 

Clicking this button takes the cursor to the next data point generated by the simulator.

To move the cursor to the next transition

➡ On the toolbar, click the Cursor Next Tran button. 

Clicking this button takes the cursor to the next transition point in a digital trace.

To move the cursor to the previous transition

➡ On the toolbar, click the Cursor Prev Tran button. 

Clicking this button takes the cursor to the previous transition point in a digital trace.

To mark every data point with a symbol

➡ On the toolbar, click the Mark Label button.

To search for a specific cursor location

Do the following:

1. Choose Trace – Cursor – Display or click the Toggle Cursor button.

2. Choose Trace – Cursor – Search Commands or click the Cursor Search button.

The Search Command window opens.

3. Specify the command sfxv() or sfle() to move the cursor to specific X and Y 
locations respectively.
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For example: 

❑ To move the cursor to X = 10ns, specify sfxv(10ns).

❑ To move the cursor to Y = 10V, specify sfle(10v).

4. Click OK.

Important

By default, the sfxv() and sfle() commands search in the forward direction from 
current cursor location.

To move the cursor at a specific location in the reverse direction, use the following 
commands:

❑ sbxv()

❑ sble()

Changing views

You can change the way PSpice displays the traces on a plot. You can zoom in or out, change 
the center point, display only a selected area, see the previous view, and fit the display to the 
plot. You can also turn the display of the Toolbar and Status Bar on or off.

❑ To zoom in or out

❑ To change the center point

❑ To display the selected area

❑ To redraw the screen

❑ To see the previous view

❑ To fit the view

❑ To display the Toolbar

❑ To display the status bar 

Note: The new items were formerly part of the Probe Settings dialog box.

To zoom in or out

1. On the toolbar, click View In or View Out. 
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❑ View In zooms in by a factor of 2 around the point you specify. 

❑ View Out zooms out by a factor of 2 around the point you specify. 

To change the center point 

1. From the View menu, choose Pan New Center. 

2. Click the new center. 

The screen redraws with the new center, maintaining the previous scale. 

To display the selected area

1. On the toolbar, click the Area button. 

2. Click the mouse in the display. 

3. Drag a box around the area you want to view.

The area is displayed. 

To redraw the screen

■ From the View menu, choose Redraw. 

The screen is immediately redrawn. 

To see the previous view

■ From the View menu, choose Previous. 

The screen is redrawn to the previous view, whether it was the last scroll position or the 
last screen setting. 

To go back to more views, repeat the command. 

To fit the view

1. On the toolbar, click the Fit button. 

The selected plot changes scale so that all data fits in the plot view on the screen. 
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To display the Toolbar

■ From the View menu, choose Toolbar.

A check mark next to the menu command indicates that the Toolbar is displayed.

To display the status bar

■ From the View menu, choose Status Bar. 

A check mark next to the menu command indicates that the Status Bar is displayed.

To save or load a display 

1. From the Window menu, choose Display Control. 

2. Do one of the following:

❑ To save the current display, type a name in the New Name box. Click Save.

❑ To save to a different location, click the Save To button. Type a new name. Click OK. 

❑ To load a listed display, click the name and click the Restore button. 

❑ To load a display not listed, click the Load button, then select the name of the .PRB 
file to load. Click OK. Click the name of the display to load, then click the Restore 
button. 

3. Click Close. 

To use a saved display

1. From the Window menu, choose Display Control.

The Display Control dialog box appears.
June 2020 154 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



PSpice Help
Traces
2. Click the Displays tab.

3. Do one of the following:

❑ To use a display listed here, click the name. 

❑ To use a display from another .PRB, click Load. Select the file. Click OK. Click the 
name of the display. 

4. Click Restore.

Note: You can use a saved display to display traces as long as the current data file has 
variables with the same names as the variables in the display file. 

To load displays from another .PRB file

1. From the Window menu, choose Display Control.

The Display Control dialog box appears.

2. Click the Displays tab.

3. Click Load. 

4. Select the file. 

5. Click OK. 
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Note: You can use displays saved in another .PRB file. 

Creating a Fourier Transform 

Fourier Transforms (FFT) can be applied to all the analog traces in a Probe window. 

You can use Fourier Transforms to examine the spectrum of the output of non-linear circuits. 
The resolution of the transformed display is determined by the extent of the original x-axis. 
The extent of the transformed x-axis is determined by the number of original data points.

If you want the Fourier transform display in PSpice to show more resolution, run the transient 
analysis for a longer time interval. Run the circuit for many cycles if necessary. 

When Fourier is used to end the Fourier transform mode, all traces are drawn normally and 
the x-axis variable goes back to its original domain. 

Note: You can take the Fourier transform of an expression of nodes (e.g., V(4) ? V(5)), but 
you cannot display an expression of Fourier transforms (e.g., FFT(V(4)) ? FFT(V(5))).

To view a Fourier Transform

1. Select a plot to view. 

2. On the toolbar, click the Fourier Transform button.

Fourier transforms of all traces are displayed. 

To end the Fourier Transform

1. On the toolbar, click the Fourier Transform button.

Caution

Measurement definitions are not supported in Fourier transform mode.

Cautions when using FFTs

To correctly evaluate the harmonic components of a waveform, you must apply the Fourier 
Transform to a waveform with an integral number of periods. The FFT of a waveform with a 
partial period (e.g., 2.9 periods instead of 3) will generate false harmonic information.

To get an exact number of periods

1. Restrict the data as necessary.
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In general, using several periods will give better results.

Changing axis settings

You can specify the way PSpice displays the x-axis or y-axis, or the x or y grids. The Axis 
Settings dialog box provides tabbed dialog boxes for defining the display characteristics for 
each of these options:

■ To set the x-axis

■ To set the y-axis

■ To set the x-grid

■ To set the y-grid

To set the x-axis

1. Do one of the following to display the Axis Settings dialog box:

❑ From the Plot menu, choose Axis Settings. 

❑ Double-click in the area below the plot where the x-axis values are listed. 

2. Click the X Axis tab, and type or select the following:

❑ Data Range 

❑ Scale 

❑ Use Data 

❑ Processing Options 

❑ Axis Title 

❑ Axis Variable 

3. Click OK to apply the changes.

To set the y-axis

1. Do one of the following to display the Axis Settings dialog box:

❑ From the Plot menu, choose Axis Settings. 

❑ Double-click in the area below the plot where the x-axis values are listed. 
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2. Click the Y Axis tab, and type or select the following:

❑ Data Range 

❑ Scale 

❑ Y Axis Number: select an identification number from the list.

❑ Axis Position 

❑ Axis Title: enter a title for the y-axis.

3. Click OK to apply the changes.

To set the x-grid

1. Do one of the following to display the Axis Settings dialog box:

❑ From the Plot menu, choose Axis Settings. 

❑ Double-click in the area below the plot where the x-axis values are listed. 

2. Click the X Grid tab, and type or select the following:

❑ Automatic: select this to calculate the grid spacing automatically.

❑ Major 

❑ Minor 

3. Click OK to apply the changes.

To set the y-grid

1. Do one of the following to display the Axis Settings dialog box:

❑ From the Plot menu, choose Axis Settings. 

❑ Double-click in the area below the plot where the x-axis values are listed. 

2. Click the Y Grid tab, and type or select the following:

❑ Automatic: select this to calculate the grid spacing automatically.

❑ Y Axis Number: select this to identify which y-axis the settings should be applied to.

❑ Major 

❑ Minor 
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3. Click OK to apply the changes.

Using the ‘Save as Default’ and ‘Reset Defaults’ buttons

The Save as Default button provides a means of setting the default preferences that are used 
when traces are added or when new axes are created. This will not affect the settings of 
previously existing axes or traces.

The Reset Defaults button will restore the default settings to the original settings that are used 
when the program is first run.

To set the x-axis data range

1. Double-click the x-axis to display the Axis Settings dialog box.

2. Click the X Axis tab.

3. In the Data Range frame, choose either Auto Range or User Defined.

If you choose User Defined, specify the range in the text boxes.

4. In the Scale frame, do the following:

a. Type a beginning value and end value for the range. 

b. Choose Linear or Log scaling. 

5. In the Use Data frame, choose either Full or Restricted. 

If you choose Restricted, specify the range in the text boxes. 

6. In the Processing Options frame, choose Fourier, Performance Analysis., or neither.

7. Click Axis Variable to select the variable for the x-axis. 

8. Click the variable or trace you want as the variable for the x-axis. To see other available 
variables or traces, click the choices. Click here Defining analog trace expressions for 
more information on defining traces.

a. Click OK to close this dialog box. 

9. Click OK.

To set the y-axis data range 

1. Do one of the following:
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❑ From the Plot menu, choose Y Axis Settings. 

❑ Double-click the y-axis to display the Axis Settings dialog box.

2. Click Y Axis tab. 

3. In the Data Range frame, choose either Auto Range or User Defined.

If you choose User Defined, specify the range in the text boxes. 

4. In the Scale frame, do the following:

a. Type a beginning value and end value for the range. 

b. Choose Linear or logarithmic scaling. 

5. In the Y Axis Number box, select an identification number for the y-axis.

6. In the Axis Title box, type a title for the y-axis.

7. Click OK.

Adding a new Y axis

You can add a new y-axis to the active Probe window. You can add up to 3 y-axes. The added 
y-axis becomes the selected y-axis. All subsequent traces added are added to the selected 
y-axis. 

To add a Y axis:

1. Click the plot that you want to add a new y-axis to. 

2. From the Plot menu, choose Add Y Axis.

Deleting a Y axis

You can delete a y-axis you no longer want. 

Caution

Any traces on the axis are deleted when the axis is deleted.

To delete a y-axis:

1. Click the y-axis that you want to delete. 

2. From the Plot menu, choose Delete Y Axis. 
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Using multiple plots

You can display multiple plots at the same time in one Probe window. When several plots are 
in the same Probe window, you can select one, delete one, or work with them as synchronized 
or unsynchronized. You can also copy and paste traces among plots.

Plots from the same set of waveform data are automatically synchronized. You can use 
unsynchronized plots to independently apply different scales, Fourier or Performance 
Analysis, or evaluate measurement expressions.

Unsynchronizing plots releases the selected plot to have its own x-axis. Plots that share x-
axes are always displayed together, one above the other. 

For more information, see the following topics:

❑ To add a new plot

❑ To select the current plot

❑ To delete a plot

❑ To unsynchronize plots

To add a new plot

1. Click in the Probe window to which you want to add the plot. 

2. From the Plot menu, choose Add Plot to Window. 

The new plot appears above the selected plot in the Probe window. 

Now you can add traces. 

To select the current plot

Click the plot you want. 

To delete a plot

1. Click the Plot you want to delete.

2. From the Plot menu, choose Delete Plot. 
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To unsynchronize plots

If the selected plot is the middle plot of three plots sharing an X axis, then the middle plot is 
moved to the top position.

Note: After you have unsynchronized a plot, you cannot resynchronize it. You must delete 
the plot and add a new plot.

To unsynchronize a plot

1. Click the plot you want to become unsynchronized. 

2. From the Plot menu, choose Unsynchronize X Axis.

Using Probe windows

When you open a waveform data file, a new Probe window appears. 

You can have more than one Probe window at a time. Each Probe window can contain one 
or more plots. Each plot can contain both analog and digital traces. You can copy and paste 
traces among plots.

You can create, select, arrange, and delete Probe windows by using the Plot and Windows 
menus. The title for the Probe window is a list of the waveform data files open for that window. 

Probe windows feature automatic grid spacing. As you resize a Probe window, the major grid 
spacing changes, and the grid numbering appears as the numerals fit on the screen.

You can save the contents of a Probe window by using Display Control. Display control saves 
the plot configuration, including number of plots, traces and labels in each plot, x- and y-axis 
settings, and x-axis variable. 

You can print any or all of the plots in a Probe window. 

Toggling between display modes

You have the choice of using two different display modes. 

The standard (default) display mode in PSpice includes the main Probe window, plus the 
output window and the simulation status window. This provides all possible information about 
the simulation run and contains all of the toolbars and settings. 
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The alternate display mode shows only the Probe window with any waveforms that have been 
plotted. This mode gives you just the plots you are interested in seeing without the additional 
simulation data normally provided by PSpice. 

The toolbar and window settings are saved for each mode. Any changes you make in the 
settings will become the new default the next time you choose that display mode.

The alternate display mode can be very handy when you want to see the waveforms 
superimposed on the schematic diagram for easy debugging and testing of the circuit. You 
can customize the alternate display mode to view various toolbars or other PSpice windows, 
according to your own preferences. 

Note: By default, the alternate display mode is set to be visible at all times (see Keeping the 
Probe window visible at all times). 

To toggle between the standard and the alternate display modes:

1. From the View menu, choose Alternate Display or click the Alternate Display toolbar 
button.

Keeping the Probe window visible at all times

Like any other application running under Windows, the PSpice window will remain in the 
forefront of the desktop only as long as it is the active window. In order to keep the PSpice 
window visible at all times, you can use the push pin feature. 

By keeping the Probe window on top of other active windows, you can easily view the 
schematic page at the same time you see the corresponding waveform for that circuit. This 
allows you to cross-probe quickly and easily without having to activate the Probe window 
each time.

Note: The push pin button is a toggle; clicking on it when it is enabled will disable the “on top” 
function.

To make the Probe window visible at all times:

1. Click the push pin button in the toolbar or, from the View menu, choose Always on Top.

To print plots

Do one of the following:

1. To print one copy of the current Probe window using the default print settings, click the 
Printer button on the toolbar.
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2. Select the plots you want to print. 

3. If needed, select a printer and printer information. 

4. Click OK. 

Using Display Control

You can create displays to save the contents of a Probe window. You can view a display again 
at a later time with a different simulation so long as the new simulation has identically named 
variables. 

Once the display is saved, you can copy it, edit it, and delete it.

For more information, see the following topics:

❑ To save a display 

❑ To copy a display

❑ To delete a display

❑ To use a saved display

❑ To load displays from another .PRB file
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To save a display

1. Set up the plots, traces, labels, and axes in the Probe window you want to save. 

2. From the Window menu, choose Display Control.

The Display Control dialog box appears.

3. Click the Displays tab.

4. In the New Name text box, type a name for the display. 

5. Do one of the following:

❑ To save the display in the current .PRB file, click Save. 

❑ To save the display in another .PRB file, click Save To. Specify the name and location 
of the file. Click OK. 

6. Click Close. 

To copy a display

1. From the Window menu, choose Display Control.

The Display Control dialog box appears.

2. Click the Displays tab.

3. Click the name of the display to copy. 

4. Click Copy To. 

5. Specify the name and location of the copied display. 

6. Click OK. 

7. Click Close. 

To delete a display 

1. From the Window menu, choose Display Control.

The Display Control dialog box appears.

2. Click the Displays tab. 

3. Do one of the following:

❑ To delete a display from the current .PRB file, click the name, then click Delete. 
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❑ To delete a display from a global or remote .PRB file, click Delete From, then select 
the .PRB file.

4. Click Close. 

Using plot window templates 

PSpice provides plot window templates that allow you to create and reuse custom displays in 
Probe using defined arguments. A plot window template is a plot window consisting of one or 
more arguments used to represent node voltage, pin current, power or digital names within a 
display. An argument provides the means to replace a fixed node voltage or pin current name 
with a node voltage or pin current name you choose.

You can create unique plot window templates for a particular design or general templates that 
can be applied to various designs. A set of some of the more commonly used templates are 
predefined and included with PSpice.

To work with plot window templates, from the Window menu, choose Display Control, and 
click the Templates tab. Here you can customize plot window templates in various ways. See 
the Related Topics below for more detailed information.
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Related Topics

Creating a plot window template 

In order to create and save a new plot window template, you must first set up the active plot 
window in Probe with the configuration you want. The active plot window will be the basis for 
the template properties you save.

Note: Only those templates which apply to the active simulation are listed in the Template 
dialog box. For example, an AC simulation will show frequency domain templates such as 
Bode plot, while a transient analysis will show time domain templates such as risetime or 
pulsewidth. In addition, some predefined templates require multirun analyses (Monte Carlo 
analysis, time sweep, or parametric sweep).

To create a new plot window template

1. In PSpice, from the Window menu, choose Display Control.

2. Click the Templates tab.

For information 
about…

Click this topic…

Creating a new 
template…

Creating a plot window template

Modifying an 
existing template…

Modifying a plot window template

Deleting a 
template…

Deleting a plot window template

Copying a template… Copying a plot window template

Restoring a 
template…

Restoring a plot window template

Viewing the 
properties of a 
template…

Viewing the properties of a plot window template

Loading a template… Loading a plot window template

Placing plot window 
template markers…

Placing plot window template markers
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3. In the New Name text box, enter the name for the new template you want to create.

4. Click Save or Save To.

The Save Plot Window Template – Step 1 of 2 dialog box appears.

5. In the Description text box, type in a description for the template, if you would like one. 
(This is optional.)
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6. If you clicked Save To instead of Save, choose the .PRB file you wish to save the template 
to by selecting the appropriate radio button under the Store Template In frame. (The 
default is the local .PRB file. For the Save function, the Local File is the only option.)

❑ Local File – the .PRB file for the current simulation in PSpice.

❑ Global File – the .PRB file to be used globally for all Probe displays.

❑ Other File – another .PRB file stored elsewhere on your hard disk or network drive. 
Use the Browse button to locate the file on a particular drive.

7. Click Next.

The Save Plot Window Template – Step 2 of 2 dialog box appears. The number of Node/
Pin Name arguments that are listed here is determined by the current display.

8. Define the association of each argument by selecting the node or pin name from the 
drop-down list under the column Node/Pin Name. 

This drop-down list shows all of the available node voltage, pin current, power or digital 
names. If the drop-down list does not appear, click in the text box to activate the drop-
down button.

9. For each argument, set the Type of argument to be used by selecting the argument name 
from the drop-down list under the column Type. 

This drop-down list shows all of the available argument types (any, current, power, 
voltage). If the drop-down list does not appear, click in the text box to activate the drop-
down button.

10. For each argument, under the Description column, type in a description, if you would like 
one. (This is optional.) 

The description you enter here will be displayed in the status line of Capture when 
placing a marker associated with the argument. 
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11. If desired, change the order of the arguments by using the Arrow buttons to move an 
argument up or down in the listing. Or, you can delete an argument by selecting it and 
clicking the Delete button.

12. Click Finish.

Note: At least one argument is required to create a plot window template. The maximum 
number of arguments allowed is the number of unique node voltage, pin current, power or 
digital names in the active display.

Modifying a plot window template 

Modifying a plot window template is essentially the same as creating a new template. In order 
to modify a plot window template, that particular template must be the active plot window in 
Probe. If the active display is not the template you want to modify, use the Restore button to 
make a different template the active display in Probe (see Restoring a plot window template).

To modify a plot window template

1. From the Window menu, choose Display Control.

2. Click the Templates tab.

3. Select the template you want to modify by clicking on its name in the list of loaded 
templates. If the template you are looking for is not in the list, use the Restore button to 
make it the active display.

4. Click Save to display the Save Plot Window Template – Step 1 of 2 dialog box.

5. Make the desired changes, then click Next to display the Save Plot Window Template – 
Step 2 of 2 dialog box.

6. Make the desired changes, then click Finish.

The modifications will be saved and the display will be updated automatically.

Note: If an argument assignment no longer applies because the node voltage, pin current, 
power or digital names are mapped to an argument that has changed, then information 
regarding that argument will not be available in the Step 2 of 2 dialog box. 

Deleting a plot window template 

You can remove a plot window template from the list of loaded templates. By deleting a plot 
window template, you remove it from the list of templates you can access and erase it from 
the .PRB file.
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To delete a plot window template

1. From the Window menu, choose Display Control.

2. Click the Templates tab.

3. Click the name of the plot window template you want to delete.

4. Click Delete.

Copying a plot window template 

You can copy a plot window template into another .PRB file to make it available for use later 
with that file.

To copy a plot window template

1. From the Window menu, choose Display Control.

2. Click the Templates tab.

3. Click the name of the plot window template you want to copy.

4. Click Copy To.

The Probe File for Save Template dialog box appears.

5. Choose the .PRB file you wish to save the template to by selecting the appropriate radio 
button under the Store Template In frame. (The default is the local .PRB file.)

❑ Local File – the .PRB file for the current simulation in PSpice.

❑ Global File – the .PRB file to be used globally for all Probe displays.

❑ Other File – another .PRB file stored elsewhere on your hard disk or network drive. 
Use the Browse button to locate the file on a particular drive.

6. Click OK.

Restoring a plot window template 

In order to make a plot window template the active display in Probe, you must restore it. This 
process recalls a previously defined plot window template and sets up a new plot window in 
Probe using the arguments associated with that template. In order for the arguments in the 
template to apply, you must replace the node voltage names or pin current names for each 
argument contained in the restored template.
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Note: You can only restore plot window templates that are already loaded. If you want to 
restore a plot window template that does not appear in the list, you must first load it. To load 
a template, see Loading a plot window template.

To restore a plot window template

1. From the Window menu, choose Display Control.

2. Click the Templates tab.

3. Choose the plot window template you want to restore by clicking on its name in the list 
of loaded templates.

4. Click Restore.

The Restore Plot Window Template dialog box appears.

5. Reassign the node voltage names or pin current names for each argument in the list.

6. Click OK.

A new Probe window will be created and the restored plot window template will be 
displayed.

Note: You may also restore a plot window template by choosing the Add Trace command 
from the Trace menu, and then selecting Plot Window Templates from the drop-down list in 
the Functions or Macros frame.
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Viewing the properties of a plot window template 

You can view the properties of a plot window template and change the description fields for 
the template or arguments it contains.

Note: Only those templates which apply to the active simulation are listed in the Template 
dialog box. For example, an AC simulation will show frequency domain templates such as 
Bode plot, while a transient analysis will show time domain templates such as risetime or 
pulsewidth. In addition, some predefined templates require multirun analyses (Monte Carlo 
analysis, time sweep, or parametric sweep).

To view the properties of a plot window template

1. From the Window menu, choose Display Control.

2. Click the Templates tab.

3. Click the name of the plot window template you want to view.

4. Click Properties.

The Plot Window Template Properties dialog box appears.

5. Change the Description field for the template, or change the description for any of the 
Arguments, as desired.

6. Click Finish to exit and save any changes.
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Note: When viewing the properties of a template, you can only edit the description fields. No 
other changes are allowed. If you want to modify the arguments or assignments, see 
Modifying a plot window template. 

Loading a plot window template 

You can load a plot window template from another .PRB file, and add it to the list of available 
templates. When you load a template, you do not make it the active display in Probe. You are 
only adding it to the list of available templates. (To restore the display of a newly loaded 
template, see Restoring a plot window template.)

If a duplicate template is loaded, then the one you are loading will replace the current one in 
the list. If you close the data file and reopen it, any plot window templates that you loaded 
earlier will have to be loaded again to make them available. (Loaded templates are not saved 
with the data file.)

To load a plot window template

1. From the Window menu, choose Display Control.

2. Click the Templates tab.

3. Click Load.

The Load Displays dialog box appears.

4. Locate the .PRB file that contains the plot window template you want to load.

5. Select the file and then choose Open. 

The loaded templates will be listed in the Display Control dialog box.

Placing plot window template markers

You can place a marker in Capture that represents a plot window template. The marker will 
restore the associated template when you run the simulation in PSpice. Markers for plot 
window templates are distinguished from other markers (for voltage, current, or power) by 
being square rather than round in shape. 
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A simulation profile must be active in order to place a marker for a plot window template. The 
analysis type defined in the profile will determine what type of template will be loaded (either 
for AC, DC or transient analysis). Plot window templates are defined for one analysis type 
only. For example, an AC simulation will show frequency domain templates such as Bode plot, 
while a transient analysis will show time domain templates such as risetime or pulsewidth. In 
addition, some predefined templates require multirun analyses (Monte Carlo analysis, time 
sweep, or parametric sweep).

When placing a plot window template marker, the argument description for the template being 
placed will appear in the status bar of Capture. Markers will continue to be placed until all 
arguments for the template have been satisfied. If an active simulation exists, then the 
template markers will turn black; otherwise, they will remain gray. 

If an argument type is set to "Any" rather than a specific type, the marker type will depend on 
the marker placement location. If a marker is placed on a pin, then it will be assumed to be a 
current marker. If a marker is placed on a node, it will be assumed to be a voltage marker. If 
a marker is placed on a device, it will be assumed to be a power marker. 

To place a plot window template marker

1. In Capture, from the PSpice menu, choose Markers, then select Plot Window Templates.

The Plot Window Templates dialog box appears.
June 2020 175 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



PSpice Help
Traces
2. Click the template you want to associate with the marker you will place.

3. Click Place.

A plot window template marker will appear and be attached to the cursor. 

4. Place the marker at a particular location on the schematic page.

5. Continue to place markers at the appropriate locations until all the arguments for the 
template have been satisfied.

Note: PSpice does not have to be running in order for you to place a marker for a plot window 
template. The list of loaded templates comes from either the default PSpice.PRB file or from 
the .PRB file for the active profile, if that exists.
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Related Topics

Labeling plots

You can place labels to annotate an analog plot. Labels can be placed anywhere on the trace 
window, including outside the current Probe window where they are not visible. Unless you 
specifically set the plot region, PSpice rescales the plot so that all labels are visible.

You can place the following labels. Click one to display a procedure of how to use it.

To move a label

1. Click to select a label. Shift+click to select several labels. 

For information 
about…

Click this topic…

Plot window 
templates in PSpice 
…

Using plot window templates

Working with 
current, voltage or 
power markers…

Using markers

Defining simulation 
profiles…

Creating a new simulation profile

text To place text

Line To draw a line

Box To draw a box

circle To draw a circle

poly-line To draw a poly-line

Arrow To draw an arrow

Ellipse To draw an ellipse

mark To mark the cursor location
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2. Drag the labels to a new location, holding the mouse button down on the edge of one of 
the labels.

3. Release the mouse button to place the labels. 

To delete a label 

1. Click to select a label. Shift+click to select several labels. 

2. From the Edit menu, choose Delete.

To place text

1. On the toolbar, click the Text button.

2. In the Text Label dialog box, type a label in the text box. You can use up to 124 characters, 
including spaces. 

3. Click OK. 

4. Move the cursor to where you want to place the text. 

5. Click to place the text. 

To draw a line 

1. From the Plot menu, point to Label, then choose Line.

2. Click the start point for the line. 

3. Move the pointer to the end point for the line. 

4. Click to set the end point and draw the line. 

To draw a poly-line

1. From the Plot menu, point to Label, then choose Poly-line.

2. Click the start point for the line. 

3. Move the pointer to the end point for the first segment. 

4. Click to set the end point and draw the first segment. 

5. Repeat steps 3 and 4 for the other segments. 

6. Right-click to complete the poly-line label.
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Note: When you create single poly-lines, PSpice changes all the line segments to single 
poly-line labels.

To draw an arrow

1. From the Plot menu, point to Label, then choose Arrow.

2. Click the start point for the arrow. The arrowhead appears on the other end. 

3. Move the pointer to the end point for the line. 

4. Click to set the end point and draw the arrow. 

To draw a box 

1. From the Plot menu, point to Label, then choose Box.

2. Click to set the first corner of the box. 

3. Move the pointer to the other corner of the box. 

4. Click to set the corner and draw the box. 

To draw a circle 

1. From the Plot menu, point to Label, then choose Circle.

2. Click to set the center of the circle. 

3. Move the pointer to the outside point of the circle. 

4. Click to set the radius and draw the circle. 

To draw an ellipse

1. From the Plot menu, point to Label, then choose Ellipse.

2. Type the inclination angle and click OK.

3. Click to place the center of the ellipse. 

4. Move the pointer to size and shape the ellipse. 

5. Click to draw the ellipse. 
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To mark the cursor location

The Mark command places a cursor mark at the position of the most recently moved cursor. 

A cursor mark consists of a text label with the coordinates of the cursor placed above and to 
the right of the cursor and a line label with one end anchored to the trace at the cursor and 
the other end placed just below the text. 

If the line label is moved, the end anchored to the trace does not move, and the line stretches 
and rotates about the anchor point.

Editing labels 

There are several ways to edit items in PSpice:

■ You can copy the current Probe window to the Windows clipboard to be pasted in another 
Windows application. 

■ Other items can be cut and pasted. 

■ Objects like a single trace expression, a single text label, or a single ellipse label can be 
edited; edit traces by changing the expression that describes the trace. 

■ The text of text labels or inclination angle of ellipse labels can also be edited. For 
example, you can change the title of the currently active Probe window. 

For more information, see the following topics:

❑ Copying Probe data to other applications 

❑ To copy and paste an item 

❑ To modify a label or an ellipse angle 

To copy a Probe window to the clipboard

1. Click the tab of the Probe window you want to copy. 

2. From the Window menu, choose Copy to Clipboard. The status line and the menu bar 
are not copied. 

3. Paste the bitmap into a graphics program like Microsoft Paint.

4. Edit the bitmap as needed. 

5. Do one of the following:
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❑ Save the bitmap to a file. Use this option if you are going to need the bitmap in 
several applications. 

❑ Copy the bitmap again and paste it in another application. 

To copy and paste an item

1. Click an item. 

2. On the toolbar, click the Copy button.

3. On the toolbar, click the Paste button.

4. Click to place the item. 

To modify a trace

1. Do one of the following:

❑ Click the trace name. From the Edit menu, choose Modify Object.

❑ Double-click the trace name. 

2. Do any of the following:

❑ Select a new expression from the list. 

❑ Type in a new expression. 

❑ Modify the existing expression. 

3. Click OK. 

To modify a label or an ellipse angle

1. Click a label or an ellipse. 

2. From the Edit menu, choose Modify Object. 

3. Make any changes in the dialog box.

4. Click OK. 
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Copying Probe data to other applications

Copying Probe window to the Windows Clipboard and word processing applications

To copy a Probe window to the Windows Clipboard and word processing applications like 
Microsoft Word, do the following:

1. Click the tab of the Probe window you want to copy. 

2. From the Window menu, choose Copy to Clipboard. The Copy to Clipboard dialog box 
appears.

3. Select the Make window and plot backgrounds transparent check box if you want to copy 
the probe window and plot background with a transparent background.

4. Select the appropriate check box for the foreground color.

5. Click OK. 

The Probe window is copied to the Windows Clipboard. The status line and the menu bar 
are not copied. 

6. Paste the bitmap into a graphics program like Microsoft Paint.

7. Edit the bitmap as needed. 

8. Do one of the following:

❑ Save the bitmap to a file. Use this option if you are going to need the bitmap in 
several applications. 

❑ Copy the bitmap again and paste it in another application. 

Copying Probe data to spreadsheet applications and math programs

You can copy the X and Y-axis data for traces on the Probe window to text editors, 
spreadsheet applications and math programs. You can then manipulate the data for your own 
purposes. For example, you can define custom measurement functions in Microsoft Excel 
and analyze the Probe data using those functions. You can also use the probe data in 
spreadsheet applications to create charts or graphs for presentation purposes.

1. Click the tab of the Probe window from which you want to copy the data. 

2. Click the trace name in the plot legend. To select more than one trace name, use 
SHIFT+click or CTRL+click.

3. From the Edit menu choose Copy.
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4. Do one of the following:

❑ Paste the data into a spreadsheet or math program. 

❑ Paste the data into a text editor and save it to an ASCII text file. The data is stored 
in a tab-delimited format. 

Use this option if you want to import the data into other applications.

Loading large data file

To load a large data file, you can select one of the following methods:

■ Displaying fewer data points 

■ Displaying partial trace 

Displaying fewer data points

Instead of using all the data points in the .dat file, only a few points are used to construct the 
complete trace. The number of data points used to construct the complete trace depends on 
the number of data points per trace defined in PSpice. By default, this limit is set to 1 million 
points, but if required, users can increase this limit. See Setting large data file options 

Displaying partial trace

The complete trace is divided into multiple smaller parts. Only a part of the trace is loaded 
and displayed. Number of partial traces created depends on total number of data points used 
to define the trace and also on the number of data points per trace allowed in PSpice. By 
default, the number of data points per trace is set to 1 million points, but if required, users can 
increase this limit. See Setting options for large data files.

Importing traces

PSpice now allows you to import the traces stored in tabular format in a text (.txt) or comma-
separated (.csv) file. Using the import feature you can import waveforms generated by 
measuring instruments such as digital oscilloscope to PSpice. 

To import a trace into PSpice, saved in a text (.txt) or a comma-separated (.csv) file complete 
the following steps.

1. From the File menu, choose Import. 
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2. In the Import File dialog box, select the text file to be imported in PSpice.

The Import Traces dialog box appears. All the nodes listed in the source file are listed in 
the X-axis drop-down list and the Available Nodes list.

3. In the Import Traces dialog box, specify the name and the location of the .DAT file in 
which the imported trace is to be stored. 

4. From the X-Axis drop-down list box, select the node name to be plotted on the X-Axis. 

5. Specify a name for the X-axis. Select one of the following options for naming the X-axis.

a. Time

b. Frequency

c. Sweep Variable: when you select Sweep Variable, you need to specify the variable 
name in the enabled text box. 

6. From the Available Traces list box, select the traces that are to be imported in PSpice.

7. Click Add. 

The selected traces appear in the Import Trace list box. To import all the traces available 
in the source file, click the Add All. 

8. Select OK to import the selected trace(s).

Import Traces

This dialog box appears when you try to import a traces saved in the text format or in a .csv 
file.

DAT File Path Specify the name and location of the data file in which the 
imported trace will be saved.

X-Axis Select the trace that is to be plotted along the X-Axis.

The X-Axis drop-down list box lists all the traces available in the 
.txt or the .csv file.

Specify a name for 
the X-Axis using 
one of the 
following options.

Time Select this, if you want to rename the X-axis as Time. 
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Frequency Select this, if you want to rename the X-axis as Frequency. 

Sweep Variables Select this, if you want to specify a user-defined name for the X-
axis. Specify the name in the enabled text box.

Available Traces Lists all the traces available in the .txt or .csv file. 

Imported Traces Lists all the traces that will be imported in the .dat file.

Add Click this to add the selected trace to the Import Trace list.

Add All Click this to add all the available traces into the Import Traces 
list. 

Note: The trace selected as X-Axis, will not appear in the Import 
Traces list box.

Remove Click this to remove the selected traces from the Import Trace 
list.

Remove All Click this to empty the Import Traces list
June 2020 185 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



PSpice Help
Traces
June 2020 186 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



PSpice Help
Using performance analysis and 
measurements

Using Performance Analysis

Performance Analysis allows you to add traces that show how a derived value changes 
between simulation runs. The derived value is calculated for each run based on the 
measurement expression you specify when you add each trace.

To prepare for using Performance Analysis

1. Have multiple sections of data in the Probe data file. Enabling a parametric analysis, a 
temperature analysis with multiple temperatures, or a Monte Carlo analysis causes the 
simulator to do multiple simulations of the circuit. Each simulation creates one section of 
data.

2. Create measurement definitions you want to use and bring them into PSpice. Do one of 
the following:

a. Use the predefined measurement definitions in the file PSpice.PRB.

b. Create measurement definitions in a .PRB file, using an ASCII text editor like 
Notepad. Save the file with a .PRB extension. Load the file into PSpice as a global 
file. 

c. Create new or edit existing measurement definitions while running Probe: from the 
Trace menu, select Measurements, then select New or Edit. 

Using Measurement Expressions

Measurement expressions evaluate the characteristics of a waveform. A measurement 
expression is made by choosing the waveform and the waveform calculation you want to 
evaluate.

The waveform calculation is defined by a measurement definition such as rise time, bandpass 
bandwidth, minimum value, and maximum value.
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For example, if you want to measure the risetime of your circuit output voltage, use the 
following expression:

Risetime_NoOvershoot(v(out))

Measurement strategy

■ Start with a circuit created in Capture and a working PSpice simulation.

■ Decide what you want to measure.

■ Select the measurement definition that matches the waveform characteristics you want 
to measure.

■ Insert the output variable (whose waveform you want to measure) into the measurement 
definition, to form a measurement expression.

■ Test the measurement expression.

Composing Measurement Expressions

These steps show you how to create a measurement expression in PSpice. Measurement 
expressions created in PSpice can be imported into Advanced Analysis.

1. Work in the Simulation Results view in PSpice. In the side toolbar, click .

2. From the Trace menu in PSpice, select Measurements.

The Measurements dialog box appears.

3. Select the measurement definition you want to evaluate.

4. Click Eval (evaluate).

The Arguments for Measurement Evaluation dialog box appears.

5. Click the Name of trace to search button.

The Traces for Measurement Arguments dialog box appears.

Note: You will only be using the Simulation Output Variables list on the left side. Ignore 
the Functions or Macros list. 

6. Uncheck the output types you don’t need (if you want to simplify the list).

7. Click the output variable you want to evaluate.

The output variable appears in the Trace Expression field.
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8. Click OK.

The Arguments for Measurement Evaluation dialog box reappears with the output 
variable you chose in the Name of trace to search field.

9. Click OK.

Your new measurement expression is evaluated and displayed graphically in the PSpice 
window.

10. Click OK in the Display Measurement Evaluation pop-up box to continue working in 
PSpice.

Your new measurement expression is saved, but it no longer displays in the window. The 
only way to get another graphical display is to redo these steps. 

You can see the numerical evaluation of your measurement expression by following the steps 
in the topic Viewing Measurement Results.

See the topic Measurement Expression Example for an example.

Measurement Expression Example

These steps show you an example of creating a measurement expression in PSpice.

 Work in the Simulation Results view in PSpice. In the side toolbar, click .

1. Choose Trace – Measurements.

The Measurements dialog box appears.

2. Select the measurement definition you want to evaluate.

3. Click Eval (evaluate).

The Arguments for Measurement Evaluation dialog box appears.

4. Click the Name of trace to search button.

The Traces for Measurement Arguments dialog box appears.

Note: You will only be using the Simulation Output Variables list on the left side. Ignore 
the Functions or Macros list. 

5. Uncheck the output types you don’t need (if you want to simplify the list).

6. Click the output variable you want to evaluate.
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The output variable appears in the Trace Expression field.

7. Click OK.

The Arguments for Measurement Evaluation dialog box reappears with the output 
variable you chose in the Name of trace to search field.

8. Click OK.

Your new measurement expression is evaluated and displayed graphically in the PSpice 
window.

9. Click OK in the Display Measurement Evaluation pop-up box to continue working in 
PSpice.

Your new measurement expression is saved, but it no longer displays in the window. The only 
way to get another graphical display is to redo these steps. 

You can see the numerical evaluation of your measurement expression by following the steps 
in the topic Viewing Measurement Results.

Viewing Measurement Results

To view the results of measurement expressions you have previously composed:

1. From the View menu in PSpice, select Measurement Results.

The Measurement Results table displays below the plot window.

2. Click the box in the Evaluate column.

The PSpice calculation for your measurement expression appears in the Value column.

See the topic Measurement Results Example for an example.

Evaluating a measurement

After simulating a circuit, you can add new measurements in the Measurement Results 
window, and evaluate them. To add a measurement for evaluation:

1. From the Trace menu in PSpice, choose Evaluate Measurement.

The Evaluate Measurement dialog box displays, with Measurements selected in the 
Functions or Macros drop-down list box.

Note: Alternatively, the Evaluate Measurement dialog box can be invoked using the 
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Evaluate Measurement icon from the toolbar.

2. Select the measurement that you want to evaluate by clicking one of the entries in the 
Measurements list. 

3. From the Simulation Output Variables list, click the variable to be passed as a 
parameter to the selected measurement, and click OK.

The new measurement gets added in the Measurement Results table displayed below 
the plot window.

The PSpice calculation for your measurement expression appears in the Value column.

Note: To view information about measurements provided by PSpice, see Measurement 
Definitions Included with PSpice.

To view information on how to create new measurements, see Composing Measurement 
Expressions.

Measurement Results Example

1. Choose View - Measurement Results.

The Measurement Results table displays below the plot window.

2. Click the box in the Evaluate column.

A check mark appears in the Evaluate column check box and the PSpice calculation for 
your measurement expression appears in the Value column.
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Measurement Definitions Included with PSpice 

Definition Finds the. . .

Bandwidth Bandwidth of a waveform (you choose dB level)

Bandwidth_Bandpass_
3dB

Bandwidth (3dB level) of a waveform 

Bandwidth_Bandpass_
3dB_XRange

Bandwidth (3dB level) of a waveform over a specified X-range

CenterFrequency Center frequency (dB level) of a waveform

CenterFrequency_XRa
nge

Center frequency (dB level) of a waveform over a specified X-
range

ConversionGain Ratio of the maximum value of the first waveform to the 
maximum value of the second waveform

ConversionGain_XRan
ge

Ratio of the maximum value of the first waveform to the 
maximum value of the second waveform over a specified X-
range

Cutoff_Highpass_3dB High pass bandwidth (for the given dB level)

Cutoff_Highpass_3dB
_XRange

High pass bandwidth (for the given dB level)

Cutoff_Lowpass_3dB Low pass bandwidth (for the given dB level) 

Cutoff_Lowpass_3dB_
XRange

Low pass bandwidth (for the given dB level) over a specified 
range

DutyCycle Duty cycle of the first pulse/period

DutyCycle_XRange Duty cycle of the first pulse/period over a range

Falltime_NoOvershoo
t

Falltime with no overshoot.

Falltime_StepRespon
se

Falltime of a negative-going step response curve

Falltime_StepRespon
se_XRange

Falltime of a negative-going step response curve over a 
specified range

GainMargin Gain (dB level) at the first 180-degree out-of-phase mark 

Max Maximum value of the waveform

Max_XRange Maximum value of the waveform within the specified range of X 
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Min Minimum value of the waveform

Min_XRange Minimum value of the waveform within the specified range of X

NthPeak Value of a waveform at its nth peak

Overshoot Overshoot of a step response curve

Overshoot_XRange Overshoot of a step response curve over a specified range

Peak Value of a waveform at its nth peak

Period Period of a time domain signal

Period_XRange Period of a time domain signal over a specified range

PhaseMargin Phase margin

PowerDissipation_mW Total power dissipation in milli-watts during the final period of 
time (can be used to calculate total power dissipation, if the first 
waveform is the integral of V(load)

Pulsewidth Width of the first pulse

Pulsewidth_XRange Width of the first pulse at a specified range

Q_Bandpass Calculates Q (center frequency / bandwidth) of a bandpass 
response at the specified dB point 

Q_Bandpass_XRange Calculates Q (center frequency / bandwidth) of a bandpass 
response at the specified dB point and the specified range

Risetime_NoOvershoo
t

Risetime of a step response curve with no overshoot

Risetime_StepRespon
se

Risetime of a step response curve

Risetime_StepRespon
se_XRange

Risetime of a step response curve at a specified range

SettlingTime Time from <begin_x> to the time it takes a step response to 
settle within a specified band

SettlingTime_XRange Time from <begin_x> to the time it takes a step response to 
settle within a specified band and within a specified range

SlewRate_Fall Slew rate of a negative-going step response curve

SlewRate_Fall_XRang
e

Slew rate of a negative-going step response curve over an X-
range

SlewRate_Rise Slew rate of a positive-going step response curve
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Creating Custom Measurement Definitions

Measurement definitions establish rules to locate interesting points and compute values for a 
waveform. In order to do this, a measurement definition needs:

■ A measurement definition name

■ A marked point expression

These are the calculations that computer the final point on the waveform.

■ One or more search commands

These commands specify how to search for the interesting points.

SlewRate_Rise_XRang
e

Slew rate of a positive-going step response curve over an X-
range

Swing_XRange Difference between the maximum and minimum values of the 
waveform within the specified range

XatNthY Value of X corresponding to the nth occurrence of the given 
Y_value, for the specified waveform

XatNthY_NegativeSlo
pe

Value of X corresponding to the nth negative slope crossing of 
the given Y_value, for the specified waveform

XatNthY_PercentYRan
ge

Value of X corresponding to the nth occurrence of the waveform 
crossing the given percentage of its full Y-axis range; 
specifically, nth occurrence of Y=Ymin+(Ymax-Ymin)*Y_pct/
100

XatNthY_Positive 
Slope

Value of X corresponding to the nth positive slope crossing of 
the given Y_value, for the specified waveform

YatFirstX Value of the waveform at the beginning of the X_value range

YatLastX Value of the waveform at the end of the X_value range

YatX Value of the waveform at the given X_value

YatX_PercentXRange Value of the waveform at the given percentage of the X-axis 
range

ZeroCross X-value where the Y-value first crosses zero

ZeroCross_XRange X-value where the Y-value first crosses zero at the specified 
range
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Strategy

1. Decide what you want to measure.

2. Examine the waveforms you have and choose which points on the waveform are needed 
to calculate the measured value.

3. Compose the search commands to find and mark the desired points.

4. Use the marked points in the Marked Point Expressions to calculate the final value for 
the waveforms.

5. Test the search commands and measurements.

Note: An easy way to create a new definition:

Choose Trace- Measurements to open the Measurements dialog box, then:

■ Select the definition most similar to your needs

■ Click Copy and follow the prompts to rename and edit.

Composing a New Measurement Definition

These steps show you how to create a measurement definition in PSpice. Measurement 
definitions can be directly evaluated or used as part of measurement expressions.

Work in the Simulation Results view in PSpice. In the side toolbar, click .

1. From the PSpice Trace menu, choose Measurements.

The Measurements dialog box appears.

2. Click New to start with the basic template definition, or click Copy to start your new 
measurement definition using an existing definition.

The New Measurement dialog box or the Copy Measurement dialog box appears.

3. Type a name for the new measurement in the New Measurement name field. All 
measurement definitions must have unique names.

4. Make sure local file is selected.

This stores the new measurement in a .PRB file local to the design.

5. Click OK.

The Edit New Measurement dialog box appears. If you have copied a measurement 
definition, you will need to click Edit on the Measurements dialog box.
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6. Type in the marked point expression.

7. Type in any comments you want.

8. Type in the search command function.

Your new measurement definition is now listed in the Measurements dialog box.

See the topic Measurement Definition Example for an example.

Managing Measurements

You can use this dialog to evaluate measurement expressions or to create, edit, or delete 
existing measurements definitions.

■ New allows you to compose a new measurement definition.

■ Copy allows you to copy an existing measurement definition. This is a good way to start 
when you want to create a new measurement definition.

■ View allows you to see the marked point expression, search function, and comments of 
the selected measurement definition.

■ Edit allows you to modify the selected measurement definition.

■ Delete allows you to remove the selected measurement definition. Once it has been 
deleted, you cannot undelete it.

■ Eval allows you to evaluate a measurement expression using the selected measurement 
definition.

■ Load allows you to load a different .PRB file with different measurement definitions. The 
load command on this Measurements dialog box will only load the measurement 
definitions from the .PRB file. Macros and displays will not be included.

Copying a Measurement Definition

Copying a measurement definition allows you to modify an existing measurement definition 
without losing the original definition.

Work in the Simulation Results view in PSpice. In the side toolbar, click .

1. Choose Trace - Measurements.

The Measurements dialog box appears.
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2. Select a measurement from the list and click Copy.

The Copy Measurement dialog box appears.

3. Type a name for the new measurement definition in the New Measurement name field. 
All measurement definitions must have unique names.

4. Make sure local file is selected.

This stores the new measurement in a .PRB file local to the design.

5. Click OK.

To edit your new measurement definition, click Edit on the Measurements dialog box. See 
Editing a Measurement Definition for more information.

Editing a Measurement Definition

Editing a measurement definition allows you to change the result it will evaluate. 

Work in the Simulation Results view in PSpice. In the side toolbar, click .

1. Choose Trace - Measurements.

The Measurements dialog box appears.

2. Select a measurement from the list and click Edit.

The Edit Measurement dialog box appears.

3. Edit the marked point expression as needed.

4. Edit the comments as needed.

5. Edit the search command function as needed.

Measurement Definition Example

1. From the PSpice Trace menu, choose Measurements.

The Measurements dialog box appears.

2. Click New.

The New Measurement dialog box appears.

3. Type a name for the new measurement in the New Measurement name field.
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4. Make sure local file is selected.

This stores the new measurement in a .prb file local to the design.

5. Click OK.

The Edit New Measurement dialog box appears.

6. Type in the marked point expression.

Point707(1) = y1

7. Type in any comments you want.

*

#Desc# Find the .707 value of the trace.

*

#Arg1# Name of trace to search

*

8. Type in the search function.

{

1|Search forward level(70.7%, p) !1;

}

Note: The search function is enclosed within curly braces. 

Always place a semi-colon at the end of the last search function.

You now have your edited measurement definition.

9. Click OK to save your edits.

Your new measurement definition is now listed in the Measurements dialog box.

Measurement Definition Syntax

Measurement definitions have the following structure and syntax:

Measurement_name (1, [2, …., n][, subarg1, subarg2, …, subargm]) = 
Marked_point_expression

{
1| search_commands_and_marked_points_for_expression_1;
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2| search_commands_and_marked_points_for_expression_2;

n| search_commands_and_marked_points_for_expression_n;
}

For examples of syntax, check out the existing measurement definitions in PSpice. 

1. From the Trace menu in PSpice, choose Measurements.

The Measurement dialog box appears.

2. Highlight an existing measurement definition, for example Risetime_NoOvershoot, and 
select View to examine the syntax.

The View Measurement dialog box appears.

The name of the measurement is Risetime_NoOvershoot. Risetime_NoOvershoot takes 1 
argument, a trace name (as seen from the comments).

The first search function searches forward (positive x direction) from the point on the trace 
where the waveform crosses the 10% point in a positive direction. That point’s X and Y 
coordinates will be marked and saved as point 1.

The second search function searches forward in the positive direction for the point on the 
trace where the waveform crosses the 90% mark. That point’s X and Y coordinates will be 
marked and saved as point 2. 

The marked point expression is x2-x1. This means the measurement calculates the X value 
of point 2 minus the X value of point 1 and returns that number. 

Measurement Name Syntax

Names can contain any alphanumeric character (A-Z, 0-9) or an underscore _, up to 50 
characters in length. The first character should be an upper or lower case letter. 

Examples of valid function names: Bandwidth, CenterFreq, delay_time, DBLevel1.
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Marked Point Expression Syntax

A marked point expression calculates a single value, which is the value of the measurement, 
based on the X and Y coordinates of one or more marked points on a curve. The marked 
points are found by the search command. 

■ All the arithmetic operators (+, -, *, /, () ) and all the functions that apply to a single point 
(for example, ABS(), SGN(), SIN(), SQRT() ) can be used in marked point expressions. 

■ The result of the expression is one number (a real value).

■ Marked point expression differ from a regular expression in the following ways:

■ Marked point coordinate values (for example, x1, y3), are used instead of simulation 
output variables (v(4), ic(Q1) ).

■ Multiple-point functions such as d(), s(), AVG(), RMS(), MIN(), and MAX() cannot be 
used.

■ Complex functions such as M(), P(), R(), IMG(), and G() cannot be used.

■ One additional function called MPAVG can also be used. It is used to find the average Y 
value between 2 marked points. The format is:

MPAVG(p1, p2,[<.fraction>])

where p1 and p2 are marked X points and fraction (expressed in decimal form) specifies the 
range. The range specified by [<.fraction>] is centered on the midpoint of the total range. The 
default value is 1.

An example:

The marked point expression

MPAVG(x1, x5, .2)

Will find the halfway point between x1 and x5 and will calculate the average Y value based 
on the 20 percent of the range that is centered on the halfway point. 

Comments Syntax

A comment line always starts with an asterisk. Special comment lines include the following 
examples:

*#Desc#* The measurement description.
*#Arg1#* The first argument used in the measurement definition.
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These comment lines will be used in dialog boxes, such as the Arguments for Measurement 
Evaluation box. 

Search Command Syntax

Search commands can be used to find a particular point along a trace based on 
characteristics of that trace. Search commands can be used for two purposes:

■ To position the cursor at a specific place along a trace.

■ As part of a measurement definition<definition>, where the point found by the search can 
be used as a marked point.

Search    [direction]    [/start_point/]    [#consecutive_points#]    
[(range_x[,range_y])]

[for]         [repeat:]      <condition>

Brackets indicate optional arguments.

You can use uppercase or lowercase characters, because searches are case independent.

[direction]

The direction of the search. The search begins at the origin of the curve.

[Forward] searches in the normal X expression direction, which may appear as backwards 
on the plot if the X axis has been reversed with a user-defined range.

Forward is the default direction.

[/start_point/]

The starting point to begin a search. The current point is the default.

forward Search forward on the trace

backward Search backwards on the trace

Use this To start the search at this…

^ The first point in the search range

Begin The first point in the search range

$ The last point in the search range

End The last point in the search range
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For example:

X1

(x1 –  (x2 – x1) / 2)

[#consecutive_points#]

Defines the number of consecutive points required for a condition to be met. Usage varies for 
individual conditions; the default is 1. 

A peak is a data point with one neighboring data point on both sides that has a lower Y value 
than the data point.

If [#consecutive_point#] is 2 and <condition> is PEak, then the peak searched for is a 
data point with two neighboring data points on both sides with lower Y values than the marked 
data point.

[(range_x[,range_y])]

Specifies the range of values to confine the search.

The range can be specified as floating-point values, as a percent of the full range, as marked 
points, or as an expression of marked points. The default range is all points available.

Some examples:

[for] [repeat:] <condition>

Specifies which occurrence of <condition> to find.

xn A marked point number or an expression of marked points. 

This range… Means this…

(1n,200n) X range limited from 1e-9 to 200e-9, Y range defaults to full 
range

(1.5,20e-9,0,1m) Both X and Y ranges are limited

(5m,1,10%,90%) Both X and Y ranges are limited

(0%,100%,1,3) Full X range, limited Y range

(,,1,3) Full X range, limited Y range

(,30n) X range limited only on upper end
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If repeat is greater than the number of found instances of <condition>, then the last 
<condition> found is used.

For example, the argument:

2:LEvel

would find the second level crossing.

The <condition> must be exactly one of the following:

■ LEvel(value[,posneg])

■ SLope[(posneg)]

■ PEak

■ TRough

■ MAx

■ MIn

■ POint

■ XValue(value)

Each <condition> requires just the first 2 characters of the word. For example, you can 
shorten LEvel to LE.

If a <condition> is not found, then either the cursor is not moved or the measurement 
definition is not evaluated.

LEvel(value[,posneg])

<value> can take any of the following forms:

Value Form Example

A floating number 1e5 100n 1

A percentage of 
full range

50%

A marked point Or 
an expression of 
marked points

X1 Y1 (x1-x2)/2
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Decimal point ( . )

A decimal point ( . ) represents the Y value of the last point found using a search on the current 
trace expression of the measurement definition. If this is the first search command, then it 
represents the Y value of the start point of the search.

[,posneg]

Finds the next Y value crossing at the specified level. This can be between real data points, 
in which case an interpolated artificial point is created.

At least [#consecutive_points#]-1 points following the level crossing point must be on the 
same side of the level crossing for the first point to count as the level crossing.

[,posneg] can be Positive (P), Negative (P), or Both (B). The default is Both.

SLope[(posneg)]

Finds the next maximum slope (positive or negative as specified) in the specified direction. 

[(posneg)] refers to the slope going Positive (P), Negative (N), or Both (B). If more than the 
next [#consecutive_points#] points have zero or opposite slope, the Slope function does not 
look any further for the maximum slope.

Positive slope means increasing Y value for increasing indices of the X expression.

The point found is an artificial point halfway between the two data points defining the 
maximum slope.

The default [(posneg)] is Positive.

A value relative to 
startvalue

.-3 (startvalue –3) 

.+3 (startvalue +3)

A db value relative 
to startvalue

.-3db (3db above startvalue)

.+3db (3db below startvalue) 

A value relative to 
max or min

Max-3 (maxrng –3) 

Min+3 (minrng +3)

A db value relative 
to max or min

Max-3db (3db below maxrng) 

Min+3db (3db above maxrng)
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PEak

Finds the nearest peak. At least [#consecutive_points#] points on each side of the peak must 
have Y values less than the peak Y value.

TRough

Finds nearest negative peak. At least [#consecutive_points#] points on each side of the 
trough must have Y values greater than the trough Y value.

MAx

Finds the greatest Y value for all points in the specified X range. If more than one maximum 
exists (same Y values), then the nearest one is found. 

MAx is not affected by [direction], [#consecutive_points#], or [repeat:].

MIn

Finds the minimum Y value for all points in the specified X range. 

MIn is not affected by [direction], [#consecutive_points#], or [repeat:].

POint

Finds the next data point in the given direction.

XValue(value)

Finds the first point on the curve that has the specified X axis value. 

The <(value)> is a floating-point value or percent of full range 

XValue is not affected by [direction], [#consecutive_points#], [(range_x [,range_y])], or 
[repeat:].

<(value)> can take any of the following forms:

Value Form Example

A floating number 1e5 100n 1
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ForceDBArg1

Converts a non-DB trace to a dB trace. Used in measurement functions such as 
Bandwidth_Bandpass_3dB and Cutoff_Highpass_3dB.

Limiting a Measurement Expression to a Specific Range of Data

You can restrict the data that measurement expressions apply to. 

To limit the data 

1. From the Plot menu, select Axis Settings. 

2. Click the X Axis tab

3. Select User Defined in the Data Range frame and enter the desired start and finish 
values. 

4. Click OK. 

All measurement expressions used are applied to the data range you specified. 

A percentage of 
full range

50%

A marked point Or 
an expression of 
marked points

X1 

Y1

(x1-x2)/2

A value relative to 
startvalue

.-3 (startvalue –3)

.+3 (startvalue +3)

A db value relative 
to startvalue

.-3db (3db below startvalue)

.+3db (3db above startvalue)

A value relative to 
max or min

Max-3 (maxrng –3)

Min+3 (minrng +3)

A db value relative 
to max or min

Max-3db (3db below maxrng)

Min+3db (3db above maxrng)
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Control Elements in Dialog Boxes

Help

Click to display Help. 

Close

Click to close the measurement dialog box. 

Measurement Function Expression

Type the measurement function argument. 

Name of Trace to Search Frame

Type any other measurement arguments needed to complete the expression. 

Box

Type your changes in this box. 

This Measurement Function is Saved in the File

The location of the measurement function on your system. 

New Measurement Function Name

Type the new name of the copied measurement function. 

File to Keep Measurement Function in

Click to select the location of the copied measurement function. 

List

The available sections are listed. Click to select. 
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All

Click to select all of the listed sections. 

None

Click to select none of the listed sections. 

 

expression arguments (1, 2, …, n )

These are placeholders for the Probe trace expressions that search commands are applied 
to. The number that identifies the expression argument (e.g., 1) corresponds to the search 
command labeled with the same number below.

When a measurement definition is used in the Add Trace dialog box, expression arguments 
are replaced with regular Probe trace expressions. For example, for the measurement 
definition

GainMargin (1,2) 

You need to specify two trace expressions in the Trace Expression text box, e.g.,

GainMargin (Vp(Out), VdB(Out)).

substitution arguments (subarg1, subarg2, …, subargm)

These are optional arguments that follow the expression arguments. 

In a measurement definition, these arguments are text strings, which can have any 
alphanumeric character or underscore (_) but cannot start with a number. 

For example, in the measurement definition 

bandwidth (1, db_level) = x2 -x1

db_level is the substitution argument. This measurement definition finds the db_level 
bandwidth of a signal. 
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When a measurement definition is used in the Add Trace dialog box, the values of these 
arguments are specified by replacing them with numbers, which are substituted into any of 
the measurement definition's search commands that contain the subargument text. 

Example

bandwidth (VdB(out),3) 

Introducing the Performance Analysis Wizard 

The Performance Analysis wizard helps you complete the information necessary to generate 
a Performance Analysis trace. Just type or select the information as you go.

To start the Performance Analysis wizard, choose Performance Analysis from the Trace 
menu.

While you are in the wizard, a button bar is displayed at the bottom of every screen. 

The following table describes the buttons.

The Performance Analysis wizard has four steps: 

1. Introducing the Performance Analysis wizard 

Contains information about the wizard process 

2. Selecting a measurement

Cancel Cancel the Wizard and return to PSpice. 

Back Go back one Wizard screen. 

Next Go forward one Wizard screen. 

Finish Leave the Wizard and see the Performance Analysis.

Help Click to go to the Wizard help system.
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Helps you select from the available, defined, measurements. 

3. Selecting measurement arguments 

Allows you to specify the arguments for the measurement. 

4. Testing the measurement

Shows you the results of your measurement with the current arguments. You can 
redefine the arguments if the results are not what you expected. 

When you are done with the Performance Analysis wizard, your trace is shown in 
Performance Analysis mode. 

The Performance Analysis wizard creates simple Performance Analysis traces. If you need a 
Performance Analysis trace that is an expression of several measurements, you can add that 
trace manually. 

Selecting a Measurement

The second step of the wizard helps you select a measurement definition. 

To create a Performance Analysis trace, select the measurement definition you want. This 
measurement definition determines the characteristic that is extracted from each PSpice run 
and is plotted versus the variable that changes between simulation runs.

To find more information about each measurement definition listed, click a name in the list on 
the left side of the dialog box. If included in the .PRB file, an explanation about the selected 
measurement definition appears on the right side of the dialog box. 

If the measurement definition you want is not listed, you can edit an existing measurement 
definition or create a new one to meet your needs. 

To edit or create a new measurement definition, click the Measurements button. 

Selecting Measurement Arguments

The third step of the wizard helps you fill in the measurement expression arguments.

Measurement expressions can have 2 types of arguments:

■ Expression arguments 
June 2020 210 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



PSpice Help
Using performance analysis and measurements
Every measurement expression must have at least one expression argument, but can 
have more.

■ Substitution arguments 

A measurement expression can have 0 or more substitution arguments.

To specify the Measurement Expression argument

1. Do one of the following:

❑ Click the toolbar button{bmc BM18.SHG}. To change the listed traces, check or 
uncheck the output types. To select a trace, double-click a name in the Simulation 
Output Variables list. The name is copied to the appropriate argument box in the 
wizard. 

or

❑ In the Name of Trace to Search box, type the name of the trace you want to evaluate. 

2. Depending on the measurement definition selected in the previous step, type the rest of 
the information in the boxes, or click the toolbar buttons to select the information. 

3. When you are done, click Next. 

 

Testing the Measurement

The final step of the wizard views the plotted measurement. If the value of this measurement 
is not correct, or if the marked points are not on the right places on the trace, do one of the 
following:

❑ Return to Step 2 and select or create a more appropriate measurement definition for 
your data

or

❑ Return to Step 3 and change the measurement expression arguments. You might 
have chosen the wrong expression argument or arguments.
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Setting PSpice Application Theme

To set the theme of PSpice:

1. From the Tools menu, select Options.

The Probe Settings dialog box opens.

2. Select the Color Settings tab.

3. Select Dark or Light from the Application Theme drop-down list.

4. Click OK.

Note: The standard Windows operating system dialog boxes do not follow the application 
theme when launched from PSpice.

Setting Probe window options

Use the Probe Settings dialog box to specify how PSpice displays Probe window items such 
as scroll bars, symbols, and trace colors. You can also specify the auto-update interval, 
number of histogram divisions, and how large data files should be loaded onto PSpice.

For more Probe window options, see Probe windows settings for simulation profiles.

To set Probe window options:

1. From the Tools menu, select Options to display the General tab of the Probe Settings 
dialog box. 

2. In the Use Symbols frame, choose one of the following options: 

❑ Attributes 

❑ Never 

❑ Always 

3. In the Trace Color Scheme frame, choose one of the following options: 

❑ Normal 
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❑ Match Axis 

❑ Sequential Per Axis 

❑ Unique By File   

4. In the Use ScrollBars frame, choose one of the following options:

❑ Auto 

❑ Never

❑ Always

5. In the Auto-Update Interval frame, choose one of the following options:

❑ Auto

❑ Every sec

❑ Every %

6. In the Number of Histogram Divisions text box, enter the number of histogram divisions 
used when PSpice displays Performance Analysis of a Monte Carlo run. 

7. In the Number of Cursor Digits text box, enter the number of digits PSpice displays when 
the cursor position is shown.

8. Select any or all of the following options:

❑ Mark Data Points 

❑ Display Evaluation 

❑ Display Statistics 

❑ Highlight Error States 

9. Click OK to close the Probe Settings dialog box. 

Setting large data file options

1. From the Tools menu, select Options to display the Probe Settings dialog box.

2. Select the Large Data tab.

3. Select one of the Options to be used as the default setting for loading a large data file.

a. Select Use fewer data points to display a complete trace, when you want that full 
trace, which may not be accurate, to be loaded and displayed on the Probe window. 
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In this case the trace is not accurate because it is created using a subset of data 
points picked randomly from the data file.

b. Select Use all data points to display trace in parts, when you want the trace to be 
accurate but only a small part of the trace is displayed at one time. In this case, the 
complete trace is divided into multiple parts and each part can be viewed separately.

c. Select Always ask, when you want the Large Data File dialog box to be displayed 
every time a large data file is opened in PSpice. By default, this option is selected.

d. Select Ignore this Warning, when you do not want to be notified whether the data file 
being loaded is a large data file or not. Therefore, the Large Data File dialog box 
never appears. In this case, either the Out of memory error appears, or if the system 
memory is sufficient the data file will be loaded successfully. 

4. In the Data points in one part text box, specify the threshold limit for the number of data 
points in a large data file. By default this value is set to 1 million (1000000).

For example, if you want that any data file that has more than 2 million data points per 
trace should be categorized at a large data file than enter 2000000 in the Data points in 
one part text box.

5. Click OK to save the settings and to close the Probe Setting dialog box.

Selecting a Printer

You can specify a different printer and settings for PSpice to use to print your plots. (If you do 
not change the settings, PSpice uses the default Windows printer settings.)

To select a printer 

1. From the File menu, select Printer Setup.

2. In the Printer frame, select the printer you want to use. Click Properties to change its 
settings.

3. In the Paper frame, select the type of paper you want to use.

4. In the Orientation frame, choose which page orientation you want to use.

5. When you have finished selecting the printer, click OK. 

Using Print Preview

You can use Print Preview to view pages before you print them.
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To use print preview

1. From the File menu, select Print Preview to preview all plots, using the current settings. 
Each plot is displayed as a separate page, unless you have set it differently in Page 
Setup.

2. In the Preview screen, click Print to print the page, or click Close to return to the Probe 
window.

Setting up the Page

You can set up the page in PSpice to establish the way the printed plots appear when you 
print. 

To set up the page

1. From the File menu, select Page Setup. 

2. In the Page Setup dialog box, enter the following options: 

❑ In the Margins frame, type the margin spacing. 

❑ In the Plots Per Page frame, enter the number of plots to be printed on each page, 
from 1 to 9 per page. 

❑ In the Orientation frame, choose Landscape or Portrait. 

❑ Select the Draw Border check box to put a border on the page.

❑ Select the Draw Plot Title box to put the plot title on the page. 

❑ In the Cursor Information area, choose where you want the cursor information to be 
displayed on the page. 

3. To add a header or a footer, click the Header button or the Footer button. 

❑ The Left Side, Center, and Right Side boxes display the header or footer content that 
is left-aligned, centered, and right-aligned, respectively. Type information into the 
appropriate box. You can use codes for certain kinds of information.

❑ Press Ctrl+Enter to start a new line. 

❑ Click OK to exit this dialog box and save the new settings. 

4. Click OK to close the Page Setup dialog box and save the new settings. 
June 2020 216 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



PSpice Help
Setting Options
Printing in PSpice 

To print the current plot

1. On the toolbar, click the Print button to print one copy of the current Probe window, using 
the current settings.

To print specific plots

1. From the File menu, select Print.

2. Set up the following options:

❑ Under Printer, select which printer to use. Click Properties to set the printer’s 
properties. 

❑ In the Copies box, enter how many copies to print.

❑ Click Page Setup to change the page settings.

❑ Under Plots to Print, select which plots to print. Each plot is printed as a separate 
page, unless you have set it differently in Page Setup.

❑ Under Automatic Grid Spacing, choose either Based on Print Area or Same as 
Display.

3. Click OK to print using these settings, or click Cancel to exit this dialog box without 
printing anything.

Setting the Width of Printed Plot Lines 

You can set the width of the printed plot lines by using an ASCII text editor, such as Notepad, 
to edit the PSpice.INI file.

To set the plot line width

1. Using a text editor, open the file PSpice.INI. 

2. In the [Probe] section of the file, add or modify the following entry. The format is:

PRINTERLINEWIDTH = <value>

If the above entry is not present in the .INI file, the default line width is 0.

The line width of a printed plot is scaled automatically, so you do not need to set custom 
values for the PRINTERLINEWIDTH command in the PSpice.INI file. This makes the printout 
more legible for most printer configurations using the default value in the .INI file.
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You can select all the traces in a plot to change their properties collectively. To do this, use 
the Select All command from the Edit menu, then edit the properties as needed. The new 
trace properties will then be reflected on the screen, in Print Preview, and on the printout.

Changing the Screen Colors

You can change the colors PSpice uses to display plots on the screen by using an ASCII text 
editor, like Notepad, to edit the PSpice.INI file.

To edit screen colors:

1. Using a text editor, open the file PSpice.INI. 

2. In the [Probe Display Colors] or the [Probe Pointer Colors] section of the file, add or 
modify a color entry. The format is:

<item name>=<color>

For example, background=red draws the background in red.

Valid item names are:

Valid color names

Specify varying degrees of color by using the R, G, B value of the color. The range is from 
0-255. For example, <attribute>=255 0 0 is the same as <attribute>=red.

3. Set the trace colors using the following form:

trace_x=colorname

background The colors for the window background

foreground The default color for items not explicitly specified

trace 1 through trace 12 Colors the traces with specified color when they 
appear on the Probe window. You can specify up to 12 
colors.

black blue green cyan

red magenta yellow brightwhite

brown lightgray darkgray darkblue

darkgreen darkcyan darkred darkmagenta
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where trace_x is trace_1 through trace_12 and colorname is a valid color name. 

4. If needed, set numtrace colors to N, where N is between 1 and 12. The numbers 1 
through 12 represent the number of trace colors displayed on the screen or printed before 
the color order repeats. 

5. Save the file as ASCII text and close it when you have finished. The settings take effect 
the next time you start PSpice. 

Header and footer codes

These codes can be inserted into any of the boxes as an abbreviated method to include 
certain information.

Customizing toolbars

Toolbar settings can be saved in settings schemes.

To change the display of toolbars 

To add menu option or button as a new menu or in the toolbar

To remove buttons from toolbars

To reset toolbars to their default settings

This code … Does this… 

&D specifies the current date in the header and/or footer

&T specifies the current time in the header and/or footer

&N specifies where page numbering appears in print job

&A prints simulation date from current data file

&M prints simulation time from current data file

&I prints simulation title from current data file

&E prints simulation temperature from data file

&P prints specified parameter or other value changing between 
data file sections
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To change the display of toolbars

1. From the Tools menu, choose Customize.

2. Click the Toolbars tab.

3. In the Toolbars list, select the toolbars to be displayed.

The selected toolbar appears. 

4. Click Close to close the dialog box.

To add menu option or button as a new menu or in the toolbar

1. From the Tools menu, choose Customize.

2. Click the Commands tab.

3. In the Categories list, click a category to display related toolbar buttons or menu options 
in the Commands frame.

4. To add the selected button or option to a toolbar or menu bar, drag it from the Customize 
dialog box to any toolbar or menu bar displayed in the program window.

5. Click Close to close the dialog box. 

To remove buttons from toolbars

➡ Drag the button you do not want from the toolbar to the Customize dialog box. 

To reset toolbars to their default settings

1. From the Tools menu, choose Customize.

2. Click the Toolbars tab.

3. Do one of the following:

❑ Click Reset All.

❑ Click Reset.

4. Click Close to close the dialog box.
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Customizing Commands

To customize commands:

1. Choose Tools – Customize.

2. In the Commands tab, select a menu name from the Categories list.

The buttons for the selected menu are displayed in the Commands frame.

3. Drag a button or menu option and place it in the toolbar.

Generating a Report

Using the Generate Report option, you can generate an HTML report based on transient 
analysis data. The HTML report displays the transient analysis data in the following template:

1. General Information

a. Simulation Data (.dat) File

b. Analysis Name

c. Circuit Name

d. Simulation Time

e. PSpice Version

2. Circuit Information

a. List of Nets

b. List of Devices

3. Simulation Data

a. Current Data

b. Voltage Data

c. Power Data

The template above can be customized by modifying the TCL (orPspReport.tcl) file located 
at the following path: <Installation Directory>\tools\pspice\tclscripts.

Note: As you generate the report, remember the following points:

■ The maximum size limit of the HTML file is 800 MB.
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■ To generate report, the simulation data file must have transient analysis data of analog 
devices.
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Using files

Opening and closing files in PSpice is similar to using files in other Windows programs. 

If you open a section that is currently being created by the simulation, added traces are 
automatically updated. 

Double-click the symbol next to a trace name in the plot window legend to view information 
about the trace, including which file its data originated from.

To open a file

1. On the toolbar, click the Open File button.

2. Select the name of the file from the list. To use a file from a different directory or drive, 
select it from the list. 

3. Click OK. 

4. If the file has multiple sections with different analysis types, the Analysis Type dialog box 
appears. 

❑ Click the appropriate Analysis type. Select from AC sweep, DC sweep, or Transient. 

5. If the file has multiple sections of data of the selected analysis type, the Available 
Sections dialog box appears. Do one of the following:

❑ Click the appropriate sections. 

❑ To use all the listed sections, click All. 

6. Click OK. 

7. If any simulation-generated errors are found, a message appears. Click OK to view the 
error messages, or click Cancel to ignore the errors. 

To close a file 

1. From the File menu, select Close. 
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All data files used by the currently selected plot window are closed. Any other plot 
windows that use these files are also closed. 

PSpice default keyboard shortcuts

PSpice has a set of keyboard shortcuts for frequently used commands.

Ctrl+X cut the selected item

Ctrl+C copy the selected item

Ctrl+V paste the cut or copied item

Delete delete the selected item

Ctrl+Y add a y-axis

Shift+Ctrl+Y delete a y-axis

Insert add traces

Ctrl+Delete delete all traces in the selected plot

Ctrl+U restore the last deleted traces

Shift+Ctrl+C turn the data cursor on or off

Shift+Ctrl+F freeze the cursor

Shift+Ctrl+S search

Shift+Ctrl+X move to the next maximum value

Shift+Ctrl+M move to the next minimum value

Shift+Ctrl+R move to the previous transition

Shift+Ctrl+N move to the next transition

Shift+Ctrl+P move to the next peak

Shift+Ctrl+T move to the next trough

Shift+Ctrl+L move to the next slope

Shift+Ctrl+I move to the next point

Ctrl+A zoom into the selected area

Ctrl+I zoom in around a specified point

Ctrl+L redraw the screen

Ctrl+O open a file
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Customizing keyboard shortcuts <link>

Invalid node names

Certain characters are not valid for use in net names or node names because they are either 
reserved for special use or are not recognized, by PSpice. A list of invalid characters, which 
should not be used when naming wires, is given below.

Ctrl+N create a new text file

F12 restore the last Probe window session

Ctrl+P display the Print dialog box

F1 view Help

Alt+F4 exit PSpice 

@ 'at' symbol

% percent sign

& ampersand

* asterisk

+ plus sign (only as initial character)

<space> Space

? Question mark

~ Tilde

# Hash

^ Power of

"Double quotes

\\ Back slashes

! Exclamation mark

( Opening braces

) Closing braces

'Single quotes
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Besides the characters listed above, you should not use the reserved word CN,- for naming 
parts or nets. CN is a reserved word used for canonical names.

Limits in PSpice and Probe 

The following limits apply to PSpice and Probe: 

< Lesser than

> Greater than

= Equals

[ Opening square braces

] Closing square braces

Feature Maximum limit

analog display in 
Probe

400 traces, or 2 times the number of sections, whichever is 
greater

digital display in 
Probe

400 traces, or 2 times the number of sections, whichever is 
greater

number of analog 
nodes that can be 
stored in a.DAT 
file

2**31 (~2,147K)

number of digital 
nodes that can be 
stored in a.DAT 
file

2**15 (~32K)

Monte Carlo 
analysis

10,000 runs
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Using .PRB files

.PRB files are ASCII text files where displays, measurement functions, and macros are 
stored. Each of these are listed in a section in the .PRB file. The section begins with a section 
header:

[Displays]

[Measurement Function]

[Macros]

The sections can be in any order or not appear at all. 

Comment lines begin with an asterisk *. Blank lines are ignored.

Tip

PSpice.PRB is shipped with your OrCAD applications. This file contains examples 
of measurement functions and can be used as templates for your own measurement 
function definitions.

Loading .PRB files

Certain .PRB files are automatically loaded by PSpice:

■ The global .PRB file is loaded when a data file is opened. The global .PRB file is specified 
in the [PROBE] section of the pspice.ini file by the line:

PRBFILE=filename

■ The local .PRB file is loaded after the global .PRB file. The local .PRB file has the same 
name as the data file that is being opened. For example, if the data file is named 
PROJECT.DAT, the local file is named PROJECT.PRB.

You can load a specific .PRB file after the global and local files are loaded by using the 
command line option -p. For example:
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PSpice .EXE -P MYFILE.PRB

You can also use .PRB files by clicking the Load button in the Display Control, Measurement 
Functions, or Macro dialog boxes. Only the section is loaded from the .PRB file. For example, 
if you click Load in the Measurement Function dialog box, only the measurement functions in 
the specified .PRB file are loaded. 

Caution

When you load a .PRB file that contains any displays, measurement 
functions, or macros with the same names as ones already loaded, the 
new ones replace the previous ones.

PRB file

A .PRB file is an ASCII file which contains three sections: one for measurement functions, 
one for macros, and one for display definitions. Each section begins with a header (e.g., 
[MEASUREMENT FUNCTIONS]). 

Measurement functions are stored in a .PRB file. A single .PRB file can contain many 
measurement function definitions.

Text in a .PRB file

A .PRB file can contain any number of measurement function, macro, and display definitions.

Text in a .PRB file uses the following format: 

■ Section headers are in brackets—for example, [MACROS]. 

■ Comment lines begin with an asterisk *. 

■ Blank lines are ignored, so you can add blank lines to improve the readability of the file. 

■ Lines of text can wrap to the next line. The maximum text line is 255 characters. 

Moving data to other applications

You can copy trace data to other applications in two ways: as data or as a bitmap. 

Copying bitmaps to another application

Copying data to another application 
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Copying trace data to another application

You can copy and save trace data to other applications. 

To copy trace data to another application

1. Click the trace name in the plot legend to select the trace. (The name turns red when 
selected.)

2. From the Edit menu, choose Copy. 

3. Open a file in another application, such as Microsoft Excel, Microsoft Word, or Notepad. 

4. From the Edit menu of the other application, choose Paste to paste the data in the file as 
numbers and text. 

5. Save the file.

Logging commands

You can use command logging to create a file of commands that you can use at a later date. 
This file is played back to repeat a series of commands. 

To create a command file 

1. From the File menu, choose Log Commands. 

2. Type the name of a new file or select an existing file. If you use an existing file, it is over-
written with the new command file. 

3. Click OK. 

All functional actions you make on the screen are logged to the specified file. The 
resulting file contains actions like opening files, setting axes, and adding traces. 

4. To stop logging commands, from the File menu, choose Log Commands again. 

Caution

Cursor movements are not recorded during command logging.

To run a command file

1. From the File menu, choose Run Commands. 

2. Select the file from the list. If the file is in a different directory or drive, select the correct 
file or directory from the lists. 
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3. Click OK. to play the file immediately on your screen.

Creating and changing macros

Macros can contain constraints, functions, and/or expressions of any or all of these. Macros 
are used when specifying a trace to add. Macros can refer to other macros, but recursive 
definitions are not allowed.

You can define, load, save, and delete macro definitions. Macros are stored in a .PRB file. 

For more information, see the following topics:

❑ To create a new macro

❑ To modify an existing macro

❑ To load a macro

❑ To delete a macro

❑ To delete a macro from another file

❑ Macro syntax and examples

To add a macro

In the Add Trace dialog box:

1. From the Functions or Macros list, select Macro.

2. From the corresponding list, select the name of the macro.

3. Fill in the arguments list, using the macro syntax format:

a. In the Node Names list, click the name of a digital node.

b. Repeat step a for all arguments needed for the macro call.

To create a new macro 

1. From the Trace menu, choose Macros. 

2. In the Definition text box, type a unique name and a definition for the macro, observing 
the macro rules. 

3. Click the Save button to save the macro.
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Caution

If the macro name already exists, clicking the Save button overwrites the 
existing macro of the same name.

To modify an existing macro

1. From the Trace menu, choose Macros. 

2. From the list, select a macro. 

3. In the Definition text box, edit the macro definition, observing the macro rules.

4. To save the modified macro, do one of the following:

❑ To save with the same name, click the Save button. 

❑ To save to a specified PRB file, click the Save To button. 

To load a macro

1. From the Trace menu, choose Macros. 

2. Click the Load button.

3. Select the file you want to load and click Open.

To delete a macro

1. From the Trace menu, choose Macros. 

2. Select a macro from the list. 

3. Do one of the following: 

❑ Click the Delete button. The macro is immediately removed from the list. 

❑ If the selected macro is being used by a current trace, you are warned that it is in 
use. To delete the macro anyway, click OK

Caution

If you delete a macro that is being used by a trace, the trace is deleted too.
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To delete a macro from another file

1. From the Trace menu, choose Macros. 

2. Click the Delete From button.

3. Select the remote or global .PRB file that has the macro you want to delete. 

4. Click Open to delete the macro. 

Caution

If you delete a macro that is being used by a trace, the trace is deleted too.

Macro syntax and examples

A macro can have a maximum of 80 characters, including macro name and arguments. 
Macros can refer to other macros, but recursive definitions are not allowed. Arguments are 
enclosed in parentheses ( ) without spaces. A line beginning with an asterisk * is a comment 
line. In-line comments are marked with a semicolon after the macro definition. Blank lines are 
ignored. 

The macro format is:

<macro name>[(arg[,arg]*)] = <definition>

Examples

❑ ADD(A,B) = A+B

❑ 10X(A) = 10*A; here is an in-line comment

❑ 100X(A) = 10*10X(A)

❑ PI = 3.14159

CSDF

When you (?) the Save Data in the CSDF Format option in the data collection options for 
simulation profiles, the simulation results are generated in generic ASCII text so that any 
computer link can handle the file transfer and so that any computer platform can process the 
data. The default file name extension for CSDF files is .CSD.
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Binary

Binary files are compact and provide the quickest access to the waveform data. 

However, binary files can present problems if you want to manipulate the data, or when you 
want to transfer the data file to a different type of computer. There are several problems that 
you can encounter. Examples include:

■ Binary formats for real numbers differ between platforms

■ Link between computers cannot handle binary data adequately

■ Binary data format is difficult to access or process

Specifying default command line options

To start PSpice with a set of customized options that will be used each time a simulation is 
run, you can modify the initialization file (pspice.INI).

1. Open the file pspice.ini (located in the Windows directory) in any ASCII text editor, such 
as Notepad.

2. Under the heading [PSpice ] add the following command line with the desired switches:

PSPICECMDLINE=<option1> <option2>

3. Save the file.

For more detailed information on defining simulation command line options in PSpice and a 
listing of the valid options, see the PSpice Reference Guide.

Configuring the pspice.INI file

The pspice.ini file is an ASCII text file that contains the initialization settings for PSpice and 
other applications that run with PSpice. It controls how PSpice application programs are 
started, and how their environment and initialization settings are defined. The pspice.ini file 
is created when you perform the installation process.

Under normal installations to your local hard drive, the pspice.ini file is located in the directory 
where the PSpice executable (pspice.exe) is installed (typically, in 
<installation>\tools\pspice). The file is divided into sections with title names enclosed in 
brackets.

Each section contains settings which follow the format:
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<keyword>=<value>

where the <keyword> is the name of the setting and <value> defines the value of that setting.

For example, the first section is [PSPICE]. The setting:

LIBPATH=”C:\Cadence\SPB_17.4\tools\pspice\library”

indicates that the LIBPATH setting will point to the directory 
C:\Cadence\SPB_17.4\tools\pspice\library, where the PSpice model libraries are typically 
installed.

Changing the settings

When the pspice.ini file is created (during installation), the installation assigns default values 
to the settings. Most of the settings can be changed through dialog boxes within PSpice or 
Probe. However, some settings may only be modified with a text editor.

Note: If you use a text editor to modify the settings in pspice.ini, be sure to close any PSpice 
applications that may be running. The changes you make to pspice.ini should be saved to the 
file. They will take effect the next time you start the programs.

You can change the default settings using any standard text editor, such as Notepad.

To change items that are configurable through the text editor, you should note that:

■ The <keyword> is followed by an equals sign (=) with no spaces in-between.

■ The <value> can be an integer, a string, or a quoted string, depending on the setting; 
start typing the <value> immediately after the equals sign.

■ For settings that turn a feature on or off, the <value> should be either ON or OFF.

■ You can include comments within the file, but you must begin each comment line with a 
semicolon (;).

Section descriptions

The pspice.ini file consists of several sections that define the configuration settings for the 
various PSpice applications. The descriptions listed below provide information on the 
elements within each of these sections in pspice.ini. The descriptions provide details on the 
permissible <keyword> and <value> settings. 

Note: Several of the configuration settings described here will not appear in pspice.ini unless 
the default values have been changed.
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For specific information about a particular section, click the buttons next to the section titles 
listed below. (The sections are listed here in alphabetical order for easy reference. They are 
typically arranged in a different order in the actual pspice.ini file.)

PART LIBS section

PART LIBS section

PART LIBS section

PART LIBS section

PROBE section

PROBE DISPLAY COLORS section

PROBE PRINTER COLORS section

PSPICE section

PSpice NETLIST section

SUBCKT SETTING section

PART LIBS section

The [PART LIBS] section lists the part libraries that are configured for use in PSpice 
Schematic to Capture translation. The individual entries in the listing can be edited in the 
form:

LIB1=<library name> [extension]

where <library name> is the name of the library file (ANALOG) and [extension] is the 
extension for the library file. You may list multiple extensions. 

PROBE section

The [PROBE] section defines the configuration settings used by Probe. The following table 
describes the different settings. The settings are listed here in alphabetical order for easy 
reference, but they may appear in any order in the pspice.ini file.

Keyword Description
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AUTOUPDATEINTERVAL Controls the update interval for Probe waveforms. Valid settings 
are Auto, Seconds, or Percent. The default setting is AUTO.

AUTOUPDATEPERCENT Specifies the auto update interval for Probe waveforms in 
percent, if AUTOUPDATEINTERVAL is set to Percent. The 
default is 10.

AUTOUPDATESECONDS Specifies the auto update interval for Probe waveforms in 
seconds, if AUTOUPDATEINTERVAL is set to Seconds. The 
default is 10.

CURSORBOTTOM Specifies the bottom position of the cursor box. The default is 0.

CURSORNDIGITS Specifies the number of digits to be displayed for the cursor 
position. The default is 5.

CURSORRIGHT Specifies the right position of the cursor box. The default is 0.

DGTLNAMELEFTJUSTIFY Controls whether digital names are left or right justified. Valid 
settings are On or Off. The default is OFF, meaning right 
justified.

DISPLAYEVALON Turns on the display of traces and marked points used by 
Display Evaluation in the currently selected plot, on the 
currently selected Y axis. Valid settings are On or Off. The 
default is OFF.

ERRORMSGDLGLEFT Specifies the left position of the Error Message box. The default 
is -1.

ERRORMSGDLGTOP Specifies the top position of the Error Message box. The default 
is -1.

HISTNDIVISIONS Specifies the number of divisions for histograms. The default is 
10 divisions.

HISTSHOWSTATSON Specifies that the histogram statistics will be displayed in the 
Probe window. Valid settings are On or Off. The default is ON.

MARKDATAPOINTS Specifies whether data points will be marked on Probe traces. 
Valid settings are On or Off. The default setting is OFF.

PRBFILE Specifies the name of a global .PRB file which contains Probe 
macro, display, measurement function, and plot template 
definitions. The syntax for a typical installation is:

PRBFILE=<installation_directory>\tools\PSpic
e\Common\pspice.prb
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PROBE DISPLAY COLORS section

The [PROBE DISPLAY COLORS] section defines the color settings used by Probe. The 
following table describes the different settings. The settings are listed here in alphabetical 
order for easy reference, but they may appear in any order in the pspice.ini file.

To change the settings in the [PROBE DISPLAY COLORS] section, use the format:

<item name>=<color>

where <item name> specifies the Probe item and <color> specifies the color.

For example, the entry FOREGROUND=DARKGREEN results in graph axes being drawn in 
dark green, Or, BACKGROUND=CYAN results in the screen background changing to the 
color cyan instead of the default color black.

Alternatively, you may specify varying degrees of color by using the RGB (red, green, blue) 
value of the color you desire. For example, TRACE_2=255 0 0 is the same as 
TRACE_2=RED.

The available colors are: black, blue, brown, brightwhite, cyan, darkblue, darkcyan, darkgray, 
darkgreen, darkmagenta, darkred, green lightgray, magenta, red, and yellow.

In some cases you may want to limit the number of colors used for drawing. For a super VGA 
display, the default maximum number of colors (NUMTRACECOLORS) is twelve.

PRINTERLINEWIDTH Specifies the width of lines drawn during printing (in pixels). The 
default is 1.

SCROLLBARS Controls display of scroll bars. Valid settings are Always, Never, 
or Auto. The default setting is AUTO.

PRINTSAMEASDISPLAY Controls whether the Probe printout matches the display. Valid 
settings are 0 (Off) or 1 (On). The default setting is 0.

TRACECOLORSCHEME Specifies the trace coloring scheme. Valid settings are Normal, 
Match, or Sequential. The default setting is NORMAL.

TRACESYMBOLS Specifies how trace symbols will appear on traces in the Probe 
plot window. Valid settings are Always, Never, or Auto. The 
default setting is AUTO.

TRACEWIDTH Specifies the trace width in the probe. The default is 1.

Keyword Description
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BACKGROUND Specifies the background color. The default setting is BLACK.

FOREGROUND Specifies the foreground color. The default setting is WHITE.

NUMTRACECOLORS Specifies the maximum number of trace colors. The default 
setting is 0 (one color). For color printers, set this to 12. After 
reaching the maximum number, Probe begins displaying the 
next trace color by repeating the first trace color, then the 
second, etc.

TRACE_1 Specifies the color of the first trace. The default setting is 
BRIGHTGREEN.

TRACE_2 Specifies the color of the second trace. The default setting is 
BRIGHTRED.

TRACE_3 Specifies the color of the third trace. The default setting is 
BRIGHTBLUE.

TRACE_4 Specifies the color of the fourth trace. The default setting is 
BRIGHTYELLOW.

TRACE_5 Specifies the color of the fifth trace. The default setting is 
BRIGHTMAGENTA.

TRACE_6 Specifies the color of the sixth trace. The default setting is 
BRIGHTCYAN.

TRACE_7 Specifies the color of the seventh trace. The default setting is 
MUSTARD.

TRACE_8 Specifies the color of the eighth trace. The default setting is 
PINK.

TRACE_9 Specifies the color of the ninth trace. The default setting is 
LIGHTGREEN.

TRACE_10 Specifies the color of the tenth trace. The default setting is 
DARKPINK.

TRACE_11 Specifies the color of the eleventh trace. The default setting is 
LIGHTBLUE.

TRACE_12 Specifies the color of the twelfth trace. The default setting is 
PURPLE.
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PROBE PRINTER COLORS section

The [PROBE PRINTER COLORS] section defines the color settings used for printing from 
Probe. The following table describes the different settings. The settings are listed here in 
alphabetical order for easy reference, but they may appear in any order in the pspice.ini file.

To change the settings in the [PROBE PRINTER COLORS] section, use the format:

<item name>=<color>

where <item name> specifies the Probe item and <color> specifies the color.

For example, the entry FOREGROUND=DARKGREEN results in graph axes being printed in 
dark green. The default maximum number of colors is twelve. 

The available colors are: black, blue, brown, brightwhite, cyan, darkblue, darkcyan, darkgray, 
darkgreen, darkmagenta, darkred, green lightgray, magenta, red, and yellow.

If you are using a four pen plotter, you will get the best results if you set the maximum number 
of colors to three. The first three trace colors will be used for the colors of digital traces.

Keyword Description

BACKGROUND Specifies the background color. The default setting is 
BRIGHTWHITE.

FOREGROUND Specifies the foreground color. The default setting is BLACK.

NUMTRACECOLORS Specifies the maximum number of trace colors. The default 
setting is 12. After reaching the maximum number, Probe 
begins printing the next trace color by repeating the first trace 
color, then the second, etc.

TRACE_1 Specifies the color of the first trace. The default setting is 
GREEN.

TRACE_2 Specifies the color of the second trace. The default setting is 
RED.

TRACE_3 Specifies the color of the third trace. The default setting is 
BLUE.

TRACE_4 Specifies the color of the fourth trace. The default setting is 
YELLOW.

TRACE_5 Specifies the color of the fifth trace. The default setting is 
MAGENTA.
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PSPICE section

The [PSPICE] section contains settings that are specific to PSpice. The following table 
describes the different settings. The settings are listed here in alphabetical order for easy 
reference, but they may appear in any order in the PSPICE.INI file.

Command line options for the PSpice applications are explained in much more detail in the 
PSpice Reference Guide.

TRACE_6 Specifies the color of the sixth trace. The default setting is 
CYAN.

TRACE_7 Specifies the color of the seventh trace. The default setting is 
MUSTARD.

TRACE_8 Specifies the color of the eighth trace. The default setting is 
PINK.

TRACE_9 Specifies the color of the ninth trace. The default setting is 
LIGHTGREEN.

TRACE_10 Specifies the color of the tenth trace. The default setting is 
DARKPINK.

TRACE_11 Specifies the color of the eleventh trace. The default setting is 
LIGHTBLUE.

TRACE_12 Specifies the color of the twelfth trace. The default setting is 
PURPLE.

Keyword  Description

BACKUP Specifies the directory in which backup copies are placed. The 
default is set at installation. This line can be edited in the form:

BACKUP=<directory> 

where <directory> specifies the directory where backups will be 
written. If you are installing a network version, this directory 
cannot be write-protected and should be set to a local directory, 
not a network directory.
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LIBPATH

This variable is originally set during installation to the directory:

LIBPATH=C:\Program Files\Orcad\Capture\ Library\PSpice 

If you install the PSpice applications into another directory, then a corresponding subdirectory 
will be created under your named directory.

For example, if you specify C:\Mydir as the directory where PSpice should be installed, then 
your LIBPATH variable will be set to:

LIBPATH Specifies the directories where the model, part, and package 
libraries are located. The default is set at installation. This line 
can be edited in the form: 

LIBPATH=<directory> 

where <directory> specifies the directory where the library files 
are located. (For more information, see the section on LIBPATH 
below.)

MATHEXCEPTIONS Allows reporting of math exception errors. (The keyword is not 
included in the netlist.) Valid settings are Off or On. The default 
setting is ON.

OPTIMIZERCMD Specifies the command used to run PSpice Optimizer. This line 
can be edited in the form: 

OPTIMIZERCMD=<optimize r> [options] 

where <optimizer> indicates the executable for starting 
Optimizer and [options] can be any of the available Optimizer 
switches.

PSPICECMDLINE Specifies what command line options should be used when 
starting up PSpice. This line can be edited in the form: 

PSPCIECMDLINE= -<switch> <filename> 

where -<switch> indicates the and <filename> is the name of 
the corresponding file to be opened. Valid switches are: -i = 
custom .INI file -p = measurement function file

SET_OPTION_FLAG Forces the use of SPICE2 time steps when simulating 
transmission lines. This is not included in the default settings. 
This line can be inserted in the form: 

SET_OPTION_FLAG= OLDTLINETSTEP
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LIBPATH=C:\Mydir\Orcad\Capture\Library\ PSpice 

You can specify more than one directory for LIBPATH by separating the paths with a 
semicolon (;). When a library file is referenced, PSpice will search for the file in the directories 
in the order specified by this variable. You can change the LIBPATH variable by editing this 
line in the form:

LIBPATH=<directory>;<directory>;...;<directory>

For example, if you want PSpice to search for model library files in more than one place, you 
could set the variable to:

LIBPATH=C:\Program Files\Orcad\Capture\ Library\PSpice ; D:\ProjectA\Library

In this case, PSpice will look first for a library file in C:\Program 
Files\Orcad\Capture\Library\PSpice. If it finds the specified library file here, it will 
stop searching. Otherwise, PSpice will then search for the specified library file in 
D:\ProjectA\Library.

PSpice NETLIST section

The [PSpice NETLIST ] section contains settings that specify which model library files should 
be processed when generating a PSpice simulation netlist. 

The typical setting created during installation will appear in the form:

LINE1=.lib “nom.lib”

You can specify more than one library file to include in the netlist generation process. The 
library files you specify will be searched in the order in which they are listed.

For example, if you have three different sets of model libraries that should be searched and 
processed during netlist generation, list them as follows:

LINE1=.lib “nom.lib”

LINE2=.lib “projectA.lib”

LINE3=.lib “projectB.lib”

Note: For more specific information on how to set up Library and Include files for processing 
simulation netlists, see the help and user guide for the particular front-end tool you are using.
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SUBCKT SETTING section

The [SUBCKT SETTING] section defines how various parameters in subcircuits are 
processed when a hierarchical netlist is generated. The following table describes the different 
settings. The settings are listed here in alphabetical order for easy reference, but they may 
appear in any order in the pspice.ini file.

Caution

This section must be added in order to disable the automatic assignment 
of the global pin name prefix “$G_” to hidden pin names when 
hierarchical netlists are generated.

Keyword Description

CREATESUBCKTFORMULT
DEVICE

Controls whether subcircuits are created for multiple devices 
template when a hierarchical netlist is generated. Valid settings 
are Yes or No. The default setting is YES.

LOCALIZEHIDDENPIN Controls whether hidden pin names for subcircuits are localized 
when a hierarchical netlist is generated. Valid settings are Yes 
or No. The default setting is NO.

SORTPIN Controls whether pin names for subcircuits are sorted when a 
hierarchical netlist is generated. Valid settings are Yes or No. 
The default setting is YES.
June 2020 243 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



PSpice Help
Files and Commands
Calculating Hysteresis Core Loss 

The Hysteresis Core Loss application calculates the area of the B-H curve, which is the 
integrated average of B-H loops, on the basis of the specified time range, that is, the start time 
and end time. 

If the specified time range covers more than 50 B-H loops, the area of the B-H curve is 
calculated using the first 50 B-H loops. If the specified time range covers less than 50 B-H 
loops, the area of the B-H curve is calculated using the number of the loops covered within 
the specified time range.

The following figures illustrate an example where the circuit is in the transient state.

Figure 12-1  Transient State of the circuit
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Note that in Figure 12-1 on page 244, the time range for the B-H loops is from 0 to 4 seconds 
and the B-H loops, as shown in Figure 12-2 on page 245, do not overlap as the B-H values 
are different for each loop.

Figure 12-2  B-H Curve of the Circuit’s Transient State
The following figures illustrate an example of the steady-state behavior of the circuit in the 
specified time range of 4 to 10 seconds. 
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Note that the B-H loops, as shown in the Figure 12-4 on page 247, overlap as the circuit is in 
its steady state. The core loss of the circuit’s steady state is calculated if the specified time 
range is from 4 to 10 seconds.
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Figure 12-3  Steady State of the circuit

Figure 12-4  B-H Curve of the circuit’s steady state

Note: For accurate core loss calculation, specify a value for the maximum step size that 
generates optimal number of data points.
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The main PSpice menu bar is shown below. For a detailed description of a particular menu, 
click the name of that menu.

Note: Before you open a simulation file, the Edit, Trace and Plot menus are not visible. After 
a simulation file is opened, all of the menus are accessible.

The File menu

The File menu provides typical file management functions.

Menu command… Function…

New 

..Simulation 

..Profile Text File
Creates a new simulation profile. 

Creates a new text file.

Open Opens an existing file.

Close Closes the current file.

Open Simulation Opens an existing simulation file.

Close Simulation Closes the current simulation file.

Save Saves the current file.

Save As This menu is available only if a .DAT file is loaded. Saves the 
current file under a new name.

Export

Probe Data (.dat 
file)

Exports the selected data into a new data file.

Stimulus library 
(.stl file)

Exports the selected data into a new stimulus library file.

Text (.txt file) Exports the selected data into a new text file.
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The Edit menu

The Edit menu provides standard text editing and navigation functions for use when editing a 
simulation text file. Most of the commands in the Edit menu are grayed out and unavailable 
unless you are currently working in a text file.

Note: The Undo and Redo commands only apply to actions performed within the text editor. 
These do not affect any actions performed within Probe or PSpice.

 Import Imports traces stored in .txt or .csv format in PSpice. 

Page Setup Provides page setup options.

Printer Setup Provides printer setup options.

Print Preview Previews the current print setup.

Print Prints the current file.

Log Commands Records the command sequence in a log file (.CMD).

Run Commands Runs the commands in a previously saved log file (.CMD).

Recent Simulations Lists the most recently used simulation files (.SIM).

Recent Files Lists the most recently used data files (.DAT).

Change Product Changes the product license, if available.

Exit Exits PSpice.

Menu command… Function…

Undo Returns the current file to the state it was in prior to the last 
executed command (“undoes” the last command).

Redo Reinstates the state of the file before the last undo command 
(“undoes” the undo command).

Cut Copies the selected area to the clipboard and removes it from 
the text file.

Copy Copies the selected area to the clipboard.

Paste Pastes the contents of the clipboard to the cursor location.

Delete Deletes the selected objects.

Select All Selects all objects in the text file.
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The View menu

The View menu provides controls for defining what portion of a Probe window is displayed, 
for moving around the window, and for defining what toolbars are displayed.

Find Provides a means of searching for a particular string of text. 
See Find dialog box for more information.

Find Next Finds the next instance of the defined search string.

Replace Provides a means of searching for and replacing a particular 
string of text with a new string.

Goto Line Jumps to the specified line number.

Insert File Inserts an existing file into the current file.

Toggle Line Number 
Display

Toggles on or off line number display in .cir and .out files.

Toggle Bookmark Toggles on or off a bookmark at the selected location.

Next Bookmark Jumps to the next bookmark.

Previous Bookmark Jumps back to the previous bookmark.

Clear Bookmarks Clears all of the defined bookmarks.

Modify Object Provides options for modifying objects.

Menu command… Function…

Zoom 

Fit 

In 

Out 

Area 

Previous 

Redraw 

Pan - New Center

Provides the following zoom functions: 

fits the entire plot in the current window 

magnifies the view at the selected point 

expands the view at the selected point 

magnifies the view to the selected area 

restores the previous view 

refreshes the display 

pans to the selected center point; maintains the view

Measurement Results Displays the measurement results for the current simulation.

Circuit File Displays the circuit file for the current simulation.
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The Simulation menu

The Simulation menu provides controls for starting, stopping, and changing a simulation.

Output File Displays the output file for the current simulation.

Simulation Results Displays the results of the current simulation.

Simulation Messages Displays the messages for the current simulation.

Simulation Queue Provides a listing of the current simulations in the queue.

Output Window Toggle for turning on or off the Output Window.

Cursor Window Toggle for turning on or off the Cursor Window.

Simulation Status 
Window

Toggle for turning on or off the Status Window.

PSpice_toolbars Toggle for turning on or off the toolbars.

Command Window Toggle for turning on or off the Command Window.

Status Bar Toggle for turning on or off the Status toolbar.

Workbook Mode Toggle for turning on or off the Workbook Mode.

Alternate Display Displays only the Probe window with the plotted waveforms. 
Additional simulation data provided by PSpice is not displayed. 
See Toggling between display modes.

Large Data File 
Mode 

Toggle for switching between two mode for displaying large data 
files

Display fewer 
points

Displays the complete trace constructed using fewer data points 
from the large data file. 

Though the full trace is displayed, it is not very accurate.

Display in parts Displays a part of the trace at a time. The complete trace 
described by the large data file is divided into multiple parts. At 
given point of time, only one part is loaded for viewing.

Load Next Part Loads and displays the next part of the trace. Enabled only 
when the Display in parts mode is selected for loading and 
viewing the large data file.

Menu command… Function…
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The Trace menu

The Trace menu provides controls for displaying traces and cursors, and for setting up 
specialized analyses such as Fourier, performance analysis and measurement expressions.

Run <current 
simulation>

Runs the current (named) simulation.

Pause Momentarily interrupts the current simulation.

Save Saves the current simulation.

Stop Halts the current simulation.

Edit Profile Provides access to the simulation profile for editing the 
simulation setup.

Edit Runtime 
Settings

Provides access to runtime simulation settings.

Menu command... Function…

Add Trace Adds a trace to the display.

Delete All Traces Deletes all the traces from the display.

Undelete Traces Restores deleted traces. 

Fourier Toggles on or off the display of the Fourier transform of analog 
traces.

Performance 
Analysis

Toggles on or off performance analysis.
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The Plot menu

The Plot menu provides standard text editing functions for use when editing a simulation text 
file.

Cursor 

Display 

Freeze 

Peak 

Trough 

Slope 

Min 

Max 

Point 

Search Commands 

Next Transition 

Previous Transition

Provides the following cursor controls: 

toggles on or off the cursors 

locks the cursor at its current position 

jumps the cursor to the next peak on the plot 

jumps the cursor to the next trough on the plot 

jumps the cursor to the next slope on the plot 

jumps the cursor to the next minimum value 

jumps the cursor to the next maximum value 

jumps the cursor to the next data point on the plot 

jumps the cursor to a specified point 

jumps the cursor to the next digital transition point 

jumps the cursor back to the previous digital transition

Macros Provides a way to define macros in PSpice. 

Measurements... Provides options for setting up measurement expressions.

Evaluate 
Measurements...

Provides options for evaluating measurement expressions.

Menu command… Function…

Axis Settings Provides options for defining the X and Y axes.

Add Y Axis Adds a new Y axis.

Delete Y Axis Deletes the second Y axis.

Add Plot to Window Adds a new plot to the Probe window.

Delete Plot Deletes the currently selected plot.

Unsynchronize X 
Axis

Unsynchronizes the X axis.
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The Tools menu

The Tools menu provides ways to customize the work environment for PSpice.

Digital Size

Label 

Text 

Line 

Poly-line 

Arrow 

Box 

Circle 

Ellipse 

Mark

Provides the following drawing functions: 

inserts text 

draws a line segment 

draws a multi-segment poly-line 

inserts an arrow 

draws a rectangular box 

draws a circle 

draws an ellipse 

inserts a mark

AC If checked, identifies the current simulation as an AC analysis.

DC If checked, identifies the current simulation as a DC analysis.

Transient If checked, identifies the current simulation as a Transient 
analysis.

Menu command… Function…

Customize Provides customization options for the PSpice environment.

Options Provides different options for Probe settings.

General tab Provides general option settings for default values.

Large Dat tab Provides options settings for opening a large data file in PSpice.

Cursors Settings 
tab

Provides options for cursor settings

Color Settings tab Provides different options for color settings

Font Settings tab Provides different options for font settings

FRA Provides option to enable Frequency Response Analysis.
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The Window menu

The Window menu provides typical controls for how different Probe windows are displayed.

Generate Report Provide option to generate report based on transient analysis 
data

PSpice Calculator

..Hysteresis Core 
Loss

provides option to calculate hysteresis core loss

Matlab

..Set Matlab Path

..Start Engine

..Export All Traces

..Export Selected 
Traces

..Co-Simulation

provides option the following MATLAB options:

- Sets the MATLAB path

- Starts the MATLAB Engine

- Exports all traces in MATLAB

- Exports the selected traces in MATLAB

- Launches MATLAB for PSpice Simulink Co-Simulation

Menu command… Function…

New Window Opens a new window in Probe.

Close Closes the current window.

Close All Closes all windows.

Cascade Cascades the windows.

Tile Horizontally Tiles the windows horizontally.

Tile Vertically Tiles the windows vertically.

Title Changes the title of the Probe window.

Display Control Provides a means of saving and restoring the display settings.

Copy to Clipboard Copies the contents of the current Probe window to the 
clipboard.

<listing of 
currently displayed 
windows in Probe>
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Terms used in File

Export Data

Data displayed on the PSpice window can be exported either into a data file, a stimulus library 
file or into a text file. 

The Export Probe Data dialog box is used for generating a data (.dat) file, the Export Stimulus 
Library dialog box is used for generating a stimulus file, and using Export Text Data dialog box 
generates a text file.

Output Variables to 
Export

Lists the variables for which traces will be present in the text file 
to be generated.

File Name Specify the name of the new text file to be generated.

Available Output 
Variables

Lists the output variables for which data is available.

Analog Select this to list all Analog variables in the Available Output 
Variables list box.

Digital

Voltages Select this if you want only the voltage output variables to be 
listed in the Available Output Variables list box.

Currents Select this if you want only the current output variables to be 
listed in the Available Output Variables list box.

Power Select this if you want only the power output variables to be 
listed in the Available Output Variables list box.

Noise(V^2/Hz)

Alias Names Select this to list Alias Names in the Available Output Variables 
list box.

Subcircuit Nodes Select this to list the subcircuit nodes in the Available Output 
Variables list box.

Add Use this add a new trace variable. Clicking this moves the 
selected variable from the Available Output Variables list box to 
Output Variables to Export list box.

Add All Use this add all the variables listed in the Available Output 
Variables list box to Output Variables to Export list box.
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Find dialog box

The Find dialog box is used to find text in the text window in PSpice.

The options in the Find dialog box are described below:

Remove Select this to remove a variable, for which you do not want the 
reference file.

Remove All Select this to remove all the variables form the Output Variables 
to Export list box.

Data Compression Data Compression options are available only for the transient 
analysis. For AC and DC analysis these options are not 
enabled.

Enable Select this check box to enable data compression. Selecting 
this check box enables the Tolerance fields. Increasing the 
tolerance value decreases the number of data files in the 
reference waveform. As a result the size of the dat file 
generated is also reduced.

Absolute Tolerances Use this to specify the Absolute tolerance to be used while 
generating the reference data.

Relative Tolerances Use this to specify the Relative tolerance to be used while 
generating the reference data. The number of data points in the 
reference waveform and size of the dat file generated is 
inversely proportional to the absolute and the relative tolerance.

Reset Select this to Reset the tolerance values to the default values.

Match Case Select this to find text that matches the case of the search string

Regular expression Select this to find text using regular expressions.

Wrap around search If this check box is selected, the search wraps around to the start 
of the document. 

If this check box is not selected, PSpice displays the “string not 
found” error message if the string is not found between the 
current cursor position and the end of the file.

Mark All Click this button to mark all the lines where the search string 
exists.
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Regular expressions

You can use regular expressions to find text using the Find dialog box.

Regular expressions are made up of normal characters and metacharacters. Normal 
characters include upper and lower case letters and digits. The metacharacters have special 
meanings and are described in detail below.

Metacharacter Description

. The period (.) matches any single character except the newline 
character ^. For example the regular expression r.t will match 
the strings rat, rut, r t, but not root.

[ ] Use the [ ] brackets to match any one of the characters between 
the brackets. For example, the regular expression r[aou]t 
matches rat, rot, and rut, but not ret. 

Ranges of characters can specified by using a hyphen. For 
example, the regular expression [0-9] means match any digit. 
Multiple ranges can be specified as well. The regular 
expression [A-Za-z] means match any upper or lower case 
letter. 

To match any character except those in the range, use the caret 
as the first character after the opening bracket. For example, 
the expression [^269A-Z] will match any characters except 2, 6, 
9, and upper case letters.  

$ The dollar sign ($) matches the end of a line. For example, the 
regular expression professional$ will match the end of the line 
"He is a professional" but not the end of the line "They are 
professionals"

^ The caret (^) matches the beginning of a line. For example, the 
regular expression ̂ When in will match the beginning of the line 
"When in the course of human events" but will not match the 
beginning of the line "What and When in the"

* The asterisk (*) matches zero or more occurrences of the 
character immediately preceding. For example, the regular 
expression .* matches any number of any characters. The 
regular expression [a-z]* matches zero or more lower-case 
characters.
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The Large Data File dialog box

The Large Data File dialog box appears when you try to open a large data file in PSpice. A 
large data file is a .dat file in which the number of data points per trace is greater than the limit 
specified in PSpice. By default, this limit is set to 1 million data points per trace.

\ A backslash (\) followed by any metacharacter matches the 
literal character itself. That is, the backslash “escapes” the 
metacharacter. For example, \$ is used to match the dollar sign 
$ rather than the end of a line. Similarly, the expression \. is 
used to match the period character rather than any single 
character.

| Matches two conditions. For example the regular expression 
him|her matches the line "it belongs to him" and matches the 
line "it belongs to her" but does not match the line "it belongs to 
them" 

? A question mark (?) is an optional element. For example, xy?z 
matches either xyz or xz.

+  Matches one or more occurrences of the character or regular 
expression immediately preceding. For example, the regular 
expression 9+ matches 9, 99, 999 and so on. The regular 
expression [a-z]+ matches one or more lower-case characters.

Options Used for...

Use fewer data 
points to display 
the complete trace 

Select this when you want the complete trace to be displayed. 
In this case all data points are not used to construct the trace, 
only a few data points are used to construct the trace. 

The number of points used to construct the trace can be 
specified in the Probe Setting dialog box. The number of data 
points to be used is specified in the Data points in one part text 
box in the Large data file tab of the Probe Settings dialog box. 

For example, if in the .dat file the complete trace is defined 
using 4 million data points and the value specified in the Data 
points in one part text box is 1 million, then the trace displayed 
on the Probe window will be created using only 1 million data 
points, which is one-fifth of the total number of data points.
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Note: The following two options are disabled for marching waveforms:

■ Use fewer data points to display the complete trace

■ Use all data points to display trace in parts

Use all data points 
to display trace in 
parts 

Select this when you want to load and display the trace in parts. 
In this case, all the data points are used to construct the part of 
the trace. 

The size of each part of the trace is decided by the number 
specified in the Data points in one part text box in the Large 
data file tab of the Probe Settings dialog box. 

For example, if the complete trace from 0 to 5 seconds has 
500000 data points and the value specified in the Data points in 
one part text box is 100000, then the complete trace will be 
divided into 5 parts, each constructed using 100000 data 
points.

Ignore this warning Select this if you want to load the complete trace in one go 
using all the data points. 

When you select this option the data file may or may not get 
loaded depending on the system memory. If the memory 
required for loading the complete data file is not sufficient, an 
error message stating Out of Memory appears and the file is not 
loaded. 

Always use this 
option 

Select this check box, if you want that one of the three options 
selected by you should be set as default.
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The Quick Reference Card (QRC) is an online description of the shortcut keys and toolbars 
for PSpice. The shortcut keys provide an alternative, keyboard-based method of executing 
the most common commands. The toolbars also duplicate the most common menu 
commands and allow you to start them with just one click of the mouse.

Click the button to jump to the listings of shortcuts or toolbars you are interested in.

Keyboard shortcuts 

PSpice toolbars 

File toolbar in PSpice 

Edit toolbar in PSpice 

Simulate toolbar in PSpice

Probe toolbar in PSpice 

Cursor toolbar in PSpice 

Keyboard shortcuts

Key    Mode or user interface item Function or menu command

CTRL+ A Zoom menu (on the View 
menu)

Area

CTRL+ C Edit menu Copy

CTRL+ 
SHIFT+ C

Cursor menu (on the Trace 
menu)

Display

CTRL+ F Edit menu Find

CTRL+ 
SHIFT+ F

Cursor menu (on the Trace 
menu)

Freeze

CTRL+ G Edit menu Goto Line
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CTRL+ H Edit menu Replace

CTRL+ I Zoom menu (on the View 
menu)

In

CTRL+T Zoom menu (on the View 
menu)

Out

CTRL+ 
SHIFT+ I

Cursor menu (on the Trace 
menu)

Point

CTRL+ L Zoom menu (on the View 
menu)

Redraw

CTRL+ 
SHIFT+ L

Cursor menu (on the Trace 
menu)

Slope

CTRL+ 
SHIFT+ M

Cursor menu (on the Trace 
menu)

Min

CTRL+ N With a PSpice window active Creates a new text file

CTRL+ 
SHIFT+ N

Cursor menu (on the Trace 
menu)

Next Transition

CTRL+ O File menu Open

CTRL+ P File menu Print

CTRL+ 
SHIFT+ P

Cursor menu (on the Trace 
menu)

Peak

CTRL+ 
SHIFT+ R

Cursor menu (on the Trace 
menu)

Previous Transition

CTRL+ 
SHIFT+ S

Cursor menu (on the Trace 
menu)

Search Commands

CTRL+ 
SHIFT+ T

Cursor menu (on the Trace 
menu)

Trough

CTRL+ U With a waveform window active Restores the last deleted 
traces

CTRL+ V Edit menu Paste

CTRL+ X Edit menu Cut

CTRL+ 
SHIFT+ X

Cursor menu (on the Trace 
menu)

Max

CTRL+ Y With a waveform window active Add a Y axis
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PSpice toolbars

PSpice toolbar in Capture
    

CTRL+ 
SHIFT+ Y

With a waveform window active Delete a Y axis

F1 Help menu Help Topics

F3 Edit menu Find Next

ALT+ F4 File menu Exit

F12 With a waveform window active Restores the last waveform 
window

INSERT With a waveform window active Opens the Add Traces dialog 
box

DELETE Edit menu Delete

CTRL+ 
DELETE

With a waveform window active Deletes all traces in the 
waveform window

 Tool Name Description

 New Simulation Profile Opens the New Simulation dialog 
box. Equivalent to the New 
Simulation Profile command on the 
PSpice menu. 

 Edit Simulation Profile Opens the Simulation Settings 
dialog box. Equivalent to the Edit 
Simulation Profile command on the 
PSpice menu.

 Run Runs the simulation. Equivalent to 
the Run command on the PSpice 
menu.

 View Simulation Results Opens the simulation window. 
Equivalent to the View Simulation 
Results command on the PSpice 
menu.
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File toolbar in PSpice 

 Voltage level marker Places a voltage level marker on 
the schematic page. Equivalent to 
the Voltage Level command on the 
Markers menu (on the PSpice 
menu).

 Current into pin marker Places a current into pin marker on 
the schematic page. Equivalent to 
the Current Into Pin command on 
the Markers menu (on the PSpice 
menu).

 Voltage differential marker Places a voltage differential marker 
on the schematic page. Equivalent 
to the Voltage Differential command 
on the Markers menu (on the 
PSpice menu).

Tool Name Description

 New Opens a new simulation file or 
a new text file. Equivalent to 
the Simulation Profile 
command or Text File 
command on the New menu 
(on the File menu).

 Open Opens a data file. Equivalent to 
the Open command on the File 
menu.

 

 Save Saves the active file. 
Equivalent to the Save 
command on the File menu.

 Print Prints the active file. Similar to 
the Print command on the File 
menu.
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Edit toolbar in PSpice 

Note: Most of the commands in the Edit toolbar are grayed out and unavailable unless you 
are currently working in a text file. The Undo and Redo commands only apply to actions 
performed within the text editor. These do not affect any actions performed within Probe or 
PSpice.

Tool Name Description

 Cut Removes the selected object 
and places it on the Clipboard. 
Equivalent to the Cut 
command on the Edit menu.

 Copy Copies the selected object to 
the Clipboard. Equivalent to 
the Copy command on the Edit 
menu.

 Paste Pastes the contents of the 
Clipboard at the cursor. 
Equivalent to the Paste 
command on the Edit menu.

 Undo Undoes the last command 
performed in the text editor 
only. Equivalent to the Undo 
command on the Edit menu.

 Redo Redoes the last command 
performed in the text editor 
only. Equivalent to the Redo 
command on the Edit menu.

 Toggle bookmark Toggles a bookmark at the 
current line. Equivalent to the 
Toggle Bookmark command on 
the Edit menu.

 Next bookmark Moves to the next bookmark. 
Equivalent to the Next 
Bookmark command on the 
Edit menu.
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Probe toolbar in PSpice 
    

 Previous bookmark Moves to the previous 
bookmark. Equivalent to the 
Previous Bookmark command 
on the Edit menu.

 Clear all bookmarks Clears all bookmarks in the 
active window. Equivalent to 
the Clear Bookmarks 
command on the Edit menu.

Tool Name Description

 Run Runs the current simulation. 
Equivalent to the Run 
command on the Simulation 
menu.

 Pause Pauses the simulation run. 
Equivalent to the Pause 
command on the Simulation 
menu.

Tool Name Description

 Zoom in Zooms in on a specified point. 
Equivalent to the In command 
on the Zoom menu (on the 
View menu).

 Zoom out Zooms out from a specified 
point. Equivalent to the Out 
command on the Zoom menu 
(on the View menu).
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 Zoom area Zooms in on a selected area of 
a graph. Equivalent to the Area 
command on the Zoom menu 
(on the View menu).

 Zoom fit Zooms to show all traces and 
labels. Equivalent to the Fit 
command on the Zoom menu 
(on the View menu).

 Toggle Large Data File Mode Toggles between two modes 
for loading a large data file, 
Display Fewer points and 
Display in parts.

 Load Next Part Is enabled when the Display in 
parts mode for loading Large 
Data File is selected. 

Loads and 
displays 
the next 
part of 
the 
trace. 
Select 
the down-
arrow 
button 
when you 
want load 
any one 
of the 
next 5 or 
the 
previous 
5 parts. 
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 Log X axis Toggles the X axis between log 
and linear scaling. Equivalent 
to selecting the Log option or 
Linear option in the X Axis tab 
in the Axis Settings dialog box 
(accessed by choosing the 
Axis Settings command on the 
Plot menu).

 Fourier Toggles between displaying 
the Fourier transform of all 
analog traces in the selected 
plot. Equivalent to the Fourier 
(or End Fourier) command on 
the Trace menu.

 Performance analysis Toggles the performance 
analysis on and off. Equivalent 
to the Performance Analysis 
command on the Trace menu.

 Log Y axis Toggles the Y axis between log 
and linear scaling. Equivalent 
to selecting the Log option or 
Linear option in the Y Axis tab 
in the Axis Settings dialog box 
(accessed by choosing the 
Axis Settings command on the 
Plot menu).

 Add trace Opens the Add Traces dialog 
box, which you use to add a 
trace (or traces) to a selected 
plot. Equivalent to the Add 
Trace command on the Trace 
menu.

 Evaluate measurement Opens the Evaluate 
Measurement dialog box, 
which you use to evaluate a 
measurement expression's 
value. Equivalent to the 
Evaluate Measurement 
command on the Trace menu.
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 Text label Opens the Text Label dialog 
box, which you use to add a 
text label to a graph. 
Equivalent to the Text 
command on the Label menu 
(on the Plot menu).

 Mark data points Marks data points on analog 
traces. Equivalent to selecting 
the Mark Data Points option in 
the Probe Settings dialog box 
(accessed by choosing the 
Options command on the Tools 
menu).

 Toggle cursor Toggles the display of the 
Probe cursor on and off. 
Equivalent to the Display 
command on the Cursor menu 
(on the Trace menu).

Tool Name Description

 Cursor peak Positions the cursor at the next 
peak value. Equivalent to the 
Peak command on the Cursor 
menu (on the Trace menu).

 Cursor trough Positions the cursor at the next 
trough. Equivalent to the 
Trough command on the 
Cursor menu (on the Trace 
menu).

 Cursor slope Positions the cursor at the next 
slope. Equivalent to the Slope 
command on the Cursor menu 
(on the Trace menu).
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 Cursor min Positions the cursor at the next 
minimum value. Equivalent to 
the Min command on the 
Cursor menu (on the Trace 
menu).

 Cursor max Positions the cursor at the next 
maximum value. Equivalent to 
the Max command on the 
Cursor menu (on the Trace 
menu).

 Cursor point Positions the cursor at the next 
data point. Equivalent to the 
Point command on the Cursor 
menu (on the Trace menu).

 Cursor search Opens the Search Command 
dialog box, which you use to 
position the cursor at a specific 
place along a trace. Equivalent 
to the Search Commands 
command on the Cursor menu 
(on the Trace menu).

 Cursor next tran Positions the cursor at the next 
digital transition. Equivalent to 
the Next Transition command 
on the Cursor menu (on the 
Trace menu).

 Cursor prev tran Positions the cursor at the 
previous digital transition. 
Equivalent to the Previous 
Transition command on the 
Cursor menu (on the Trace 
menu).

 Mark label Marks the current cursor 
location with a value. 
Equivalent to the Mark 
command on the Label menu 
(on the Plot menu).
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Index of PSpice symbol and part properties

The following index lists every symbol/part property that can be used with PSpice, its 
associated symbol/part, what libraries the symbol/part can be found in, and a brief description 
of what the property is used for. This list should be used when preparing a circuit for 
simulation by setting up property assignments for symbols/parts that are placed in Capture. 
The properties are listed alphabetically for easy searching.

Proper
ty 

Symbol(s)/
Part(s)

PSpice 
Library

Description Req
uired

Defa
ult

Units

AC VPWL, VSIN, 
VPWL_F_RE_
FOREVER, 
VPWL_RE_N_
TIMES, 
VPULSE, 
VPWL_ENH, 
VPWL_RE_F
OREVER, 
VPWL_FILE, 
VSFFM, 
VSRC, 
VPWL_F_RE_
N_TIMES, 
VSTIM

SOURCE AC magnitude (used 
in AC sweep analysis 
only)

No 0 V

AC IPWL, ISIN, 
IPWL_F_RE_
FOREVER, 
IPWL_RE_N_
TIMES, 
IPULSE, 
IPWL_ENH, 
IPWL_RE_FO
REVER, 
IPWL_FILE, 
ISFFM, ISRC, 
IPWL_F_RE_
N_TIMES, 
ISTIM

SOURCE, 
SOURCST
M

AC magnitude (used 
in AC sweep analysis 
only)

No 0 A
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AC IPRINT, 
VPRINT1, 
VPRINT2

SPECIAL Print AC sweep 
results for signal to 
output file (Y|N)

No N none

ACMAG IAC SOURCE AC magnitude (used 
in AC sweep analysis 
only)

Yes 0 A

ACPHAS
E 

IAC SOURCE AC phase (used in AC 
sweep analysis only)

No 0 Degr
ees

ACMAG VAC SOURCE AC magnitude (used 
in AC sweep analysis 
only)

Yes 0 V

ACPHAS
E 

VAC SOURCE AC phase (used in AC 
sweep analysis only)

No 0 Degr
ees

AD MbreakN4, 
MbreakN, 
MbreakN3, 
MbreakP4, 
MbreakP, 
MbreakP3, 
Mbreak P4, 
MbreakN3

BREAKOUT Drain diffusion area No DEF
AD

m^2

AGD ZbreakN BREAKOUT Gate-drain overlap 
area

No 5.0e-
6

m^2

ANALYS
IS 

PRINT1, 
WATCH1

SPECIAL Analysis type 
(AC|DC|TRAN)

No TRA
N

none
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AREA DbreakCR, 
JbreakN, 
QbreakP3, 
DbreakW, 
JbreakP, 
QbreakP4, 
QbreakL, 
QbreakN3, 
QbreakN4, 
QbreakN, 
QbreakP, 
DbreakZ, 
Dbreak, 
Bbreak, 
ZbreakN

BREAKOUT Area value (for 
scaling)

No 1.0 none

ARM_MA
SS 

Relay_SPDT_
phy

ANL_MISC Contact arm mass 
(moment)

Yes 0.5 g*cm
*sec*
sec

AS MbreakN4, 
MbreakN, 
MbreakN3, 
MbreakP4, 
MbreakP, 
MbreakP3, 
Mbreak P4, 
MbreakN3

BREAKOUT Source diffusion area No DEF
AS

m^2

ASSERT
ION 

HOLD<SIZE> DIG_MISC Assert hold violation 
when low to high or 
high to low (LH|HL)

Yes  LH none

ASSERT
ION 

SETUP<SIZE
>

DIG_MISC Assert setup violation 
when low to high or 
high to low (LH|HL)

Yes  LH none

BACKEM
F 

BLDCMTR MIX_MISC Back EMF constant Yes  0.12 Volt*
sec/
rev

BIT VECTOR<SIZ
E>

SPECIAL Bit position within a 
single hex or octal 
digit (see .VECTOR)

No none none
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C TLOSSY, 
TLURC<SIZE
>, 
TLUMP<SIZE
>

ANALOG, 
TLINE

Capacitance value 
per unit length of 
transmission line

Yes 1 F

C T<SIZE>coupl
ed

TLINE Capacitance value 
per unit length of 
coupled transmission 
line

Yes -1 F

C1 T<SIZE>coupl
edX

TLINE Capacitance value 
per unit length of first 
coupled transmission 
line

Yes -1 F

C2 T<SIZE>coupl
edX

TLINE Capacitance value 
per unit length of 
second coupled 
transmission line

Yes -1 F

C3 T<SIZE>coupl
edX

TLINE Capacitance value 
per unit length of third 
coupled transmission 
line

Yes -1 F

C4 T<SIZE>coupl
edX

TLINE Capacitance value 
per unit length of 
fourth coupled 
transmission line

Yes -1 F

C5 T<SIZE>coupl
edX

TLINE Capacitance value 
per unit length of fifth 
coupled transmission 
line

Yes -1 F

CAP DIGCAP DIG_MISC Capacitance value for 
digital I/O model

Yes  10P F

CAPACI
TANCE 

BLDCMTR MIX_MISC Winding capacitance 
to ground

Yes  
0.00
1u

F

CIN ADCPAR<SIZ
E>

DATACONV Input capacitance Yes  10P F

CIN ADCMIC<SIZ
E>

DATACONV Input capacitance Yes  22p F
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CKDPDM
AX 

ADCSER<SIZ
E>

DATACONV Maximum clock to 
data delay

Yes  80n sec

CKDPDM
IN 

ADCSER<SIZ
E>

DATACONV Minimum clock to 
data delay

Yes  25n sec

CLKHI ADCSER<SIZ
E>

DATACONV Minimum clock high 
pulse width

Yes  40n sec

CLKLO ADCSER<SIZ
E>

DATACONV Minimum clock low 
pulse width

Yes  60n sec

CLKMAX ADCSER<SIZ
E>

DATACONV Maximum clock 
frequency

Yes  
5Me
g

Hz

CLKMIN ADCSER<SIZ
E>

DATACONV Minimum clock 
frequency

Yes  
178.
571K

Hz

CM T<SIZE>coupl
ed, 
T<SIZE>coupl
edX

TLINE Mutual capacitance 
per unit length

Yes 0 F

CM Kcouple2 TLINE Mutual coupling 
capacitance per unit 
length

Yes none F

CM12 T<SIZE>coupl
edX

TLINE Mutual coupling 
capacitance per unit 
length between tlines 
1 and 2

Yes 0 F

CM13 T<SIZE>coupl
edX

TLINE Mutual coupling 
capacitance per unit 
length between tlines 
1 and 3

Yes 0 F

CM14 T<SIZE>coupl
edX

TLINE Mutual coupling 
capacitance per unit 
length between tlines 
1 and 4

Yes 0 F

CM15 T<SIZE>coupl
edX

TLINE Mutual coupling 
capacitance per unit 
length between tlines 
1 and 5

Yes 0 F
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CM21 Kcouple<SIZE
>

TLINE Mutual coupling 
capacitance per unit 
length between tlines 
2 and 1

Yes none F

CM23 T<SIZE>coupl
edX

TLINE Mutual coupling 
capacitance per unit 
length between tlines 
2 and 3

Yes 0 F

CM24 T<SIZE>coupl
edX

TLINE Mutual coupling 
capacitance per unit 
length between tlines 
2 and 4

Yes 0 F

CM25 T<SIZE>coupl
edX

TLINE Mutual coupling 
capacitance per unit 
length between tlines 
2 and 5

Yes 0 F

CM31 Kcouple<SIZE
>

TLINE Mutual coupling 
capacitance per unit 
length between tlines 
3 and 1

Yes none F

CM32 Kcouple<SIZE
>

TLINE Mutual coupling 
capacitance per unit 
length between tlines 
3 and 2

Yes none F

CM34 T<SIZE>coupl
edX

TLINE Mutual coupling 
capacitance per unit 
length between tlines 
3 and 4

Yes 0 F

CM35 T<SIZE>coupl
edX

TLINE Mutual coupling 
capacitance per unit 
length between tlines 
3 and 5

Yes 0 F

CM41 Kcouple<SIZE
>

TLINE Mutual coupling 
capacitance per unit 
length between tlines 
4 and 1

Yes none F
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CM42 Kcouple<SIZE
>

TLINE Mutual coupling 
capacitance per unit 
length between tlines 
4 and 2

Yes none F

CM43 Kcouple<SIZE
>

TLINE Mutual coupling 
capacitance per unit 
length between tlines 
4 and 3

Yes none F

CM45 T<SIZE>coupl
edX

TLINE Mutual coupling 
capacitance per unit 
length between tlines 
4 and 5

Yes 0 F

CM51 Kcouple<SIZE
>

TLINE Mutual coupling 
capacitance per unit 
length between tlines 
5 and 1

Yes none F

CM52 Kcouple<SIZE
>

TLINE Mutual coupling 
capacitance per unit 
length between tlines 
5 and 2

Yes none F

CM53 Kcouple<SIZE
>

TLINE Mutual coupling 
capacitance per unit 
length between tlines 
5 and 3

Yes none F

CM54 Kcouple<SIZE
>

TLINE Mutual coupling 
capacitance per unit 
length between tlines 
5 and 4

Yes none F

CO QRLSZCS SWIT_RAV Resonant capacitor 
value

Yes  .1u F

COEFF EPOLY ANALOG Voltage gain Yes 1 V/V

COEFF FPOLY ANALOG Current gain Yes 1 A/A

COEFF GPOLY ANALOG Transconductance Yes 1 A/V

COEFF HPOLY ANALOG Transresistance Yes 1 V/A
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COMMAN
D<LINE
>

STIM1 SOURCE (time, bit value) pairs 
of stimuli to be 
generated (see 
Stimulus Generator)

Yes  0s 0 pair

COMMAN
D<LINE
>

STIM16 SOURCE (time, hex value) pairs 
of stimuli to be 
generated (see 
Stimulus Generator)

Yes  0s 
0000

pair

COMMAN
D<LINE
>

STIM4 SOURCE (time, bit value) pairs 
of stimuli to be 
generated (see 
Stimulus Generator)

Yes  0s 
0000

pair

COMMAN
D<LINE
>

STIM8 SOURCE (time, bit value) pairs 
of stimuli to be 
generated (see 
Stimulus Generator)

Yes  0s 
0000
0000

pair

CONTAC
T_MATC
H 

Relay_DPDT_
b, 
Relay_DPDT_
nb

MIX_MISC Matching of contact 
make/break/bounce 
times: 1 = exact

Yes 0.95 none

CONVWH
I 

ADCSER<SIZ
E>

DATACONV Minimum high width 
of convert pulse

Yes  40n sec

CONVWH
I 

ADCPAR<SIZ
E>

DATACONV Minimum high width 
of convert pulse

Yes  45n sec

CONVWH
I 

ADCMIC<SIZ
E>

DATACONV Minimum high width 
of convert pulse

Yes  50n sec

CONVWL
O 

ADCPAR<SIZ
E>

DATACONV Minimum low width of 
convert pulse

Yes  45n sec

CONVWL
O 

ADCMIC<SIZ
E>

DATACONV Minimum low width of 
convert pulse

Yes  50n sec

CONVWL
O 

ADCSER<SIZ
E>

DATACONV Minimum low width of 
convert pulse

Yes  60n sec
June 2020 282 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



PSpice Help
COUPLI
NG 

XFRM_LINEA
R, 
XFRM_NONLI
NEAR, 
K_LINEAR, 
kbreak

ANALOG, 
BREAKOUT

Coupling coefficient Yes 1 none

COUT DACCUR<SIZ
E>

DATACONV Output capacitance Yes  10p F

CSMINL
O 

DACPAR<SIZ
E>

DATACONV Minimum low width of 
CS

Yes  90n sec

D CMSSCCM SWIT_RAV Duty cycle Yes 0.75 none

D VMSSCCM SWIT_RAV Duty cycle Yes 0.4 none

DAMPIN
G 

BLDCMTR MIX_MISC Damping and eddy 
current losses (linear 
torque with speed)

Yes  0.36 g*cm
*sec/
rad

DAMPIN
G 

Relay_SPDT_
phy

ANL_MISC Limit damping rate Yes 1000 g*cm
*sec/
rad

DB IPRINT, 
IPLOT, 
VPLOT1, 
VPLOT2, 
VPRINT1, 
VPRINT2

SPECIAL Write signal in DB in 
output file (Y|N)

No N none

DC VDC SOURCE DC voltage 
magnitude (used for 
bias point and in 
transient analysis)

Yes 0 V

DC IDC SOURCE DC current magnitude 
(used for bias point 
and in transient 
analysis)

Yes 0 A
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DC VPWL, VSIN, 
VPWL_F_RE_
FOREVER, 
VPWL_RE_N_
TIMES, 
VPULSE, 
VPWL_ENH, 
VPWL_RE_F
OREVER, 
VPWL_FILE, 
VSFFM, 
VSRC, 
VPWL_F_RE_
N_TIMES, 
VSTIM, VAC

SOURCE, 
SOURCST
M

DC voltage 
magnitude (used for 
bias point)

No 0 V

DC IPWL, ISIN, 
IPWL_F_RE_
FOREVER, 
IPWL_RE_N_
TIMES, 
IPULSE, 
IPWL_ENH, 
IPWL_RE_FO
REVER, 
IPWL_FILE, 
ISFFM, ISRC, 
IPWL_F_RE_
N_TIMES, 
ISTIM, IAC

SOURCE, 
SOURCST
M

DC current magnitude 
(used for bias point)

No 0 A

DC IPRINT, 
IPLOT, 
VPLOT1, 
VPLOT2, 
VPRINT1, 
VPRINT2

SPECIAL Write DC analysis 
results to output file 
(Y|N)

No N none

DEADTI
ME 

SG1525A/
25C, 
SG1526B, 
SG1525, 
SG1524B, 
SG1529

SWIT_REG Dead time Yes 1u sec
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DEADTI
ME 

SG1842, 
SG1843, 
SG1844, 
SG1845, 
SG1846

SWIT_REG Dead time Yes 2u sec

DEADTI
ME 

SG1825 SWIT_REG Dead time Yes 5E-
08

sec

DELAY DIGCLOCK SOURCE Delay before clock 
starts

No 0 sec

DELAY EFREQ, 
FTABLE, 
GFREQ

ABM Phase delay to apply 
to data in frequency 
table

No 0 sec

DELAY DELAY DIG_MISC Digital delay Yes  50n sec

DENOM LAPLACE ABM Denominator of 
Laplace transform

Yes  1 + 
s

none

DETENT BLDCMTR MIX_MISC Magnetic detent 
torque

Yes  2.9 g*cm

DF VSIN, ISIN SOURCE Damping factor No 0 none

DHOLD DACSER<SIZ
E>

DATACONV Data hold time Yes 10n sec

DIG_GN
D 

STIM<SIZE> SOURCE Digital ground 
reference node 
(change for user 
power supply)

Yes  
$G_
DGN
D

none

DIG_PW
R 

STIM<SIZE> SOURCE Digital power 
reference node 
(change for user 
power supply)

Yes  
$G_
DPW
R

none

DRAG Relay_SPDT_
phy

ANL_MISC Air and other contact 
arm drag

Yes 1 g*cm
/
sec^
2

DSET DACSER<SIZ
E>

DATACONV Data setup time Yes  
100n

sec
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ERRORL
IMIT 

RELEASE<SI
ZE>, 
HOLD<SIZE>, 
CONSTRAINT
<SIZE>, 
SETUP<SIZE
>, WIDTH_HI, 
WIDTH_LO, 
MAXFREQ

DIG_MISC Maximum number of 
constraint checker 
violations to report

No  20 none

EXP<LI
NE>

PWR, PWRS, 
ABM2, ABM3, 
ABM1, ABM1/
I, ABM3/I, 
ABM2/I, ABM/
I, ABM

ABM ABM expression line 
containing circuit 
variables and math 
functions and 
operators forming 
controlling 
expression. Start with 
lowest number. Lines 
are concatenated.

Yes 1 none

EXPR ELAPLACE, 
GTABLE, 
EFREQ, 
ETABLE, 
GVALUE, 
GFREQ, 
EVALUE, 
GLAPLACE

ABM ABM expression line 
containing circuit 
variables and math 
functions and 
operators forming 
controlling 
expression. Default is 
signal connected to 
input pins of symbol.

No  
V(%I
N+, 
%IN-
)

insta
nce

F T ANALOG Frequency for NL 
parameter (see 
Transmission Line 
device)

No none Hz

F0 BANDREJ, 
BANDPASS

ABM Lower stopband 
frequency of filter

Yes  10 Hz

F1 BANDREJ, 
BANDPASS

ABM Lower passband 
frequency of filter

Yes  100 Hz

F2 BANDREJ, 
BANDPASS

ABM Upper passband 
frequency of filter

Yes  300 Hz

F3 BANDREJ, 
BANDPASS

ABM Upper stopband 
frequency of filter

Yes  
1000

Hz
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FC VSFFM, 
ISFFM

SOURCE Carrier frequency Yes none Hz

FILE VPWL_F_RE_
FOREVER, 
IPWL_F_RE_
N_TIMES, 
VPWL_FILE, 
IPWL_F_RE_
FOREVER, 
VPWL_F_RE_
N_TIMES

SOURCE Input file containing 
PWL source data,  
(time, analog value) 
pairs

Yes none none

FILE VECTOR<SIZ
E>

SPECIAL Output file for 
.VECTOR results

No none none

FILENA
ME 

FileStim<SIZE
>

SOURCE Input file containing 
STIM source data, 
(time, digital value) 
pairs

Yes none none

FILENA
ME 

LIB SPECIAL Library file name to 
be included

Yes none none

FILENA
ME 

INCLUDE SPECIAL Include file name to 
be included

Yes none none

FIRST_
NPAIRS 

IPWL_RE_FO
REVER, 
VPWL_RE_N_
TIMES, 
VPWL_ENH, 
VPWL_RE_F
OREVER, 
IPWL_ENH, 
IPWL_RE_N_
TIMES

SOURCE First line containing 
PWL data, (time, 
analog value) pairs. 
Lines will be 
concatenated.

Yes none pairs

FLOAT Property that should 
be added on an 
unconnected pin. Add 
this property on 
unconnected pins 
instead of using a No 
Connect symbol.
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See 
Using 
the 
FLOAT 
proper
ty 

FM VSFFM, 
ISFFM

SOURCE Modulation frequency Yes none Hz

FORMAT STIM1 SOURCE Digital data format 
(1=bit, 4=hex). 

No 1 binar
y

FORMAT STIM4 SOURCE Digital data format 
(1=bit, 4=hex)

No 1111 binar
y

FORMAT STIM8 SOURCE Digital data format 
(1=bit, 4=hex)

No 1111
1111

binar
y

FORMAT STIM16 SOURCE Digital data format 
(1=bit, 4=hex)

No 4444 hex

FP HIPASS ABM Pass band cutoff 
frequency

Yes  100 Hz

FP LOPASS ABM Pass band cutoff 
frequency

Yes  10 Hz

FREQ VSIN, ISIN SOURCE Frequency of sinusoid 
(transient analysis 
only)

Yes none Hz

FRICTI
ON 

BLDCMTR MIX_MISC Friction/drag losses 
(constant torque 
losses)

Yes  0.72 g*cm
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FRQ COAX, RG6/U, 
RG58A/U, 
RG59B/U, 
RG8A/U, 
RG9B/U, 
RG174/U, 
RG8/U, 
RG12A/U, 
RG58C/U, 
RG6A/U, 
RG11A/U, 
RG59/u=, 
RG22B/U, 
RG55B/U, 
RG58/U+, 
RG8/u+, 
RG62/U 
RG179B/U, 
RG178B/U, 
RG188A/U, 
RG212/U, 
RG223/U, 
RG11/u+, 
RG62A/U, 
RG63B/U, 
RG187A/U, 
RG213/U, 
RG214/U, 
RG11/U, 
RG55/U, 
RG196A/U, 
RG215/U, 
RG71B/U, 
RG195A/U, 
RG217/U, 
RG58/U, 
RG218/U, 
RG59/U, 
RG219/U, 
RG180B/U

TLINE Frequency to evaluate 
expressions for R and 
G (conductor and 
dielectric losses). If 
specified, R and G 
are constant in the 
model. No 
assignment to FRQ 
(leaving the value 
empty) will select 
Laplace expression 
for R and G to model 
skin effect.

No  
100
Meg

Hz
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FRQ TP19AWG, 
TP26AWG, 
TP24AWG, 
TP22AWG

TLINE Frequency to evaluate 
expressions for R and 
G (conductor and 
dielectric losses). If 
specified, R and G 
are constant in the 
model. No 
assignment to FRQ 
(leaving the value 
empty) will select 
Laplace expression 
for R and G to model 
skin effect (use for AC 
Sweep analysis only).

No  5k Hz

FS LOPASS ABM Stop band cutoff 
frequency

Yes  100 Hz

FS CMLSCCM SWIT_RAV Operating frequency Yes  
100k

Hz

FS CMSSCCM SWIT_RAV Operating frequency Yes  
100k

Hz

FS HIPASS ABM Stop band cutoff 
frequency

Yes  10 Hz

FS VMLSDCM SWIT_RAV Operating frequency Yes  50k Hz

FS VMCCMDCM SWIT_RAV Operating frequency Yes  50k Hz

FSOFFS
ET 

QRLSZCS SWIT_RAV Frequency from Vco 
at zero Vc

Yes  
280k

Hz

G T<SIZE>coupl
ed, 
TLUMP<SIZE
>

TLINE Per unit length 
conductance

Yes 0 Siem
ens

G TLOSSY ANALOG Per unit length 
conductance

Yes 1 Siem
ens

G1 T<SIZE>coupl
edX

TLINE Per unit length 
conductance of first 
conductor

Yes 0 Siem
ens
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G2 T<SIZE>coupl
edX

TLINE Per unit length 
conductance of 
second conductor

Yes 0 Siem
ens

G3 T<SIZE>coupl
edX

TLINE Per unit length 
conductance of third 
conductor

Yes 0 Siem
ens

G4 T<SIZE>coupl
edX

TLINE Per unit length 
conductance of fourth 
conductor

Yes 0 Siem
ens

G5 T<SIZE>coupl
edX

TLINE Per unit length 
conductance of fifth 
conductor

Yes 0 Siem
ens

GAIN E ANALOG Voltage gain Yes 1 V/V

GAIN F ANALOG Current gain Yes 1 A/A

GAIN G ANALOG Transconductance Yes 1 I/V

GAIN H ANALOG Transresistance Yes 1 V/I

GAIN DIFFER ABM Prescaling factor 
before differentiation

Yes 1 insta
nce

GAIN INTEG ABM Prescaling factor 
before integration

Yes 1 insta
nce

GAIN GAIN ABM Gain Yes 1000 insta
nce

GAIN GLIMIT ABM Prescaling factor 
before limiting

Yes  1k insta
nce

GAIN HILO ABM Prescaling factor 
before limiting

Yes  1k insta
nce

GAIN SOFTLIM ABM Prescaling factor 
before limiting

Yes  1k insta
nce

GAIN_R
EF 

ADCPAR<SIZ
E>

DATACONV Upper input voltage 
limit

Yes 0.4 none

GAIN_R
EF_GND 

ADCPAR<SIZ
E>

DATACONV Lower input voltage 
limit

Yes -0.4 none

HCTAU BULB OPTO Heat capacity time 
constant

Yes 4.08
2

sec
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HI WATCH1 SPECIAL Upper limit value for 
.WATCH

Yes  
none

V

HI GLIMIT, HILO, 
SOFTLIM

ABM Upper limit Yes 10 V

HOLDTI
ME 

HOLD<SIZE> DIG_MISC Hold time for 
constraint checking

Yes  
none

sec

I_DROP BOUNCE, 
NO_BOUNCE, 
Relay_DPDT_
b, 
Relay_SPDT_
b, 
Relay_SPDT_
nb, 
Relay_DPDT_
nb

ANL_MISC Drop-out current Yes  25m A

I_PULL BOUNCE, 
NO_BOUNCE, 
Relay_DPDT_
b, 
Relay_SPDT_
b, 
Relay_SPDT_
nb, 
Relay_DPDT_
nb

ANL_MISC Pull-in current Yes  35m A

I1 IPULSE, IEXP SOURCE First current level Yes  
none

A

I2 IPULSE, IEXP SOURCE Second current level Yes  
none

A

I1 IPWL SOURCE First PWL point (0s, 
current value)

Yes  
none

A

I2 IPWL SOURCE Second PWL point 
(time, current value)

No  
none

A

I3 IPWL SOURCE Third PWL point 
(time, current value)

No  
none

A

I4 IPWL SOURCE Fourth PWL point 
(time, current value)

No  
none

A
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I5 IPWL SOURCE Fifth PWL point (time, 
current value)

No  
none

A

I6 IPWL SOURCE Sixth PWL point 
(time, current value)

No  
none

A

I7 IPWL SOURCE Seventh PWL point 
(time, current value)

No  
none

A

I8 IPWL SOURCE Eighth PWL point 
(time, current value)

No  
none

A

IAMPL ISIN SOURCE Current amplitude of 
sinusoid (transient 
analysis only)

Yes  
none

A

IAMPL ISFFM SOURCE Current amplitude of 
SFFM (transient 
analysis only)

Yes  
none

A

IC Cbreak, C BREAKOUT
, ANALOG

Initial voltage 
condition on capacitor

No 0 V

IC Lbreak, L BREAKOUT
, ANALOG

Initial current 
condition on inductor

No 0 A

IC INTEG ABM Initial condition for 
integrator

Yes  0 insta
nce

IC VMSSCCM SWIT_RAV  Current flowing from 
terminal C

Yes 1 A

IC CMSSCCM SWIT_RAV  Current flowing from 
terminal C

Yes 100 A

IMAG IPRINT, 
IPLOT, 
VPLOT1, 
VPLOT2, 
VPRINT1, 
VPRINT2

SPECIAL Write signal in 
IMAGINARY format in 
output file (Y|N)

No N none

INDUCT
ANCE 

BLDCMTR MIX_MISC Winding inductance Yes  3m Hz

INERTI
A 

BLDCMTR MIX_MISC Moment of inertia of 
rotor

Yes  0.30 g*cm
*sec*
sec
June 2020 293 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



PSpice Help
IO_MOD
EL 

DACSER<SIZ
E>, 
DACCUR<SIZ
E>, 
ADCSER<SIZ
E>, 
ADCPAR<SIZ
E>, 
DACPAR<SIZ
E>, 
ADCMIC<SIZ
E>

DATACONV I/O model to use for  
and D/A converter 
models

No  
IO_H
CT

none

IO_MOD
EL 

STIM<SIZE>, 
DIGCLOCK, 
DIGSTIM

SOURCE I/O model to use for 
digital stimulus

No  
IO_S
TM

none

IOFF ISIN, ISFFM SOURCE Offset current of 
transient analysis 
source

Yes  
none

A

ISINK DACPAR<SIZ
E>

DATACONV Typical output sink 
current

Yes  -
400u

A

ISOURC
E 

DACPAR<SIZ
E>

DATACONV Typical output source 
current

Yes  5m A

K_COEF 3phase ANL_MISC Mutual coupling 
coefficient

Yes 0.99
99

none

KP ZbreakN BREAKOUT MOS 
transconductance for 
IGBT

No 0.38 A/
V^2

L MbreakN4, 
MbreakN, 
MbreakN3, 
MbreakP4, 
MbreakP, 
MbreakP3, 
Mbreak P4, 
MbreakN3

BREAKOUT Length no DEF
L

m

L TLOSSY, 
TLUMP<SIZE
>,

ANALOG, 
TLINE

Per unit length 
inductance

Yes 1 H
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L T<SIZE>coupl
ed

TLINE Per unit length 
inductance

Yes -1 H

L_COIL BOUNCE, 
NO_BOUNCE, 
Relay_DPDT_
b, 
Relay_SPDT_
b, 
Relay_SPDT_
nb, 
Relay_DPDT_
nb, 
Relay_SPDT_
phy

ANL_MISC, 
MIX_MISC

Coil inductance Yes  5m H

L1 K_LINEAR, 
kbreak

ANALOG, 
BREAKOUT

Reference Designator 
of first coupled 
inductor

Yes L1 refde
s

L1 T<SIZE>coupl
edX

TLINE Per unit length 
inductance of first 
conductor

Yes -1 H

L1_TUR
NS 

XFRM_NONLI
NEAR

BREAKOUT Number of turns for 
first inductor

Yes none none

L1_VAL
UE 

XFRM_LINEA
R

ANALOG Inductance value of 
first inductor

Yes none H

L2 K_LINEAR, 
kbreak

ANALOG, 
BREAKOUT

Reference Designator 
of second coupled 
inductor

Yes L2 refde
s

L2 T<SIZE>coupl
edX

TLINE Per unit length 
inductance of second 
conductor

Yes -1 H

L2_TUR
NS 

XFRM_NONLI
NEAR

BREAKOUT Number of turns for 
second inductor

Yes none none

L2_VAL
UE 

XFRM_LINEA
R

ANALOG Inductance value of 
second inductor

Yes none H

L3 K_LINEAR, 
kbreak

ANALOG, 
BREAKOUT

Reference Designator 
of third coupled 
inductor

Yes L3 refde
s
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L3 T<SIZE>coupl
edX

TLINE Per unit length 
inductance of third 
conductor

Yes -1 H

L4 K_LINEAR, 
kbreak

ANALOG, 
BREAKOUT

Reference Designator 
of fourth coupled 
inductor

Yes L4 refde
s

L4 T<SIZE>coupl
edX

TLINE Per unit length 
inductance of fourth 
conductor

Yes -1 H

L5 K_LINEAR, 
kbreak

ANALOG, 
BREAKOUT

Reference Designator 
of fifth coupled 
inductor

Yes L5 refde
s

L5 T<SIZE>coupl
edX

TLINE Per unit length 
inductance of fifth 
conductor

Yes -1 H

L6 K_LINEAR, 
kbreak

ANALOG, 
BREAKOUT

Reference Designator 
of sixth coupled 
inductor

Yes L6 refde
s

LDACMI
NLO 

DACPAR<SIZ
E>

DATACONV Minimum pulse width 
low for LDAC

Yes  90n sec
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LEN COAX, RG6/U, 
RG58A/U, 
RG59B/U, 
RG8A/U, 
RG9B/U, 
RG174/U, 
RG8/U, 
RG12A/U, 
RG58C/U, 
RG6A/U, 
RG11A/U, 
RG59/u=, 
RG22B/U, 
RG55B/U, 
RG58/U+, 
RG8/u+, 
RG62/U 
RG179B/U, 
RG178B/U, 
RG188A/U, 
RG212/U, 
RG223/U, 
RG11/u+, 
RG62A/U, 
RG63B/U, 
RG187A/U, 
RG213/U, 
RG214/U, 
RG11/U, 
RG55/U, 
RG196A/U, 
RG215/U, 
RG71B/U, 
RG195A/U, 
RG217/U, 
RG58/U, 
RG218/U, 
RG59/U, 
RG219/U, 
RG180B/U, 
TWSTPAIR, 
TP24AWG, 
TP22AWG, 
TP19AWG, 

TLINE, 
ANALOG

Length of 
transmission line. The 
characteristic 
parameters R, L, G, 
and C are defined per 
unit length. For coax 
and twisted pair 
models, the length 
must be specified in 
meters.

Yes none m
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LFIL VMLSDCM, 
VMCCMDCM

SWIT_RAV Filter inductance Yes  
500u

H

LFIL CMLSCCM, 
CMSSCCM

SWIT_RAV Filter inductance Yes  5u H

LIM_K Relay_SPDT_
phy

ANL_MISC Limit spring rate Yes 1000
000

g/
sec

LM T<SIZE>coupl
ed, 
T<SIZE>coupl
edX

TLINE Mutual inductance 
per unit length

Yes 0 H

LM Kcouple2 TLINE Mutual coupling 
inductance per unit 
length

Yes none H

LM12 T<SIZE>coupl
edX, 
Kcouple<SIZE
>

TLINE Mutual coupling 
inductance per unit 
length between tlines 
1 and 2

Yes 0 H

LM13 T<SIZE>coupl
edX, 
Kcouple<SIZE
>

TLINE Mutual coupling 
inductance per unit 
length between tlines 
1 and 3

Yes 0 H

LM14 T<SIZE>coupl
edX, 
Kcouple<SIZE
>

TLINE Mutual coupling 
inductance per unit 
length between tlines 
1 and 4

Yes 0 H

LM15 T<SIZE>coupl
edX, 
Kcouple<SIZE
>

TLINE Mutual coupling 
inductance per unit 
length between tlines 
1 and 5

Yes 0 H

LM21 Kcouple<SIZE
>

TLINE Mutual coupling 
inductance per unit 
length between tlines 
2 and 1

Yes none H

LM23 T<SIZE>coupl
edX, 
Kcouple<SIZE
>

TLINE Mutual coupling 
inductance per unit 
length between tlines 
2 and 3

Yes 0 H
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LM24 T<SIZE>coupl
edX, 
Kcouple<SIZE
>

TLINE Mutual coupling 
inductance per unit 
length between tlines 
2 and 4

Yes 0 H

LM25 T<SIZE>coupl
edX, 
Kcouple<SIZE
>

TLINE Mutual coupling 
inductance per unit 
length between tlines 
2 and 5

Yes 0 H

LM31 Kcouple<SIZE
>

TLINE Mutual coupling 
inductance per unit 
length between tlines 
3 and 1

Yes none H

LM32 Kcouple<SIZE
>

TLINE Mutual coupling 
inductance per unit 
length between tlines 
3 and 2

Yes none H

LM34 T<SIZE>coupl
edX, 
Kcouple<SIZE
>

TLINE Mutual coupling 
inductance per unit 
length between tlines 
3 and 4

Yes 0 H

LM35 T<SIZE>coupl
edX, 
Kcouple<SIZE
>

TLINE Mutual coupling 
inductance per unit 
length between tlines 
3 and 5

Yes 0 H

LM41 Kcouple<SIZE
>

TLINE Mutual coupling 
inductance per unit 
length between tlines 
4 and 1

Yes none H

LM42 Kcouple<SIZE
>

TLINE Mutual coupling 
inductance per unit 
length between tlines 
4 and 2

Yes none H

LM43 Kcouple<SIZE
>

TLINE Mutual coupling 
inductance per unit 
length between tlines 
4 and 3

Yes none H
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LM45 T<SIZE>coupl
edX, 
Kcouple<SIZE
>

TLINE Mutual coupling 
inductance per unit 
length between tlines 
4 and 5

Yes 0 H

LO WATCH1 SPECIAL Lower voltage value 
for .WATCH

Yes none none

LO GLIMIT, HILO, 
LIMIT, 
SOFTLIM

ABM Lower limit voltage Yes 0 V

LO QRLSZCS SWIT_RAV Resonant inductor 
value

Yes  20n H

M MbreakN4, 
MbreakN, 
MbreakN3, 
MbreakP4, 
MbreakP, 
MbreakP3, 
Mbreak P4, 
MbreakN3

BREAKOUT Multiplier No 1 none

MAG IPRINT, 
IPLOT, 
VPLOT1, 
VPLOT2, 
VPRINT1, 
VPRINT2

SPECIAL Write signal in 
MAGNITUDE format 
in output file (Y|N)

No Y none

MAGUNI
TS 

EFREQ, 
FTABLE, 
GFREQ

ABM Units for magnitude 
table entries 
(MAG|DB)

No MAG none

MAXFRE
Q 

MAXFREQ DIG_MISC Maximum frequency 
for constraint checker

Yes none Hz

MAXFRE
Q 

ADCPAR<SIZ
E>

DATACONV Maximum clock 
frequency

Yes  
11M
eg

Hz

MAXP Relay_SPDT_
phy

ANL_MISC Maximum permeance 
(when arm is close to 
coil)

Yes 5 gaus
s*m^
2/A

MINFRE
Q 

MINFREQ DIG_MISC Minimum frequency 
for constraint checker

Yes none Hz
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MINFRE
Q 

ADCPAR<SIZ
E>

DATACONV Minimum clock 
frequency

Yes  10K Hz

MINHOL
D 

ADCMIC<SIZ
E>

DATACONV R/Cbar to CSbar hold 
time

Yes  10n sec

MINLO ADCMIC<SIZ
E>

DATACONV R/Cbar minimum 
pulse width

Yes  50n sec

MINP Relay_SPDT_
phy

ANL_MISC Minimum permeance 
(when arm is close to 
coil)

Yes 1 gaus
s*m^
2/A

MINPER ADCMIC<SIZ
E>

DATACONV Minimum time 
between conversions

Yes  10u sec

MINSET ADCMIC<SIZ
E>

DATACONV R/Cbar to CSbar 
setup time

Yes  10n sec

MINW DACSER<SIZ
E>

DATACONV LDAC low minimum 
pulse width

Yes  50n sec

MOD VSFFM, 
ISFFM

SOURCE Modulation Index Yes none none

MUTUAL
_IND 

BLDCMTR MIX_MISC Adjacent winding 
mutual coupling factor

Yes 0.5 none

N QRLSZCS SWIT_RAV Full-wave=1; half-
wave=2

Yes 2 none

NL T ANALOG Number of 
wavelengths

No none none

NRB MbreakN4, 
MbreakN, 
MbreakN3, 
MbreakP4, 
MbreakP, 
MbreakP3, 
Mbreak P4, 
MbreakN3

BREAKOUT Multiplier of RSH to 
get RB

No 0 none
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NRD MbreakN4, 
MbreakN, 
MbreakN3, 
MbreakP4, 
MbreakP, 
MbreakP3, 
Mbreak P4, 
MbreakN3

BREAKOUT Multiplier of RSH to 
get RD

No 0 none

NRG MbreakN4, 
MbreakN, 
MbreakN3, 
MbreakP4, 
MbreakP, 
MbreakP3, 
Mbreak P4, 
MbreakN3

BREAKOUT Multiplier of RSH to 
get RG

No 0 none

NRS MbreakN4, 
MbreakN, 
MbreakN3, 
MbreakP4, 
MbreakP, 
MbreakP3, 
Mbreak P4, 
MbreakN3

BREAKOUT Multiplier of RSH to 
get RS

No 0 none

NUM LAPLACE ABM Numerator of Laplace 
transform

Yes 1 none

OFFTIM
E 

DIGCLOCK SOURCE Time clock is low Yes  .5u sec

ONTIME DIGCLOCK SOURCE Time clock is high Yes  .5u sec

OPPVAL DIGCLOCK SOURCE State to transition to 
from low (usually 1)

Yes 1 none

PD MbreakN4, 
MbreakN, 
MbreakN3, 
MbreakP4, 
MbreakP, 
MbreakP3, 
Mbreak P4, 
MbreakN3

BREAKOUT Perimeter of drain No 0 m
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PER IPULSE, 
VPULSE

SOURCE Period No TST
OP

sec

PERIOD SG1525A/
25C, 
SG1526B, 
SG1525, 
SG1524B, 
SG1529

SWIT_REG Period of internal 
oscillator

Yes  1m sec

PERIOD SG1825 SWIT_REG Period of internal 
oscillator

Yes  2.5u sec

PERIOD SG1825, 
SG1842, 
SG1843, 
SG1844, 
SG1845, 
SG1846

SWIT_REG Period of internal 
oscillator

Yes  
22.5
u

sec

PERMEA
NCE_RA
TIO 

3phase ANL_MISC Ratio of 
Permeance_inner/
Permeance_outer

Yes 1 none

PHASE IPRINT, 
IPLOT, 
VPLOT1, 
VPLOT2, 
VPRINT1, 
VPRINT2

SPECIAL Write signal in 
PHASE format in 
output file (Y|N)

No N none

PHASEU
NITS 

EFREQ, 
FTABLE, 
GFREQ

ABM Units for phase table 
entries (DEG|RAD)

No DEG none

PNOM BULB OPTO Nominal power Yes  100 W

POS VECTOR<SIZ
E>

SPECIAL Column position (see 
.VECTOR)

No see 
.VEC
TOR

none

PRI_IN
D 

3phase ANL_MISC Primary inductance Yes  
200
m

H

PRI_R 3phase ANL_MISC Primary resistance Yes 0.1 Ohm
s
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PS MbreakN4, 
MbreakN, 
MbreakN3, 
MbreakP4, 
MbreakP, 
MbreakP3, 
Mbreak P4, 
MbreakN3

BREAKOUT Perimeter of source No 0 m

PULSE 74LS122, 
74LS123

1_SHOT Pulsewidth Yes  
116n

sec

PULSE CD4098B 1_SHOT Pulsewidth Yes  1u sec

PULSE CD4538B 1_SHOT Pulsewidth Yes  20u sec

PULSE 74121 1_SHOT Pulsewidth Yes  30n sec

PULSE 54L121 1_SHOT Pulsewidth Yes  35n sec

PULSE 74122 1_SHOT Pulsewidth Yes  45n sec

PULSE 74123 1_SHOT Pulsewidth Yes  45n sec

PULSE 54L122, 
54L123

1_SHOT Pulsewidth Yes  90n sec

PW IPULSE, 
VPULSE

SOURCE Pulsewidth No TST
OP

sec

QUIESC
UR 

SG1842, 
SG1843

SWIT_REG Quiescent current Yes  11m A

R T<SIZE>coupl
ed, 
TLUMP<SIZE
>, TLOSSY, 
TLURC<SIZE
>

TLINE, 
ANALOG

Per unit length 
resistance

Yes 0 Ohm
s
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R_CLOS
E 

BOUNCE, 
Relay_SPDT_
phy, 
NO_BOUNCE, 
Relay_DPDT_
B, 
Relay_SPDT_
b, 
Relay_SPDT_
nb, 
Relay_DPDT_
nb

ANL_MISC, 
MIX_MISC

Closed state 
resistance

Yes 0.05 Ohm
s

R_COIL BOUNCE, 
Relay_SPDT_
phy, 
NO_BOUNCE, 
Relay_DPDT_
B, 
Relay_SPDT_
b, 
Relay_SPDT_
nb, 
Relay_DPDT_
nb

ANL_MISC, 
MIX_MISC

Series resistance of 
coil

Yes 10 Ohm
s

R_I EFREQ, 
FTABLE, 
GFREQ

ABM Use real and 
imaginary (set value 
to R_I). Default is 
magnitude and phase

No mag
nitud
e/
phas
e

none

R_OPEN BOUNCE, 
Relay_SPDT_
phy, 
NO_BOUNCE, 
Relay_DPDT_
B, 
Relay_SPDT_
b, 
Relay_SPDT_
nb, 
Relay_DPDT_
nb

ANL_MISC, 
MIX_MISC

Closed state 
resistance

Yes  
100
MEG

Ohm
s
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R_REF_
IN 

ADCPAR<SIZ
E>

DATACONV Input resistance of 
reference

Yes  5K Ohm
s

R_REF_
OUT 

ADCPAR<SIZ
E>

DATACONV Output resistance of 
reference out

Yes 12 Ohm
s

R_REF_
OUT 

ADCMIC<SIZ
E>

DATACONV Output resistance of 
reference out

Yes  4K Ohm
s

R1 T<SIZE>coupl
edX

TLINE Per unit length 
resistance of first 
conductor

Yes 0 Ohm
s

R2 T<SIZE>coupl
edX

TLINE Per unit length 
resistance of second 
conductor

Yes 0 Ohm
s

R3 T<SIZE>coupl
edX

TLINE Per unit length 
resistance of third 
conductor

Yes 0 Ohm
s

R4 T<SIZE>coupl
edX

TLINE Per unit length 
resistance of fourth 
conductor

Yes 0 Ohm
s

R5 T<SIZE>coupl
edX

TLINE Per unit length 
resistance of fifth 
conductor

Yes 0 Ohm
s

RADIX VECTOR<SIZ
E>

SPECIAL Radix of values of the 
specified nodes

No see 
.VEC
TOR

none

RCLOSE
D 

Sw_tClose, 
Sw_tOpen

ANL_MISC Closed state 
resistance

Yes 0.01 Ohm
s

RD VMSSCCM SWIT_RAV Diode on resistance Yes 0.00
0001

Ohm
s

RE VMSSCCM SWIT_RAV Models ripple across 
esr of cap

Yes 0.00
0001

Ohm
s

REAL IPRINT, 
IPLOT, 
VPLOT1, 
VPLOT2, 
VPRINT1, 
VPRINT2

SPECIAL Write signal in REAL 
format in output file 
(Y|N)

No N none
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REF_AS
SERTIO
N 

RELEASE<SI
ZE>

DIG_MISC Reference edge of 
clock

Yes  LH none

REF_VO
LT_GAI
N 

ADCMIC<SIZ
E>

DATACONV Reference voltage 
gain

Yes 4 none

REFERE
NCE 

CD4000_PWR
, DIGIFPWR

SPECIAL Negative power 
supply value

Yes  0 V
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REL_CT
R 

A4N27, 
A4N28, 
CNY17-1, 
CNY17-2, 
PS2561, 
CNY17-3, 
H11A520, 
PS1001, 
A4N49A, 
BPW32, 
A4N48A, 
A4N47A, 
A4N32, 
A4N25A, 
MRD510, 
PS2565-1, 
PS2621, 
A4N33, 
H11A2, 
MRD500, 
H11AV1, 
MCT2, H11A3, 
PS2501-1, 
PS2601, 
H11AV2, 
H11A4, 
H11AV3, 
A4N25, 
A4N26, 
MCT2E, 
MLED96, 
PS2505-1, 
MOC1005, 
MOC1006, 
IL300, 
SLD1121VS

OPTO Relative current 
transfer ratio

Yes 0.5 none

RELEAS
ETIME 

RELEASE<SI
ZE>

DIG_MISC Minimum time 
between signal 
inactive and clock 
edge

Yes none sec
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REPEAT
_VALUE 

VPWL_RE_N_
TIMES, 
IPWL_F_RE_
N_TIMES, 
VPWL_ENH, 
VPWL_FILE, 
IPWL_ENH, 
IPWL_RE_N_
TIMES, 
VPWL_F_RE_
N_TIMES

SOURCE Number of repetitions 
of specified window of 
signal

No 1 none

RESIST
ANCE 

BLDCMTR MIX_MISC Winding resistance Yes  6 Ohm
s

RI CMLSCCM, 
CMSSCCM

SWIT_RAV Current feedback 
coefficient

Yes 0.01 none

RIN ADCPAR<SIZ
E>

DATACONV Input resistance of 
analog input

Yes  50K Ohm
s

RIPPLE HIPASS, 
LOPASS, 
BANDREJ, 
BANDPASS

ABM Ripple specification Yes  1dB none

RM VMSSCCM SWIT_RAV Resistance modeling 
the base storage 
effects

Yes 0.00
0001

Ohm
s

RMPHIT
E 

VMLSCCM, 
VMLSDCM, 
VMSSCCM, 
VMCCMDCM

SWIT_RAV External ramp height Yes 2 V

ROFF Sbreak BREAKOUT Off-state resistance Yes 1000
000

Ohm
s

RON Sbreak BREAKOUT On-state resistance Yes 1 Ohm
s

ROPEN Sw_tClose, 
Sw_tOpen

ANL_MISC Open-state resistance Yes  
1Me
g

Ohm
s

ROW1 FTABLE ABM First row of data 
triplets (freq, mag, 
phase)

Yes (0Hz
, 0, 
0)         

triple
t
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ROW1 TABLE ABM First row of data pairs 
(input, output)

Yes (0v, 
0v)

pair

ROW2 FTABLE ABM Second row of data 
triplets (freq, mag, 
phase); rows are 
concatenated

No (10H
z, -3, 
-30)

triple
t

ROW2 TABLE ABM Second row of data 
pairs (input, output); 
rows are 
concatenated

No (1v, 
1v)          

pair

ROW3 FTABLE ABM Third row of data 
triplets (freq, mag, 
phase); rows are 
concatenated

No (20H
z,-6,       
-90)

triple
t

ROW3 TABLE ABM Third row of data 
pairs (input, output); 
rows are 
concatenated

No (2v, 
4v)           

pair

ROW4 FTABLE ABM Fourth row of data 
triplets (freq, mag, 
phase); rows are 
concatenated

No (30H
z, -
10, -
120)     

triple
t

ROW4 TABLE ABM Fourth row of data 
pairs (input, output); 
rows are 
concatenated

No (3v, 
9v)        

pair

ROW5 FTABLE ABM Fifth row of data 
triplets (freq, mag, 
phase); rows are 
concatenated

No (40H
z, -
15, -
150)

triple
t

ROW5 TABLE ABM Fifth row of data pairs 
(input, output); rows 
are concatenated

No (4v, 
16v)           

pair

RSW VMSSCCM SWIT_RAV Switch on resistance Yes 0.00
0001

Ohm
s

RTR_PO
LE_PAI
RS 

BLDCMTR MIX_MISC Number of north 
poles on the rotor

Yes 2 none
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SCHOLD DACSER<SIZ
E>

DATACONV SYNC to SCLK hold 
time

Yes  
120n

sec

SCLK DACSER<SIZ
E>

DATACONV SCLK cycle time Yes  
200n

sec

SCSET DACSER<SIZ
E>

DATACONV SYNC to SCLK setup 
time

Yes  50n sec

SE CMLSCCM, 
CMSSCCM

SWIT_RAV External ramp slope Yes 1000
00

V/
sec

SEC_R 3phase ANL_MISC Secondary winding 
resistance

Yes 0.1 Ohm
s

SECOND
_NPAIR
S 

IPWL_RE_FO
REVER, 
VPWL_RE_N_
TIMES, 
VPWL_ENH, 
VPWL_RE_F
OREVER, 
IPWL_ENH, 
IPWL_RE_N_
TIMES

SOURCE Second line 
containing PWL data, 
(time, analog value) 
pairs. Lines will be 
concatenated.

No none pairs

SET R_VAR, 
C_VAR, POT

ANALOG, 
BREAKOUT

Position of slider 
between minimum 
and maximum value 
(linear interpolation)

Yes 0.5 none

SETUPT
IME 

SETUP<SIZE
>

DIG_MISC Setup time Yes none sec

SIG_ED
GE 

RELEASE<SI
ZE>

DIG_MISC Signal edge for 
constraint checking

Yes  LH none

SIGNAM
E 

FileStim<SIZE
>

SOURCE Signal name in file No none none

SIGNAM
ES 

VECTOR<SIZ
E>

SPECIAL Names of signals 
which appear in the 
header of the vector 
file

No node 
nam
es

none

SN CMSSCCM SWIT_RAV Current sense ramp 
slope

Check

Yes 1000
00

V/
sec
June 2020 311 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



PSpice Help
SPR Relay_SPDT_
phy

ANL_MISC Contact arm spring 
force

Yes 40 g_c
m/
sec^
2

SR DACPAR<SIZ
E>

DATACONV Slew rate of output Yes  
2.5M
eg

V/
sec

STARTV
AL 

DIGCLOCK SOURCE First digital value of 
clock

Yes 0 none

STOP HIPASS, 
LOPASS, 
BANDREJ, 
BANDPASS

ABM Stopband attenuation Yes  
50dB

none

T_BOUN
CE 

BOUNCE, 
Relay_DPDT_
b, 
Relay_SPDT_
b

ANL_MISC, 
MIX_MISC

Bounce time (after 
contact is closed)

Yes  5m sec

T_BREA
K 

BOUNCE, 
Relay_DPDT_
b, 
Relay_SPDT_
b, 
NO_BOUNCE, 
Relay_DPDT_
nb, 
Relay_SPDT_
nb

ANL_MISC, 
MIX_MISC

Time for contact to 
open when current is 
turned off/on

Yes  10m sec

T_MAKE BOUNCE, 
Relay_DPDT_
b, 
Relay_SPDT_
b, 
NO_BOUNCE, 
Relay_DPDT_
nb, 
Relay_SPDT_
nb

ANL_MISC, 
MIX_MISC

Time for contact to 
close when current is 
turned off/on

Yes  20m sec
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T1 VPWL, IPWL SOURCE Time for first PWL 
pair (should be 0)

Yes none sec

T1 Kcouple<SIZE
>

TLINE Reference designator 
of first coupled 
transmission line

Yes  T1 refde
s

T10 VPWL, IPWL SOURCE Time for tenth PWL 
pair 

Yes none sec

T2 VPWL, IPWL SOURCE Time for second PWL 
pair 

Yes none sec

T2 Kcouple<SIZE
>

TLINE Reference designator 
of second coupled 
transmission line

Yes  T2 refde
s

T3 VPWL, IPWL SOURCE Time for third PWL 
pair 

Yes none sec

T3 Kcouple<SIZE
>

TLINE Reference designator 
of third coupled 
transmission line

Yes  T3 refde
s

T4 VPWL, IPWL SOURCE Time for fourth PWL 
pair

Yes none sec

T4 Kcouple<SIZE
>

TLINE Reference designator 
of fourth coupled 
transmission line

Yes  T4 refde
s

T5 VPWL, IPWL SOURCE Time for fifth PWL 
pair 

Yes none sec

T5 Kcouple<SIZE
>

TLINE Reference designator 
of fifth coupled 
transmission line

Yes  T5 refde
s

T6 VPWL, IPWL SOURCE Time for sixth PWL 
pair 

Yes none sec

T7 VPWL, IPWL SOURCE Time for seventh PWL 
pair 

Yes none sec

T8 VPWL, IPWL SOURCE Time for eighth PWL 
pair 

Yes none sec

T9 VPWL, IPWL SOURCE Time for ninth PWL 
pair 

Yes none sec
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TABLE EFREQ, 
GFREQ

ABM Triplets (freq, mag, 
phase) for frequency 
table

Yes  
(0,0,
0) 
(1Me
g,-
10,9
0)

triple
ts

TABLE ETABLE, 
GTABLE

ABM Pairs (input, output) 
for nonlinear table

Yes (-
15,-
15) 
(15,1
5)

pairs

TAU ZbreakN BREAKOUT Ambipolar 
recombination lifetime

No 7.1e-
6

sec

TBUSY ADCMIC<SIZ
E>

DATACONV BUSYbar low time Yes  8u sec

TBUSYR
C 

ADCMIC<SIZ
E>

DATACONV TBUSYRC - BUSYbar 
Delay from R/Cbar 
low

Yes  83n sec

TC1 IEXP, VEXP SOURCE Rise (fall) time 
constant

No TST
EP

sec

TC2 IEXP, VEXP SOURCE Fall (rise) time 
constant

No TST
EP

sec

TCLOSE Sw_tClose ANL_MISC Time at which switch 
closes

Yes 0 sec

TD IPULSE, 
VPULSE

SOURCE Delay No 0 sec

TD T ANALOG Propagation delay No none sec

TD ISIN, VSIN SOURCE Delay No 0 sec

TD1 IEXP, VEXP SOURCE Rise (fall) delay No 0 sec

TD2 IEXP, VEXP SOURCE Fall (rise) delay No <td1
>+ 
TST
EP

sec

TF IPULSE, 
VPULSE

SOURCE Fall time No TST
EP

sec
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THDGMN DACPAR<SIZ
E>

DATACONV Data valid to Write 
hold time

Yes  10n sec

THIRD_
NPAIRS 

IPWL_RE_FO
REVER, 
VPWL_RE_N_
TIMES, 
VPWL_ENH, 
VPWL_RE_F
OREVER, 
IPWL_ENH, 
IPWL_RE_N_
TIMES

SOURCE Second line 
containing PWL data, 
(time, analog value) 
pairs. Lines will be 
concatenated.

No none pairs

TIMEST
EP 

STIM<SIZE> SOURCE Number of seconds 
per clock cycle, or 
step when using the 
"C" suffix

No 0 sec

TOL DELAY DIG_MISC Tolerance for delay in 
percent

Yes 10 %

TOLERA
NCE 

R, L, C ANALOG Tolerance (e.g. 5%) 
for monte carlo/worst 
case analysis

No none none

TOPEN Sw_tOpen ANL_MISC Time at which switch 
opens

Yes 0 sec

TORQUE
_CONST 

BLDCMTR MIX_MISC Torque constant Yes  300 g*cm 
/amp

TPADHM
N 

ADCPAR<SIZ
E>

DATACONV Minimum output delay 
high

Yes  10n sec

TPADHT
Y 

ADCPAR<SIZ
E>

DATACONV Typical output delay 
high

Yes  20n sec

TPADLM
N 

ADCPAR<SIZ
E>

DATACONV Minimum output delay 
low

Yes  10n sec

TPADLT
Y 

ADCPAR<SIZ
E>

DATACONV Typical output delay 
low

Yes  20n sec

TPHZMN ADCMIC<SIZ
E>

DATACONV Minimum bus 
relinquish time H-Z

Yes  10n sec

TPHZMX ADCMIC<SIZ
E>

DATACONV Maximum bus 
relinquish time H-Z

Yes  83n sec
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TPHZTY ADCMIC<SIZ
E>

DATACONV Typical bus relinquish 
time H-Z

Yes  35n sec

TPHZTY ADCPAR<SIZ
E>

DATACONV Typical output float 
delay H-Z

Yes  50n sec

TPLZMN ADCMIC<SIZ
E>

DATACONV Minimum bus 
relinquish time L-Z

Yes  10n sec

TPLZMX ADCMIC<SIZ
E>

DATACONV Maximum bus 
relinquish time L-Z

Yes  83n sec

TPLZTY ADCMIC<SIZ
E>

DATACONV Typical bus relinquish 
time L-Z

Yes  35n sec

TPLZTY ADCPAR<SIZ
E>

DATACONV Typical output float 
delay L-Z

Yes  50n sec

TPZHMN ADCMIC<SIZ
E>

DATACONV Minimum data access 
time Z-H

Yes  10n sec

TPZHMX ADCMIC<SIZ
E>

DATACONV Maximum data 
access time Z-H

Yes  83n sec

TPZHTY ADCMIC<SIZ
E>

DATACONV Typical data access 
time Z-H

Yes  35n sec

TPZHTY ADCPAR<SIZ
E>

DATACONV Typical data access 
time Z-H

Yes  50n sec

TPZLMN ADCMIC<SIZ
E>

DATACONV Minimum data access 
time Z-L

Yes  10n sec

TPZLMX ADCMIC<SIZ
E>

DATACONV Maximum data 
access time Z-L

Yes  83n sec

TPZLTY ADCMIC<SIZ
E>

DATACONV Typical data access 
time Z-L

Yes  35n sec

TPZLTY ADCPAR<SIZ
E>

DATACONV Typical data access 
time Z-L

Yes  50n sec

TR IPULSE, 
VPULSE

SOURCE Rise time No TST
EP

sec

TRAN ISRC, VSRC SOURCE Transient 
specification - EXP(), 
PULSE(), PWL(), 
SFFM() OR SIN()

No none none
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TRAN IPRINT, 
IPLOT, 
VPLOT1, 
VPLOT2, 
VPRINT1, 
VPRINT2

SPECIAL Write TRAN analysis 
results to output file 
(Y|N)

No Y none

TSC0 ADCSER<SIZ
E>

DATACONV  CONVST/EOC* to 
CLOCK Skew 
(typical)

Yes  40n sec

TSF IPWL_RE_FO
REVER, 
VPWL_F_RE_
FOREVER, 
VPWL_RE_N_
TIMES, 
IPWL_F_RE_
N_TIMES, 
IPWL_F_RE_
FOREVER, 
VPWL_ENH, 
VPWL_RE_F
OREVER, 
VPWL_FILE, 
IPWL_ENH, 
IPWL_RE_N_
TIMES, 
VPWL_F_RE_
N_TIMES

SOURCE Time scaling factor 
(multiplies time 
values)

No 1 none

TSUDGM
N 

DACPAR<SIZ
E>

DATACONV Data valid to Write 
setup time

Yes  90n sec

TTRAN Sw_tClose ANL_MISC Transition time for 
switch to close

Yes  1u sec

TTRAN Sw_tOpen ANL_MISC Transition time for 
switch to open

Yes  1u sec

TURNS Relay_SPDT_
phy

ANL_MISC Number of turns Yes 100 none

V_RATI
O 

3phase ANL_MISC 1
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V1 VPULSE, 
VEXP

SOURCE First voltage level Yes  
none

V

V2 VPULSE, 
VEXP

SOURCE Second voltage level Yes  
none

V

V1 VPWL SOURCE First PWL point (0s, 
current value)

Yes  
none

V

V2 VPWL SOURCE Second PWL point 
(time, current value)

No  
none

V

V3 VPWL SOURCE Third PWL point 
(time, current value)

No  
none

V

V4 VPWL SOURCE Fourth PWL point 
(time, current value)

No  
none

V

V5 VPWL SOURCE Fifth PWL point (time, 
current value)

No  
none

V

V6 VPWL SOURCE Sixth PWL point 
(time, current value)

No  
none

V

V7 VPWL SOURCE Seventh PWL point 
(time, current value)

No  
none

V

V8 VPWL SOURCE Eighth PWL point 
(time, current value)

No  
none

V

V9 VPWL SOURCE Ninth PWL point 
(time, current value)

No  
none

V

V10 VPWL SOURCE Tenth PWL point 
(time, current value)

No  
none

V

VALLEY
V 

VMLSCCM, 
VMLSDCM, 
VMCCMDCM

SWIT_RAV Valley voltage of 
external ramp

Yes 1 V

VALUE IC1, IC2 SPECIAL .IC value Yes 0 V

VALUE NODESET1, 
NODESET2

SPECIAL .NODESET value Yes 0 V

VALUE R, Rbreak ANALOG, 
BREAKOUT

Resistance Yes 1K Ohm
s

VALUE L, Lbreak ANALOG, 
BREAKOUT

Inductance Yes 1m H
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VALUE C, Cbreak ANALOG, 
BREAKOUT

Capacitance Yes 1n F

VAMPL VSIN SOURCE Voltage amplitude of 
sinusoid (transient 
analysis only)

Yes  
none

V

VAMPL VSFFM SOURCE Voltage amplitude of 
SFFM (transient 
analysis only)

Yes  
none

V

VAP VMSSCCM, 
CMSSCCM

SWIT_RAV Voltage across 
terminal A P

Yes 20 V

VCC1 ECL_10K_PW
R, 
ECL_100K_P
WR

SPECIAL First power supply 
voltage for ECL 
supply

Yes  0 V

VCC2 ECL_10K_PW
R, 
ECL_100K_P
WR

SPECIAL Second power supply 
voltage for ECL 
supply

Yes  0 V

VCOCOE
FF 

QRLSZCS SWIT_RAV Coefficient for voltage 
to frequency 
conversion

Yes  20k none

VEE ECL_100K_P
WR

SPECIAL VEE Yes  -4.5 V

VEE ECL_10K_PW
R

SPECIAL VEE Yes  -5.2 V

VNOM BULB OPTO Nominal operating 
voltage

Yes  120 V

VOFF VSIN, VSFFM SOURCE Offset voltage Yes none V

VOFF Sbreak BREAKOUT Voltage lower 
threshold

Yes 0 V

VOLTAG
E 

CD4000_PWR
, DIGIFPWR

SPECIAL Digital power supply 
voltage

Yes  5 V

VON Sbreak BREAKOUT Voltage upper 
threshold

Yes 1 V
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VSF IPWL_RE_FO
REVER, 
VPWL_F_RE_
FOREVER, 
VPWL_RE_N_
TIMES, 
IPWL_F_RE_
N_TIMES, 
IPWL_F_RE_
FOREVER, 
VPWL_ENH, 
VPWL_RE_F
OREVER, 
VPWL_FILE, 
IPWL_ENH, 
IPWL_RE_N_
TIMES, 
VPWL_F_RE_
N_TIMES

SOURCE Voltage scaling factor 
(multiplies voltages)

No 1 none

VSINK DACPAR<SIZ
E>

DATACONV Output sink voltage 
(@ISINK)

Yes -0.1 V

VSOURC
E 

DACPAR<SIZ
E>

DATACONV Output source voltage 
(@ISOURCE)

Yes 10 V

VTT ECL_10K_PW
R, 
ECL_100K_P
WR

SPECIAL VTT, termination 
voltage

Yes  -2 V

W MbreakN4, 
MbreakN, 
MbreakN3, 
MbreakP4, 
MbreakP, 
MbreakP3, 
Mbreak P4, 
MbreakN3

BREAKOUT Length No DEF
W

m

WB ZbreakN BREAKOUT Metallurgical base 
width

No 9.0e-
5

m
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WHEN RELEASE<SI
ZE>, 
HOLD<SIZE>, 
CONSTRAINT
<SIZE>, 
SETUP<SIZE
>, WIDTH_HI, 
WIDTH_LO, 
MINFREQ, 
MAXFREQ

DIG_MISC Used to define a 
boolean expression 
describing a condition 
for a constraint 
checker primitive

No none none

WIDTH WIDTH_HI DIG_MISC Minimum width high 
constraint

Yes none sec

WIDTH WIDTH_LO DIG_MISC Minimum width low 
constraint

Yes none sec

WIDTH STIM1 SOURCE Number of bits Yes 1 none

WIDTH STIM16 SOURCE Number of bits Yes 16 none

WIDTH STIM4 SOURCE Number of bits Yes 4 none

WIDTH STIM8 SOURCE Number of bits Yes 8 none

WIDTH_
MIN_HI 

ADCPAR<SIZ
E>

DATACONV Minimum width high Yes  45n sec

WIDTH_
MIN_LO 

ADCPAR<SIZ
E>

DATACONV Minimum width low Yes  45n sec

WRMINL
O 

DACPAR<SIZ
E>

DATACONV Minimum width low of 
WR

Yes  90n sec

XFORM ELAPLACE, 
GLAPLACE

ABM Laplace transform Yes  1/s none

Z0 T ANALOG Characteristic 
impedance

Yes none Ohm
s
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Menu Bar

Click each menu bar item to see its pull-down menu. 

Open button 

Click to open a data file.

Print button 

Click to print one copy of the current plot window. 

Cut button 

Click to cut the currently selected item. 

Copy button 

Click to copy the currently selected item.

Paste button 

Click to paste the currently copied or cut item.

Zoom buttons 

Click to zoom the displayed view in or out. 

View Area button 

Click to zoom in to the selected area. 

View Fit button 

Click to zoom out so that all the data is visible in the selected plot. 
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X Scale button 

Click to toggle the X axis between log and linear scaling. 

Fourier Transform button 

Click to display the Fourier Transform of all traces in the selected plot. 

Performance Analysis button 

Click to enter Performance Analysis.

Y Scale button 

Click to toggle the Y axis between log and linear scaling. 

Add Trace button 

Click to add a trace. 

Eval Measurement Function button 

Click to evaluate the measurement function or expression of measurement functions on data 
from one PSpice run. 

Text button 

Click to type text to place on the displayed plot. 

Display Cursor button 

Click to turn the data cursor on or off. 

Peak button 

Click to move the cursor to the next peak.
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Trough button 

Click to move the cursor to the next trough.

Slope button 

Click to move the cursor to the next point of maximum slope.

Min button 

Click to move the cursor to the minimum Y value.

Max button 

Click to move the cursor to the maximum Y value.

Point button 

Click to move the cursor to the next data point.

Search button 

Click to display the Search dialog box. 

Next Transition button 

Click to move the cursor to the next digital transition.

Previous Transition button 

Click to move the cursor to the previous digital transition.

Mark Data Points button 

Click to view data points on the plot. 
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X Axis Data Range

Click Auto Range to let Probe set the range, or click User Defined and type a specific data 
range to display. 

Processing Options

Click to select either Fourier Transform or Performance Analysis:

■ Fourier Transform displays a line graph.

■ Performance Analysis displays a histogram. 

Variable

Click to display the Axis Variable dialog box. 

Text Area

The definition of the measurement function is shown here. 

This Measurement Function is Saved in the File

The location of the measurement function on your system. 

Use Symbols 

Click to select when and how Probe uses symbols when displaying traces. 

Use Scroll Bars

Click to set scroll bar usage. 

Trace Color Scheme

Click to set how Probe uses color to display traces. 
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Highlight Error States

Select to enable automatic highlighting of error states when digital traces are displayed. 

Number of Histogram Divisions

Type the number of histogram divisions to be used when Probe displays a Performance 
Analysis result from a Monte Carlo simulation. 

Number of Cursor Digits

Type the number of digits Probe will display when the cursor position is shown. 

New Name

Type a name to save this display as. 

List

Click to select one of the available displays shown here. 

Save

Click to save the display with the assigned name. 

Save To

Click to save the display to a specific place. 

Copy To

Click to copy the selected display. 

Delete

Click to delete the selected display. 

You can only delete local displays using the Delete button. To delete a display from a remote 
or global .PRB file, click Delete From. 
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Delete From

Click to delete a display from a remote or global .PRB file. 

Restore

Click to use the selected display. 

Load

Click to load another file with displays. 

Close

Click to close the Save/Restore dialog box. 

Box

Type the search command in this box. 

Cursor To Move

Click to select the cursor to search. 

List

Click to select one of the available traces and measurement functions listed here. 

Analog

Click to select whether analog node names are listed. 

Digital

Click to select whether digital node names are listed. 
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Voltages

Click to select whether voltage node names are listed.

Currents

Click to select whether current node names are listed.

Alias Names

Click to select whether alias node names are listed.

Internal Subcircuit Nodes

Click to select whether Internal Subcircuit Nodes names are listed.

Measurement Functions

Click to select whether measurement functions are listed.

Trace Command

Type the command or expression to use with the selected trace or measurement function. 

Margins

Type the margins in inches in the text boxes. 

Plots Per Page

Click to select the number of plots to print on each page. 

Orientation

Click to select the orientation of the page. 
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Cursor Information

Click to select where the cursor information is printed. 

Draw Border

Click to select whether a border is used when the trace is printed. 

Draw Plot Title

Click to select whether the plot title is printed on the page. 

Header

Click to display the Header dialog box. 

Footer

Click to display the Footer dialog box. 

Printer Setup

Click to display the Printer Setup dialog box. 

Printer Select 

Click to display the Printer Select dialog box. 

Set Default

Click to set the current settings as the default settings. 

Reset Default

Click to reset the current settings to the default settings. 
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New Measurement Function Name

Type the name of the new measurement function. 

File to Keep Measurement Function In

Click to select the location of the saved measurement function. 

Box

Type the name of the window title. 

Definition

Type the name and definition of the macro. 

List

The available macros and the definitions are listed here. 

Save

Click to save the current macro and definition. 

Save To

Click to save the current macro and definition to a specific location on your system. 

Delete

Click to delete the current macro and definition.

You can only delete local macros using the Delete button. To delete a macro from a remote 
or global .PRB file, click Delete From.

Delete From

Click to delete a macro and definition from remote or global .PRB file.
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Load

Click to load another file with macros and definitions. 

Close

Click to close the Macros dialog box. 

Left Side

Type the text for the left side of the header. 

Center

Type the text for the center of the header.

Right Side

Type the text for the right side of the header.

OK

Click to use the current header definitions and close the Header dialog box. 

Cancel

Click to close the window and abandon your changes. 

Set Default

Click to set the current header settings as the default. 

Reset Default

Click to reset the header to the default settings. 
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Date Run button

Click to insert the date in the selected header area. 

Header Date & Time button

Click to insert the date and time in the selected header area. 

Header Time Run button

Click to insert the time the trace was run in the selected header area. 

Header Temperature button

Click to insert the temperature information in the selected header area. 

Left Side

Type the text for the left side of the footer. 

Center

Type the text for the center of the footer. 

Right Side

Type the text for the right side of the footer. 

OK

Click to use the current footer settings and close the Footer dialog box. 

Cancel

Click to close the window and abandon your changes. 
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Set Default

Click to set the current footer settings as the default. 

Reset Default

Click to reset the footer to the default settings. 

Date Run button

Click to insert the time the trace was run in the selected footer area. 

Date & Time button

Click to insert the date and time in the selected header area. 

Time Run button

Click to insert the time the trace was run in the selected header area. 

Temperature button

Click to insert the temperature information in the selected header area. 

List

The available measurement functions are listed. 

New

Click to create a new measurement function. 

Copy 

Click to copy a measurement function. 
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View

Click to view a measurement function definition. 

Edit

Click to edit an existing measurement function. 

Delete

Click to delete the selected measurement function. 

Eval

Click to evaluate the selected measurement function. 

Load

Click to load another file with measurement function definitions. 
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Page Setup dialog box
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Add Trace dialog box

Digital Size dialog box
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Ellipse dialog box
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X Axis tab
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Display Control dialog box

Open File button

Printer button

Zoom In button
June 2020 340 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



PSpice Help
Zoom Out button

Area button

Cursor button

Copy button

Fourier Transform button

Text button
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Paste button

Cut button

Fit button

Peak button

Trough button

Slope button
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Point button

Min button

Max button

Next Transition button

Previous Transition button

Add Trace button
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Probe Settings dialog box
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Y Axis tab
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Available Sections dialog box
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X Grid tab

Y Grid tab

{bmc BM101.SHG}
June 2020 347 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



PSpice Help
June 2020 348 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



PSpice Help
Voltage source

This sets the source’s voltage to the sweep value during the sweep.

In the Name text box, type a reference designator of an independent voltage source, such as 
VI. 

Current source

This sets the source’s current to the sweep value during the sweep.

In the Name text box, type the name of an independent current source. 

Global parameter

This sets the value to the sweep value and all expressions are re-evaluated.

In the Parameter name text box, type a global parameter name.

Model parameter

This sets the parameter in the model to the sweep value.

From the Model type list, select a model type. In the Model Name text box, type the model 
name. In the Parameter name text box, type a parameter name. 

Temperature

This sets the temperature to the sweep value. For each value in the sweep, the model 
parameters of all the circuit components are updated to that temperature.

Linear

Indicates a linear sweep. The swept variable is swept linearly from the starting to the ending 
value. The Increment value is the step size.

Octave

Indicates sweep by octaves. The sweep variable is swept logarithmically by octaves. 
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Decade

Indicates sweep by decades. The sweep variable is swept logarithmically by decades. 

Value list

Uses a list of values. In this case, there are no start and end values. Instead, the numbers 
you type in the Values List text box are the values that the sweep variable is set to.

YMAX

Finds the greatest difference in each waveform from the nominal run.

MAX 

Finds the maximum value of each waveform.

MIN 

Finds the minimum value of each waveform.

RISE_EDGE 

Finds the first occurrence of the waveform crossing above the threshold value. Type a 
threshold value in the Threshold value text box.

FALL_EDGE

Finds the first occurrence of the waveform crossing below the threshold value. Type a 
threshold value in the Threshold value text box.

Low 

Specifies the lower limit of the range over which the function is evaluated.

Hi 

Specifies the upper limit of the range over which the function is evaluated.
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None 

Forces the nominal run to produce output.

All

Forces all output to be generated, including the nominal run.

First 

Generates output only during the first n runs. Type the value for n in the Runs text box.

Every 

Generates output every nth run. Type the value for n in the Runs text box.

Runs 

Performs an analysis and generates output only for listed runs. Up to 25 values can be 
specified in the Runs text box. Prints out at the beginning of each run the model parameter 
values actually used for each component during that run.

Random number seed 

Defines the seed for the random number generator within the Monte Carlo analysis. You must 
type an odd integer ranging from 1 to 32767. If the seed value is not set, it defaults to 17533.

Output All 

Requests output from the sensitivity runs, after the first run. The sensitivity and worst case 
runs are done with variations on model parameters as specified by the DEV and LOT 
tolerances. The default is to vary by BOTH. 

Vary both DEV and LOT, Vary DEV, Vary LOT 

Vary DEV and Vary LOT limit the devices analyzed to only the device types that have a DEV 
tolerance or a LOT tolerance.

Vary both DEV and LOT includes all the device types in the analysis.
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Limit devices to type(s)

In the text box, type a list of the specific device types you want included in the analysis. The 
list is a string containing the initial letters of PSpice primitives.

Primary Sweep value

The first DC sweep value at which the bias point is to be saved. If there is only one sweep 
value, type a value in the Primary Sweep value text box. If there are two sweep variables, then 
Primary Sweep value specifies the first sweep value.

Secondary Sweep value

The second DC sweep value at which the bias point is to be saved. If there is only one sweep 
value, type a value in the Primary Sweep value text box. If there are two sweep variables, then 
Secondary Sweep value specifies the second sweep value.

Parametric Sweep value 

The step value at which the bias point is to be saved for parametric analyses.

Number of runs

The number of the Monte Carlo or worst case analyses run for which the bias point is to be 
saved.

Use distribution

This option is the default distribution for Monte Carlo deviations. 

From the list, select Uniform or Gaussian, or click the Distributions button to enter your own 
distribution.

Initialize flip-flops to X, 0, or 1

If set to X, all flip-flops and latches produce an X (unknown state) until explicitly set or cleared, 
or until a known state is clocked in.

If set to 0, all such devices are cleared.
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If set to 1, all such devices are preset.

default propagation delay mode

You can change the mode for an individual part in your design by changing the part’s 
MNTYMXDLY property. By default, this part value is set to 0, which tells PSpice to use the 
default value set in the Options tab.

Temperature Sweep temperature

Defines the temperature at which the bias point is to be saved for temperature analyses.

Include detailed bias point information for nonlinear controlled sources and 
semiconductors

This option saves the small-signal (linearized) parameters of all the nonlinear controlled 
sources and all the semiconductor devices to the output file.

This is equivalent to the .OP (bias point) PSpice circuit file command.

Perform Sensitivity analysis

In the Output Variable(s) text box, type 

This option is equivalent to the .SENS (DC sensitivity) PSpice circuit file command.

Calculate small-signal DC gain

This option calculates the small-signal DC gain by linearizing the circuit around the bias point.

In the From Input Source Name text box, type 

In the To Output Variable text box, type 

Enter this… To set this mode as the default

1 minimum

2 typical

3 maximum

4 worst-case (min/max)
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This option is equivalent to the .TF (small-signal DC transfer function) PSpice circuit file 
command.

Data collection parameters

Text Data File Format (CSDF)

Select the Save data in the CSDF format (.CSD) option to write Probe data in text format 
rather than binary format. This option is not available if the Run Probe During Simulation 
option is used. 

Choose this option… To do this…

All voltages, 
currents, and 
digital states

Save Probe data for all nodes and devices in the circuit. This is 
the default.

All but internal 
subcircuit data

Save data for all nodes and devices, except internal subcircuit 
nodes and devices.

At Markers only Save the Probe data at those nodes and devices where 
markers are placed.

None Disable Probe data collection. 
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Introduction to device equations

The purpose of the Device Equations option is to change the built-in model equations for one 
or more of the semiconductor devices (GaAsFET, Diode, Junction FET, MOSFET, Bipolar 
transistor, and IGBT). This means you can extend PSpice to support user-defined or 
proprietary native device models. 

This option is not an addition to PSpice: it is a different packaging of the program that includes 
the source code for the device model subroutines. You need a Device Equations license to 
modify and extend PSpice code, but you do not need a Device Equations license to use the 
modified code. 

There are several kinds of changes that can be made using the Device Equations option. 
These include, in ascending order of complexity:

■ Changing a parameter name 

■ Giving a parameter an alias 

■ Adding a parameter 

■ Changing the device equations 

■ Adding a new device 

■ Specifying new internal device structure 

You need a supported C++ compiler to compile Device Equations extensions; for Windows 
95/98 and NT, you need Microsoft Visual C++ 6.0 or later. 

Device Equations extensions are implemented using a dynamic-link library, which means you 
can share your models with other users by distributing just a DLL. 

If you want to run PSpice on Windows 95 or NT with a Device Equations DLL developed by 
someone else, then you do not need a compiler or a Device Equations license. Just copy the 
DLL into the directory with your PSpice program file. For more information, see Simulating 
with the device equations option<link>.

Making device model changes

To get started, look at the files M.H and MOS.CPP, which implement the MOSFET equations. 
The other devices have similar structures.

M.H contains two important class definitions: 

■ the class for the MOS transistor (class M_Device) 
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■ the class for the MOS model (class M_Model) 

During read-in, the simulator creates an instance of the transistor class for every MOSFET in 
the circuit and an instance of the model class for every .MODEL statement of type NMOS or 
PMOS. The transistor instance is set up using information particular to that transistor, such 
as the nodes to which it is connected, its length and width, and the locations of its entries in 
the circuit’s conductance matrix. All parameters of the model object are set up using the 
values from the .MODEL statement, if one exists; otherwise, the default values are used.

The transistor object corresponds to the LOC, LOCV, and LX tables in U.C. Berkeley SPICE2. 
The model object corresponds to the LOC and LOCM tables in SPICE. 

Note: Do not change the transistor object (class M_Device), except when changing the 
internal device topology. It is included only to allow compiling of MOS.CPP.

The simulator needs to associate each entry in the model class with a model parameter name 
(and default value) in the .MODEL statement. You can accomplish this by using the 
ASSOCIATE macro. Just below the device class in M.H there is a list of all the parameters, 
each in an ASSOCIATE macro. The occurrence of ASSOCIATE binds together the class 
entry, the parameter name, and the default value. The read-in section of the simulator uses 
this information to parse the .MODEL statement.

For more details on how to change parameters, click the following:

Changing a parameter name

Giving a parameter an alias

Adding a parameter

Changing a parameter name

This is the easiest change. Find the parameter in the list of ASSOCIATE macros. Change the 
parameter’s name (last item on the line) and/or the default value (middle item). The names 
and defaults of the model parameters that are supplied can be changed, as well as those 
parameters that are added.

When the simulator runs, it prints the parameter values for each .MODEL statement unless 
the NOMOD option is used in the .OPTIONS statement. Normally only parameters which 
have not been defaulted are listed. A parameter can be forced to be listed, whether or not it 
has been defaulted, by preceding its name using an asterisk (*). For example, VTO is listed 
that way in M.H.
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Giving a parameter an alias

Sometimes a parameter requires an alternate name (an alias). Several bipolar model 
parameters, such as ISE, already have alternate names. The alias for ISE is C2. Look in Q.H 
at the occurrences of the parameters ISE and C2 in the ASSOCIATE macros for an example 
of how this is accomplished. There is only one entry in the model class (Q_ise) for the 
parameter, but there are two ASSOCIATE entries. This means that either name (ISE or C2) 
on the .MODEL statement can put a number into the class entry Q_ise.

Note: When model parameters are listed, the first name found in the ASSOCIATE list 
(searching downward) is the name which is echoed on the output. 

Insert the new name first if it is the name to be printed.

Adding a parameter

Adding a parameter is probably the most common case. The parameter must be added to 
both the model class (e.g., class M_Model) and the corresponding ASSOCIATE list. It is 
recommended to follow the PSpice naming convention (e.g., M_wd and M_vto), but it is not 
required.

Model parameters are set forth as pairs of elements instead of simple floating point values. 
This is to provide the use of expressions for model parameters. Because of this, when adding 
a parameter (for example, M_new), the following line is required:

MXPR( M_new, Mx_new );

instead of

float M_new;

Note: Do not modify the value of the Mx_new class element. 

The read-in mechanism can handle expressions for user-added parameters. By the time the 
model code is called, the expressions have been evaluated and their value placed in the 
appropriate fields. See the include file m.h for further examples and comments.

When the simulator is doing a read-in, model parameters are listed for each .MODEL 
statement (unless NOMOD has been specified on the .OPTIONS statement). Normally, only 
those parameters that have not been defaulted are listed. A parameter can be forced to be 
listed, even if it has been defaulted, by preceding its name using an asterisk (*) in the 
ASSOCIATE macro. For instance, VTO in M.H is listed in that manner.

The default value, OMITTED, is used by the simulator to force the calculation of a parameter’s 
value during read-in. For instance, VTO is calculated from other values if it is not given a 
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value. These calculations are built into the read-in and are fixed. Cadence recommends that 
parameters that you add be given a normal default value and not be computed by using 
OMITTED.

Once the parameter has been added, the model class becomes one parameter longer, and 
the read-in section of PSpice places a value in its entry. The parameter can now be used in 
the device code (e.g., MOS.CPP).

Changing the device equations

The device equations are in the file that has the same name as the type of device 
(DIODE.CPP, BJT.CPP, JFET.CPP, MOS.CPP, GASFET.CPP). The files D.CPP, Q.CPP, 
J.CPP, M.CPP, and B.CPP contain auxiliary functions that implement the AC equations, 
matrix setup, temperature updating, etc.The code in these subroutines use the model 
parameters and the device’s terminal voltages to calculate the branch currents and 
conductances, and, during transient analysis, the terminal charges and branch capacitances. 
These equations are neither simple nor easy. A good understanding of U.C. Berkeley’s 
SPICE2G is recommended before making such a change. Two useful references are:

1. Nagel, L.W., “SPICE2: A Computer Program to Simulate Semiconductor Circuits”, 
Memorandum No. M520, May 1975.

2. Cohen, Ellis, “Program Reference for SPICE2”, Memorandum No. M592, June 1976.

which are available from:

Software Distribution Office

EECS/ERL Industrial Liaison Program

205 Cory Hall #1770

University of California

Berkeley, CA 94720-1770

(510) 643-6687

For more details about device source files, see Functional subsections of the device source 
file.
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Functional subsections of the device source file

The code in each of the device source files is arranged into separate functional subsections. 
Each subsection occurs at least once, but can occur several times for devices that have more 
than one level. The subsections required are outlined below.

Subsection Description

Initialization This consists of locating and binding the device instance and its 
model, initializing any local variables, and obtaining appropriate 
values for the device branch voltages. The branch voltages 
(e.g., vds, vgs) are set differently depending upon whether 
there are user-specified initial conditions (using IC= or .IC), and 
on whether the present Newton Raphson cycle has finished or 
not.

Computing new 
nonlinear branch 
voltage:

This is needed to monitor progress towards a Newton Raphson 
solution.

Test if the 
solution has 
changed:

If there is not significant change bypass the rest of the 
computation. Otherwise, continue.

Limit any nonlinear 
branch voltages:

This code uses the macro PNJLIM() to insure that the branch 
voltages are in the appropriate operating region.

Compute currents 
and conductances:

This is the meat of the Device Equations code, and involves 
obtaining all the branch currents (e.g., ibs, ibd) as well as all the 
derivatives to be used in the conductance matrix.

Charge 
calculations:

Internal charges are calculated and updated.

Check convergence: Check to see if the nonlinear device branches now have values 
that are within a small tolerance range of those obtained in the 
last repeat cycle, and set a return flag to signal whether the 
device converged.

Load the current 
vector and 
conductance matrix:

The macro Y_MATRIX () is used to obtain handles to the proper 
matrix elements, and the elements are assigned their values 
based on the present evaluation of the device equations and 
derivatives.
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SPICE2G is written in FORTRAN, whereas PSpice is in C/C++. For the device subroutines, 
as much correspondence as possible has been maintained between the two. Because of 
FORTRAN, SPICE kept integer and real numbers in different tables: NODPLC (indexed by 
LOC) and VALUE (indexed by LOCV or LOCM). In PSpice, these have been combined into 
one object (e.g., class M_Device).

The state vector information is constructed somewhat differently, though the overall pattern is 
similar. In SPICE the state vector information is kept in a set of vectors in VALUE. There is 
one vector for each time point “remembered” (from 4 to 7, depending on the order of the 
integration method). Each device’s LOC table contains an offset, LX, to its portion of the 
information in each state vector. In PSpice the number of state vectors is fixed, and each 
device’s state information is kept in its own device object (e.g., class M_Device). 

For example, for MOSFETs the state vectors are an array, struct msv_def m_sv[MSTVCT] in 
class M_Device. MSTVCT is the number of state vectors and is defined in TRAN.H to be 
equal to 4. The definition of msv_def (also in M.H) lists the various currents, conductances, 
charges, and capacitances that are in the state vector. Finally, M.H contains a set of #defines, 
which allows accessing of the entries to the state vectors by name. It is these (uppercase) 
names which are then used in MOS.CPP. This may seem like a roundabout way of 
constructing the state vector information, but the actual usage (in MOS.CPP) is quite 
straightforward and is similar to that in SPICE.

Adding a new device

The Device Equations option does not allow the addition of an entirely new device. However, 
in many cases the same thing can be achieved by making use of an existing device.

Suppose, for example, that a lightning arrester device is to be added. The lightning arrester 
has two terminals, therefore it can be built into the diode equations, because the diode also 
has two terminals. This means that in the circuit (.CIR) file the lightning arresters would use 
the letter D to start and would refer to a .MODEL statement of the type D.

At first glance it appears that this would preclude using diodes in circuits, since they have 
been replaced by lightning arresters. This problem is avoided by keeping all the diode model 
parameters, adding the lightning arrester parameters, adding a LEVEL parameter, and giving 
the LEVEL parameter a default of 1. In the diode subroutine (in DIODE.CPP), a large if test 
would select all the old diode code if LEVEL=1 and all the new lightning arrester code 
otherwise. The new LEVEL parameter would switch between diode and lightning arrester.

This approach can be extended to as many devices as wanted. This could be:

■ LEVEL=1 as a diode

■ LEVEL=2 as a lightning arrester
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■ LEVEL=3 as a gas discharge tube

And so on. The restriction is that all of the devices added to the diode must have two 
terminals. If the device to be added has three terminals, it must be built into a three terminal 
device, such as the JFET. The highest number of terminals that can be modeled is four, using 
the MOSFET. There is not a good way to add devices, such as pentodes, that have five or 
more terminals.

Specifying new internal device structure

You may want to change the topology of a device in order to accommodate a more elaborate 
set of parasitic resistances and/or capacitances. To do this requires that positions in the 
conductance matrix be assigned to include the terms that the additional equations generate. 
This requires five steps:

1. Ensuring that all of the new internal nodes and matrix conductance terms are added to 
the device class in the device header file

2. Allocating the new matrix elements

3. Providing handles to access the new matrix elements and to bind the nodes to the 
branches

4. Including logic, if needed, to support device model parameter checking and updating

5. Adding the new device equations to the device code

Example

This process can be illustrated by looking at the PSpice JFET and GaAsFET devices, as 
shown in the procedure below. The topologies of these two devices are nearly identical, 
except that the GaAsFET has an additional internal capacitance, CDS, between the source 
and drain, and an additional internal resistance, RG, at the gate. This gives the GaAsFET 
topology one additional node where RG joins the rest of the structure and two additional 
internal branches.
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Procedure

Step one: editing the device header file

These differences are reflected in the device class definitions in J.H and B.H. Each of the 
device nodes is given a name and declared to be of type CKT_IDX. 

The JFET device class, J_Device, lists the two internal nodes j_d and j_s, while the GaAsFET 
device class, B_Device, has three internal nodes b_d, b_s, and a new one, b_g. The two 
additional branches in the GaAsFET require three new matrix conductance terms. 

The conductance terms are declared type MTX_IDX and are listed immediately following the 
internal nodes. 

The JFET has a term j_GG, which appears on the matrix diagonal for the external gate node. 

The GaAsFET has an additional gate node which requires one additional matrix diagonal 
conductance term, b_gg, along with two off-diagonal conductance terms, b_Gg and b_gG. 
These are used by the source code in GASFET.CPP to designate where the conductance 
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terms associated with RG go when the matrix is loaded. CDS doesn’t need any additional 
nodes or matrix terms because the items required are already in place to accommodate the 
parallel current source, id.

With the nodes and conductance terms taken care of in the device header file, the first step 
is completed. 

Step two: setting up memory allocation for the new matrix elements

You can set up memory allocation to properly incorporate the new equations into the 
conductance matrix by modifying J.CPP. In this file is the function J_Device::MatPtr(), while 
B.CPP contains B_Device::MatPtr(). These functions call the function Reserve() once for 
each conductance matrix term that was declared in the header file. For instance, when b_gg, 
b_Gg, and b_gG are added for the GaAsFET, these require corresponding code in 
B_Device::MatPtr() as follows:

flag &= Reserve (ng,ng);

flag &= Reserve (nG,ng);

flag &= Reserve (ng,nG);

The arguments ng and nG are local variables that serve as aliases for the respective device 
nodes, b_g and b_G, and are assigned at the beginning of B_Device::MatPtr() as follows:

ng = bloc -> b_g;

nG = bloc -> b_G;

Step three: binding the nodes and branches

The mechanics of step three, binding the nodes and branches, are very similar to the 
mechanics of step two. The functions of interest are J_Device::MatLoc() and 
B_Device::MatLoc(), and they now call Indxcl() instead of Reserve(). The GaAsFET again 
has three more lines of code:

flag &= Indxcl (&(bloc->b_gg),ng,ng);

flag &= Indxcl (&(bloc->b_Gg),nG,ng);

flag &= Indxcl (&(bloc->b_gG),ng,nG);
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Step four: handling model parameters

Step four, handling model parameters, is basically the same as it would be for a case not 
involving topology changes, with one significant exception: this requires handling the case 
where the parasitics associated with an internal node can be zero. In this case the node must 
be generated conditionally. An instance of this is the GaAsFET internal resistance RG. If RG 
is zero, the parasitic resistance between the internal node b_g and the external node b_G can 
be removed from the circuit. This is accomplished in the function 
B_Device::AddInternalNodes() in B.CPP, using the following line of code:

INTERNAL_NODE(P->B_rg,b_g,b_G);

INTERNAL_NODE() is a macro that performs the required logic, depending on whether the 
model parameter B_rg is zero or not. The other two calls to this macro in 
B_Device::AddInternalNodes() correspond to the RD and RS resistances that also exist for 
the JFET.

Step five: implementing the new device equations

The final step does not involve any further topological considerations and is carried out just 
as it would be if the device internal topology weren’t being changed.

Recompiling and linking the device equations option

The source files needed to create the Device Equations DLL can be copied from the CD to 
any directory you choose, though it is recommended that you create a new empty directory. 
The MSVC++ project files, DEVEQ.DSP and DEVEQ.MAK, are included to compile and link 
the DLL.

For information on obtaining the Microsoft compiler, contact Microsoft Corporation directly.

To create a new deveq.dll:

1. Load DEVEQ.DSP into the Visual C++ development environment. 

2. From the Build menu, select Build Deveq.dll. 

3. The project supports debug and release versions of the build target.

4. After DEVEQ.DLL is built, copy it to the directory that contains PSpice.EXE.

For details on how to personalize your DEVEQ.DLL file, click Personalizing your DLL.
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Personalizing your DLL

The function DLLMain() in DEVEQDLL.CPP contains the following line of code:

DEVEQVERSIONINFO(“Device Equations“,VERSIONNUM);

To personalize your DLL, change the first argument to a string which identifies you as the 
author of the DLL, as in:

DEVEQVERSIONINFO(“(c)Copyright 1998\nMyCorp\n123 MyAddress\nMyCity, ST 12345” 
,”9.0.1”);

You can leave the VERSIONNUM argument alone, in which case it will match the version 
number of your PSpice release, or you can substitute your own version numbers. It is useful 
to be able to relate the DLL to the PSpice release it was built from, so you should use 
VERSIONNUM unless there is a compelling need to change it.

Simulating with the device equations option

After you obtain a working Device Equations DLL, place it in the directory that contains 
PSpice.EXE. 

PSpice will locate and load DEVEQ.DLL when you start the program, provided the .INI file 
entry is specified correctly. For instructions on modifying the .INI file, click Selecting which 
models to use from a Device Equations DLL.

The code in the DLL will be substituted for the device model code that ships with the plain 
version of PSpice. The presence of the DLL is also noted in the Devices tab of the PSpice 
Simulation Status Window and in the .OUT file. 

If PSpice doesn’t find the DLL, it runs as the normally configured PSpice.

Selecting which models to use from a Device Equations DLL

You can tell PSpice which device models to use from a custom DLL by adding an entry to the 
pspice.ini configuration file; for any device type you do not specify, PSpice uses the normally 
configured PSpice models.

To specify which models to use from a custom DLL:

1. In a standard text editor (such as Notepad), open pspice.ini, located in your Windows 
directory.
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2. Find the [PSpice ] section and add this line to the section:

USE_DEVEQ_MODELS="<device letters>"

where <device letters> is any or all of the following:

For example, to use all of the possible device models from your custom DLL, type the 
following:

USE_DEVEQ_MODELS="BDJMQ"

3. Save pspice.ini.

4. Start PSpice and run a simulation.

For this device 
type...

Use this device letter...

GaAsFET B

Diode D

Junction FET J

MOSFET M

Bipolar transistor Q
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Popup Menu Items

Y axis number

Click to select a number from the list or type a number. 

Attributes 

Draws symbols on the traces if the Show symbols check box is enabled in the Properties 
dialog box. To access the Properties dialog box, right-click the trace and choose Properties.

Never 

Never use symbols. 

Always 

Always display trace symbols. 

Normal 

Use a different color for each trace (number of different colors permitting). 

Match Axis 

Use the same color for all the traces that belong to the same Y axis. 

Sequential Per Axis 

Use the available colors in sequence for each Y axis.

Unique by File

Use the same color for all the traces that belong to the same file. (This applies to analog 
traces only—digital traces have their own color differentiation scheme.)
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Auto

Use scroll bars when an axis is zoomed in. 

Never

Never use scroll bars. 

Always

Always use scroll bars. 

 

Auto

Allow Probe to update traces each time it gets new data from the simulation. 

 

Every sec

Update traces at regular time intervals. Time intervals can be specified in seconds.

 

Every %

Update based on the percentage of completion of the analysis. Type the value as the 
percentage of completion.

 

Auto-Update Interval

Select how often Probe updates a displayed trace. 
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Display Status Line

Click to select whether Probe shows the status line at the bottom of the screen. 

 

Mark Data Points

Click to select whether data points are automatically marked on the trace. 

 

Display Evaluation

Click to select whether Probe displays the traces and marked points when you choose 
Evaluate Measurement from the Trace menu. 

 

Display Statistics

Click to select to enable automatic display of statistics about each histogram. 

 

Highlight Error States

Click to select whether Probe automatically highlights error states when it displays a trace. 

 

Display Toolbar

Click to select whether Probe automatically displays the toolbar at the top of the window. 

 

Data Range

Click Auto Range to let Probe set the range automatically, or click User Defined and type a 
specific data range to display. 
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Scale

Click to select either Linear or Log.

 

linear

Linear is the default for all analyses, except for AC analysis, which is logarithmic.

 

logarithmic

For AC analysis, the X axis starts out as logarithmic. You cannot put the axis into a log scale 
if either end of the axis range is zero or negative.

 

Use Data

Click Full to make the entire range of raw data available, or click Restricted and type a specific 
range of raw data to use. 

 

Processing Options

Click to select either Fourier Transform or Performance Analysis.

■ Fourier Transform changes an AC analysis X axis from Frequency to Time, or a Transient 
X axis from Time to Frequency. 

■ Performance Analysis displays a histogram for Monte Carlo Analysis, or displays a line 
graph of the measurement Evaluation value versus the parameter that changes between 
multiple PSpice runs. 
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Axis Variable

Click to see the Axis Variable dialog box. This looks and functions much like the Add Traces 
dialog box. It allows you to define a particular variable, or set of variables, specific to the X 
axis.

 

Number

Click to select the Y axis number from the list or type a number. You can have 1 to 3 axes. 

 

Title

Type a title in the box. This text is shown vertically, to the left of the plot. 

 

Display statistics

The statistics that are displayed are as follows:

n samples The number of Monte Carlo runs selected for analysis in Probe.

n divisions The number of divisions that the X axis is divided into to create 
the histogram (i.e., the number of vertical bars that make up the 
histogram).

mean The arithmetic average of all the measurement expression 
values.

sigma The standard deviation

minimum The minimum measurement expression value.
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Percentage of Plot to be Digital

Specify the percentage of the plot that should be allocated for the digital traces. Select a valid 
displayed range. The default is 33 percent.

 

Length of Digital Trace Name

Specify the length of the digital signal’s display name.

 

OK

Click to accept the values in the dialog box and close the dialog box. 

 

Cancel

Click to close the dialog box without saving any changes. 

 

10th percentile A number representing measurement expression values such 
that 10% of the measurement expression values are less than 
or equal to the number, and also at least 90% of the 
measurement expression values are greater than or equal to 
the number. If there is more than one measurement expression 
value that satisfies this criteria, then the 10th percentile is the 
midpoint of the interval between the measurement expression 
values that satisfy the criteria.

median Same as 10th percentile, except for 50%.

90th percentile Same as 10th percentile, except for 90%.

maximum The maximum measurement expression value.
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Help

Click to see the help system. 

 

Close

Click to close the dialog box. 

 

Reset

Click to set the options to the default configuration. 

 

Print

Click to print one page using the current settings. 

 

Enter the Inclination Angle

Type the angle at which you want to place the ellipse. 

 

Toolbar

Click to perform a common function in Probe. 

 

Display

The traces and plots are shown here. 
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Message Bar

Messages appear here about what you are currently doing. 

 

Legend

Double-click the trace name to display the Modify Traces dialog box.

Double-click the symbol (or one of the symbols) to the left of a trace name to view information 
about the trace.

 

Move to the next transition

Shift+Control+N

 

Add a Y axis

Control+Y

 

Move to the next trough

Shift+Control+T

 

Copy the selected item

Control+C
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Move to the previous transition

Shift+Control+R

 

Cut the selected item

Control+X

 

Open a file

Control+F12

 

Delete the selected item

Delete

 

Paste the cut or copied item

Control+V

 

Delete a Y axis

Shift+Control+Y

 

Open the Print dialog box

Control+Shift+F12
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Exit Probe 

Alt+F4

 

Redraw the screen

Control+L

 

Go back to the previous view

Control+P

 

Search command

Shift+Control+S

 

Move to the next maximum value

Shift+Control+X

 

Turn the data cursor on or off

Shift+Control+C

 

Move to the next minimum value

Shift+Control+M

 

June 2020 376 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



PSpice Help
Zoom in to the selected area

Control+A

 

Move to the next peak

Shift+Control+P

 

Zoom out so that all data on the screen is shown

Control+N

 

Move to the next point

Control+Shift+I

 

Zoom in around a specified point

Control+I

 

Zoom out around a specified point

Control+O

 

Delete all traces in the selected plot

Control+Delete
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Undelete last deleted

Control+U

 

Move to the next slope

Shift+Control+L

 

Freeze the cursor

Shift+Control+F

 

expression

An expression is a single output variable or combination of output variables using arithmetic 
operators, Probe functions, or macros. 

 

alias

Node or device pin names that represent the same point in a circuit. 

Major

The Major frame allows you to customize the display of the major grid axes. 

■ Spacing

Choose Linear to define the linear spacing of the grids.

Choose Log (# of decades) to set the decade interval for a logarithmic grid display.

Note: The Spacing settings can only be defined if the Automatic check box is disabled.
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■ Grids

You can display the grids as either Lines, Dots (At intersections), + (At intersections) or None. 
If you choose Dots or + (At intersections), you can display these either with other major grids, 
with other minor grids, with both or with none.

■ Ticks inside plot edge

When this option is enabled, tick marks are displayed at each major axis. Normally these are 
not visible when the grids are displayed as Lines.

■ Numbers outside plot edge

When this option is enabled (default), the unit labels are displayed for each major axis.

Minor

The Minor frame allows you to customize the display of the minor grid axes. 

■ Intervals between Major

You can define the intervals for the minor axes as either 2, 4, 5 or 10 between each major axis.

Note: The Intervals between Major settings can only be defined if the Automatic check box 
is disabled.

■ Grids

You can display the grids as either Lines, Dots (At intersections), + (At intersections) or None. 
If you choose Dots or + (At intersections), you can display these either with other major grids, 
with other minor grids, with both or with none.

■ Ticks inside plot edge

When this option is enabled, tick marks are displayed at each major axis. Normally these are 
not visible when the grids are displayed as Lines.
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Axis Title

Allows users to specify a name for the X-axis. Select the Use this title check box. In the text 
box that gets enabled, enter the new title for the X-Axis.

 

Axis Position

Use this option to specify whether the Y-axis should be located to the left or to the right if the 
Probe window. This option is useful only in case of multiple Y-axis. In case you have only one 
Y-axis, it needs to be on the left of the Probe window.
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PSpice Errors and Solutions

.PROBE and .ALIAS must agree on /CSDF

Either a .PROBE/CSDF and .ALIAS or a .PROBE and .ALIAS/CSDF were entered.

Solution

1. Correct the conflict by specifying /CSDF on both or neither statement.

Invalid device type

The first character of all devices defines what kind of device it is. The first character is not 
known to be a valid device.

Solution

1. Correct the spelling of the name.

Maximum number of alias nodes exceeded

Too many nodes have alias names associated with them.

Solution

1. Eliminate the aliases for some nodes.

Unable to open index file

The index file could not be created. Either it is open by another program or the system-wide 
limit on the number of files which can be concurrently open has been exceeded.

Solution

1. If another program has the file open, close that program. 

Model type unknown

In a .MODEL statement the model type was probably mistyped.

Solution
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1. Make sure that the model type is valid. The valid model types for each device are listed 
in the Reference Manual section dealing with the device.

Duplicate library entry for <modelname>

The identified model appears in more than one library. Only the first one will be used.

Solution

1. Remove the definition from all the other libraries, or change their names to make them 
unique.

Out of Memory

Insufficient memory for circuit.

Solution

1. Allocate PSpice more memory: 

❑ If you are running other programs concurrently with PSpice, close them and try 
again. 

❑ Install more memory for your computer.

 

Unrecognizable command

The first character on a line was a period (.), indicating a command, but the subsequent 
characters did not define a valid command.

Solution

1. Correct the spelling of the command.

 

Unable to open stimulus file

The identified file was listed in a STIMULUS device, but could not be found.

Solution
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1. Correct the spelling of the file name.

 

Model references form circular list. For example:

A model with an AKO: references another model with an AKO: which in turn references the 
first.

Solution

1. Break the loop of AKO: references.

 

Unable to open probe file

The Probe Data file could not be created. Either it is open by another program or the system-
wide limit on the number of files which can be concurrently open has been exceeded.

Solution

1. If another program has the file open, close that program. 

 

Unable to make index for library file

An index file had to be created for a library file. However, the system did not permit it.

Solution

1. An index file will reside in the same directory as the library file. Make sure that you have 
permission to write to that directory. 

2. If the index file already exists, make sure that you have permission to modify it.
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Model <modelname> referenced by model <modelname>, is undefined

There was an AKO: reference (.MODEL first_name ... AKO: second_name ...) The second 
model is not defined in either the circuit file or any of the referenced libraries.

Solution

1. Check for correct spelling of the second model name. 

2. If necessary, add the name of the library in which it can be found.

 

Subcircuit <filename> used by <filename> is undefined

The identified subcircuit is not defined in either the circuit file or any of the referenced libraries.

Solution

1. Check for correct spelling of the model name. 

2. If necessary, add the name of the library in which it can be found.

 

Unable to open library

The specified library could not be found.

Solution

1. Check the spelling of the file name.

 

Making new index file for library file 

The index file associated with the indicated library file is being rebuilt.

This is for your information only, and is not an error. The index file is being rebuilt because it 
either did not exist or the library file was changed.
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Missing model name in library

During the process of building the index file for a library file, a .MODEL statement was 
encountered which did not have a model name.

Solution

1. Correct the .MODEL statement, using the following basic syntax:

.MODEL <name> <type> <optional parameters>

 

Missing model type in library

During the process of building the index file for a library file, a .MODEL statement was 
encountered which did not have a model type.

Solution

1. Correct the .MODEL statement, using the following basic syntax:

 .MODEL <name> <type> <optional parameters>

 

Missing subcircuit name

During the process of building the index file for a library file, a .SUBCKT statement was 
encountered which did not have a name.

Solution

1. Correct the .SUBCKT statement, using the following basic syntax:

 .SUBCKT <name> [<nodes> ...]

 

|VON - VOFF| too small for VSWITCH model

The ON and OFF voltages specified are too close in value to each other.

Solution
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1. Change value to be more reasonable.

 

RON or ROFF less than or equal to zero for VSWITCH model

Either the ON resistance or OFF resistance is not positive.

Solution

1. All resistances must be positive. Fix the incorrect value.

 

RON or ROFF greater than 1/GMIN for VSWITCH model

Either the ON resistance or OFF resistance is too large.

Solution

1. All resistances must be less that 1/GMIN. Fix the incorrect value.

 

RON = ROFF for VSWITCH model

The ON resistance is the same as the OFF resistance.

Solution

1. They must be different to be a meaningful device. Change one of them.

 

ION - IOFF| too small for ISWITCH model

The ON and OFF currents specified are too close in value to each other.

Solution

1. Change either to be more reasonable.
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RON or ROFF less than or equal to zero for ISWITCH model

Either the ON resistance or OFF resistance is not positive.

Solution

1. All resistances must be positive. Fix the incorrect value.

 

RON or ROFF greater than 1/GMIN for ISWITCH model

Either the ON resistance or OFF resistance is too large.

Solution

1. All resistances must be less that 1/GMIN. Fix the incorrect value.

 

RON = ROFF for ISWITCH model

The ON resistance is the same as the OFF resistance.

Solution

1. Change one of them. They must be different to be a meaningful device. 

 

<param> not a subcircuit param

One of the optional parameters listed in the PARAMS: section of a subcircuit call is not 
defined.

Solution

1. Correct the spelling to match those defined by the subcircuit.
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Less than 2 connections at node

This node connects to only one device terminal in the circuit or in a subcircuit model. A port 
may be mislabeled.

Solution

1. Starting with the node indicated in the message, verify the circuit connections.

 

Node is floating

The voltage of this node cannot be determined. The node or the circuitry containing it may be 
isolated from power supplies or ground by capacitors, or the node’s connections to power 
supplies or ground is missing.

Solution

1. Starting with the node indicated in the message, verify the circuit connections.

 

Invalid radix, expecting BIN (1), OCT (3), or HEX (4)

In a .VECTOR command, the optional RADIX parameter was entered, but its value was not 
1, 3, 4, B, O, or H.

Solution

1. Correct the RADIX value.

 

Unrecognized parameter

In a .VECTOR command, a parameter was entered which was not valid.

Solution

1. Correct the statement.
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Tolerances on model <modelname> ignored due to <tolerance>

A model which is the target of a .STEP PARAM or .DC PARAM had tolerances. This is a 
warning only.

The tolerances are ignored.

 

MC or .WCASE ignored (No <analysis type> command in circuit)

A .MC command was encountered specifying an analysis which was missing.

Solution

1. Add a .DC, .TRAN, or .AC command as appropriate.

 

No models had tolerances. .MC or .WCASE ignored

A .MC command was encountered, but none of the models had tolerances specified.

Solution

1. Either add tolerances to one or more models, or remove the .MC command.

 

The circuit matrix is singular and cannot be solved.

The matrix is singular (has a 0.0 value along the diagonal.)

Solution

1. Check for the following frequent causes:

❑ floating nodes

❑ a closed path through the circuit which has zero resistance
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The circuit matrix is too close to being singular to solve.

The matrix is nearly singular (has value almost 0.0 along the diagonal.)

Solution

1. Check for the following frequent causes:

❑ a path to ground which is very high impedance

❑ a path with a very large gain

 

Convergence problem

PSpice could not derive values for the node voltages or device currents that satisfy the 
convergence criteria used.

Solution

1. Check circuit connections, device model parameters used, expected operating regions 
of the devices, etc.

2. Set initial conditions, relax the tolerance parameters, use GMIN stepping (for DC 
convergence problems), etc.

 

Convergence problem

PSpice could not derive values for the node voltages or device currents that satisfy the 
convergence criteria used.

Solution

1. Check circuit connections, device model parameters used, expected operating regions 
of the devices, etc.

2. Set initial conditions, relax the tolerance parameters, use GMIN stepping (for DC 
convergence problems), etc.
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Time step is too small in Transient Analysis at xxx

The simulation must terminate due to the time step needed for convergence becoming too 
small.

Solution

1. Check for the following possible causes:

❑ waveforms with very fast rise/fall times

❑ model parameters completely wrong

 

Missing or invalid expression

An expression was expected, but was either missing or invalid.

Solution

1. Make sure that expressions are enclosed in '{' and '}' characters and that any '(' 
characters have a matching ')' character. 

2. Make sure that continuation lines have a '+' character in the first column. 

3. If the netlist was generated by Capture, contact the Customer Support.

 

Missing expression

An expression was expected, but was either missing or invalid.

Solution 

1. Make sure that expressions are enclosed in '{' and '}' characters and that any '(' 
characters have a matching ')' character. 

2. Make sure that continuation lines have a '+' character in the first column. 

3. If the netlist was generated by Capture, contact the Customer Support.
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Bad radix spec

In a digital stimulus device, the radix specified was not one of the permitted values: 1, 3 or 4.

Solution

1. Correct the radix.

 

LABEL invalid in REPEAT loop

In a digital stimulus device, a LABEL: appeared in a REPEAT ... ENDREPEAT construct.

Solution

1. Remove the label.

 

Missing goto label

In a digital stimulus device, a GOTO was encountered but the target label was missing.

Solution

1. Correct the statement.

 

GOTO invalid in REPEAT loop

In a digital stimulus device, a GOTO appeared in a REPEAT ... ENDREPEAT construct.

Solution

1. Remove the GOTO.
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HREPEAT missing FOR or FOREVER

In a digital stimulus device, a REPEAT appeared but one of the two required keywords FOR 
or FOREVER was missing.

Solution

1. Correct the specification.

 

Attempt to redefine builtin name

In a .FUNC statement, a reserved macro name such as 'SQRT()' was being redefined.

Solution

1. Refer to the Reference manual for the list of reserved macro names and avoid redefining 
them.

 

Must be D

In a .PRINT/DCTLCHG statement, a request for a voltage or current was indicated.

Solution

1. Make sure only digital nodes are printed with a .PRINT/DGTLCHG statement.

 

Must be I or V or D

In a .PRINT TRAN statement, only currents, voltages, and digital states can be printed.

Solution

1. Correct the statement.
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Must be I or V

In a .PRINT AC or .PRINT DC, only currents and voltages can be printed.

Solution

1. Correct the statement.

 

Must be V

In a .PRINT NOISE statement, only voltages can be printed.

Solution

1. Correct the statement.

 

Must be I or V, D not allowed

In a .PRINT AC or .PRINT DC, only currents and voltages can be printed.

Solution

1. Correct the statement.

 

Expression not allowed here

In a PLSYN device, a TESTVECTOR parameter was specified as a {parameter}.

Solution

1. Change the {parameter} to a literal constant.
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Unknown parameter

In a RAM, ROM or PLD device, an unknown parameter was entered.

Solution

1. Check the spelling of all parameters and correct as necessary.

 

Probability must not be less than 0.

In a .DISTRIBUTION statement a probability was less than 0.

Solution

1. Make sure all probabilities are between 0 and 1 inclusive.

 

At least two pairs of numbers necessary

In a .DISTRIBUTION statement, at least two (probability, value) pairs must be entered.

Solution

1. Make sure you have at least two pairs.

 

Please simplify .. distribution too complicated

In a .DISTRIBUTION statement, more than 100 (probability, value) pairs were entered.

Solution

1. Reduce the complexity of the expression.
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Use RLGC & LEN for lossy line

A lossy transmission line was specified and a either Z0 or TD parameter was entered.

Solution

1. Remove the Z0 or TD parameter; lossy transmission lines are characterized with the R, 
L, G, G and LEN parameters.

 

Use Z0 & TD or F/NL for ideal line

An ideal transmission line was specified and a Lossy parameter was entered.

Solution

1. Remove the Lossy parameter; ideal transmission lines are characterized with the Z0, TD, 
F and NL parameters.

 

Z0 or RLGC parameters must be specified

Transmission lines require either Z0 or R, L, G, and C to be set.

Solution

1. Enter a value for Z0 if ideal, or for R, L, G, and C if lossy.

 

TD or F must be specified

An ideal transmission line was specified, but neither TD nor F was entered.

Solution

1. Enter a value for either TD or F.
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BadTransferFunction

An E or G device was entered and LAPLACE was specified for it. The laplace expression was 
invalid.

Solution

1. Correct the expression.

 

Missing REPEAT iteration count

In a PWL type Voltage or Current source, the REPEAT iteration count was missing.

Solution

1. Correct the device specification.

 

Symbols Table overflow

You have too many devices to simulate with the memory available.

Solution

1. Give PSpice more memory:

❑ If you are running other programs concurrently with PSpice, close them and try 
again. 

❑ Add more memory for your computer.

Voltage Source and/or Inductor Loop Involving xxx

This may be caused by a loop constructed with a combination of voltage sources and/or 
inductors.

Solution

1. Break the loop by adding a series resistance.
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Convergence problem

PSpice could not derive values for the node voltages or device currents that satisfy the 
convergence criteria used.

Solution

1. Check circuit connections, device model parameters used, expected operating regions 
of the devices, etc.

2. Set initial conditions, relax the tolerance parameters, use GMIN stepping (for DC 
convergence problems), etc.

Convergence problem

PSpice could not derive values for the node voltages or device currents that satisfy the 
convergence criteria used.

Solution

1. Check circuit connections, device model parameters used, expected operating regions 
of the devices, etc.

2. Set initial conditions, relax the tolerance parameters, use GMIN stepping (for DC 
convergence problems), etc.

 

Invalid Outside of .SUBCKT

A .ENDS statement was encountered, but a subcircuit was not being defined.

Solution

1. Remove the .ENDS statement or, if it was intended to mark the end of the circuit, change 
it to .END.
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Library Index File Does Not Have the Correct Format

The index file shown is corrupt.

Solution

1. Delete the index file shown.  This will cause it to be rebuilt in the correct format.

Unable to Find Library File

The specified library could not be found.

Solution

1. Check the spelling of the file name.

Library File Has Changed Since Index File Was Created

The specified library file was modified since its index file was last created.

Solution

PSpice will automatically recreate the associated index file.

The Timestamp Changed from xxx to yyy

The specified library file was modified since its index file was last created.

Solution

PSpice will automatically recreate the associated index file.
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Model <modelname> Used by <filename> Is Undefined

The identified model is not defined in either the circuit file or any of the referenced libraries.

Solution

1. Make sure the model name is spelled correctly. 

2. If necessary, add the name of the library in which it can be found.

Missing param name in library

During the process of building the index file for a library file, a .PARAM statement was 
encountered which did not have a parameter name.

Solution

1. Correct the .PARAM statement. The basic syntax is:

 .PARAM  name = value

There Are No Devices in This Circuit (This Message Will Be Printed)

Multiple circuits may be simulated from a single file. After each .END statement is 
encountered and the simulation has been completed, PSpice will continue to read the input 
file for any subsequent circuits. If any data is read but no valid devices exist when the end of 
file is reached, this message is issued.

Solution

1. Remove blank lines after the last .END statement in the circuit file.

Only one .TEMP value allowed with .STEP

If you have a .STEP command, there may be a .TEMP command specifying only a single 
temperature.

Solution
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1. Remove all but the first temperature listed in the .TEMP statement.

Only one .TEMP, .DC TEMP, or .STEP TEMP permitted

The temperature(s) at which a circuit may be simulated can be set in exactly one of three 
ways.  Two or more different ways have been specified.

Solution

1. Remove all but one of the .TEMP, .DC TEMP and .STEP TEMP statements.

Unable to open file

In a .INCLUDE ... FILE = ... statement, the specified file name could not be found.

Solution

1. Correct the spelling of the file name.

Missing .ENDS in .SUBCKT

The file ended during the processing of a subcircuit definition before the .ENDS statement 
was encountered.

Solution

1. Insert a .ENDS statement at the appropriate place in the file.

Name on .ENDS does not match .SUBCKT

A subcircuit was being processed.  The last line of a subcircuit is the .ENDS statement, which 
may optionally have a name.  This name must be identical to the subcircuit name if it is 
present.
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Solution

1. Remove the offending name from the .ENDS statement.

Invalid device in subcircuit

While processing a subcircuit, an unknown device was encountered.

Solution

1. Correct the spelling of the device name.

Subcircuit <filename> is Undefined

The indicated subcircuit could not be found in the circuit file or any of the libraries.

Solution

1. Check the spelling and correct as required. 

2. Add the name of the library in which it is defined to the library list.

Incorrect Number of Interface Nodes for <filename>

The subcircuit was defined with a different number of interface nodes than were listed when 
an instance was placed.

Solution

1. Make sure that the definition and the reference to the subcircuit have the same number 
of nodes.

Digital Simulator Option not present

The Digital Simulator Option must be purchased to use this feature.
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Solution

1. Contact Cadence to purchase the Digital Simulator Option.

Cannot Open Temporary Digital File

One or more temporary files required by the digital simulator could not be opened.

Solution

1. Increase the FILES= value in the C:\CONFIG.SYS file.

2. If this does not solve the problem, contact Customer Support.

Missing model

A model name was expected on a device statement, but was missing.

Solution

1. Correct the statement.

 

Missing number of nodes

In a Pin Delay Device (U... PINDLY), the number of nodes parameter was missing.

Solution

1. Correct the statement.

Too few output nodes specified

In a Pin Delay Device (U... PINDLY), the number of output nodes parameter was missing.
June 2020 403 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



PSpice Help
Solution

1. Correct the statement.

Bad or missing parameter

In a Digital Stimulus Device (U... STIM ...), one of the required parameters was either invalid 
or missing entirely.

Solution

1. Correct the statement.

Invalid value

In a Digital Stimulus Device (U... STIM ...), one of the states specified was not 0, 1, R, F, X, 
or Z.

Solution

1. Correct the state value.

Undefined parameter used in expression

In an expression, a reference was made to a parameter which was neither one of the 
predefined ones, nor one defined in a .PARAM statement.

Solution

1. Make sure the spelling of all parameters within the expression is correct.
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Undefined Parameter: <parameter>

In an expression, a reference was made to this parameter which was neither one of the 
predefined ones, nor one defined in a .PARAM statement.

Solution

1. Make sure the spelling of all parameters within the expression is correct.

I(node) is not valid

In a .PRINT ... statement, an attempt was made to print a current at a node.

Solution

1. Correct the statement. You can only print currents through a device and voltages at 
nodes or device pins.

Must be independent source (I or V)

In a .PRINT ... statement, only a voltage source or current source is allowed.

Solution

1. Correct the statement.

 

Digital node table overflow

There are too many digital nodes to simulate with the memory available.

Solution

1. Allocate more memory to PSpice by doing one of the following:

❑ If you are running other programs concurrently with PSpice, close them and try to 
simulate again. 
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❑ Purchase more memory for your computer.

Missing parameter

A parameter was expected in a .AC or .DC statement, but was missing.

Solution

1. Correct the statement.

Not a valid parameter for model type

A parameter in a .MODEL statement was misspelled.

Solution

1. Correct the spelling.

Must be 'I' or 'V'

In a .DC or .STEP DC, an attempt was made to sweep some device other than a voltage or 
current source.

Solution

1. Change the device you want swept to a voltage or current source.

Missing node number

In an .IC or .NODESET statement, the node number to be set was not specified.

Solution

1. Correct the statement.
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Missing device name

In an .IC or .NODESET statement, the device whose node was to be set was not specified.

Solution

1. Correct the statement.

Analog simulator option not present

The statement requires analog simulator option, but that option is not installed.

Solution

1. Contact Cadence to purchase the analog simulator option.

Invalid parameter

For a device other than a MOSFET or IGBT, a parameter was entered that is specific to these 
two devices.

Solution

1. Correct the device.

Inductor part of this K device

In a K (Coupling) device, the same Inductor was entered twice.

Solution

1. Delete the second inductor reference.
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Inductor part of another core device

The same inductor appears in more than one K (Core) device.

Solution

1. Remove the reference in the second K device.

Transmission line part of this K device

In a K (Coupling) device, the same Transmission Line was entered twice.

Solution

1. Delete the second reference.

Invalid specification

In a voltage source or current source, the transient specification was not EXP, PULSE, PWL, 
SFFM, or SIN.

Solution

1. Correct the transient specification.

 

Bad value

A floating point value was expected, but an invalid number was encountered.

Solution

1. See the online PSpice Reference Manual for the format of valid numbers, and correct the 
statement.
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Invalid number

An invalid floating point number was generated in the process of a calculation. The most 
common cause of this is a .MODEL parameter which is too far out of line.

Solution

1. Check all .MODEL parameters for correct scaling.  If the problem persists, contact 
Customer Support.

No analog devices--DC sweep ignored

The circuit has only digital devices. Digital devices are only simulated in the Transient (time-
domain) analysis.

Solution

1. Remove the .DC statement.

No analog devices--small-signal analysis Ignored

The circuit has only digital devices. Digital devices are only simulated in the Transient (time-
domain) analysis.

Solution

1. Remove the .AC, .OP, .SENS, .TF or .NOISE statement.

Missing value

An expected value is missing.

Solution

1. Make sure that continuation lines have a + character in the first column.

2. If the netlist was generated by Capture, contact Customer Support.
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EOF in subcircuit

During the definition of a subcircuit, an end-of-file condition was encountered. The file is 
probably corrupt.

Solution

1. Regenerate the file.
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Errors and Solutions

Unable to write to disk: check if disk is full

The program could not completely save a file.

Solution

Using Windows Explorer, check if the disk is full. If so, make room by deleting files and re-try 
the operation.

Unable to read from file - improper mode

This is an internal error.

Solution

Contact Customer Support.

Unable to write to file - improper mode

This is an internal error.

Solution

Contact Customer Support.

Cannot open file: filename

This error can occur while trying to load or save a file.

Solution

If loading a file, check:

■ That the file exists

■ That you have read access to the file

If saving a file, check:

■ That the existing file is not write-protected
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■ That you have write privilege to the drive and/or directory 

Cannot open directory for backup directory name

While creating a backup copy of a file, the backup directory specified by the BACKUP setting 
in the pspice.ini configuration file did not exist. The program attempts to create such a 
directory. If it is unable to create it, you will get this error.

Solution

Check the BACKUP setting in your pspice.ini file. Create the directory then re-try the 
operation.

File error, fseek failed

This is an internal error.

Solution

Contact Customer Support.

File error, ftell failed

This is an internal error.

Solution

Contact Customer Support.

File error, cannot reopen

This is an internal error.

Solution

Contact Customer Support.

Previous error in opening file

This is an internal error.
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Solution

Contact Customer Support.

Backup failed: Permission denied to file

The program was unable to complete making a backup copy of a file. Possible causes:

■ The disk or directory where the backup is being made is write-protected

■ Another user is making a backup of the same file at the same time

Solution

Check that you have write privileges to the backup directory.

Check if another user is editing a schematic with the same name. In general, each user 
should use a separate backup directory (specified in your pspice.ini file).

Backup failed: Bad file number

This is an internal error.

Solution

Contact Customer Support.

Backup failed: Cannot write to file

The program was unable to complete making a backup copy of a file. Possible causes:

■ The disk where the backup is being made (specified by the BACKUP entry in pspice.ini) 
is full

■ The disk or directory where the backup is being made is write-protected

Solution

Check if the disk is full. If so, free up space and re-try the operation.

Check that you have write privileges to the backup directory.
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Extension can only have up to three characters

You specified a file name with an extension of more than three characters.

Solution

Specify an extension with 3 or less characters following the ‘.’.

Filenames can have only up to eight characters

The program only supports file names with up to eight characters, not including the extension.

Solution

Specify a name with 8 or less characters.

File name contains an invalid character

A file name with a ‘.’ (other than the one preceding the extension) was specified.

Solution

Remove the ‘.’ and re-try the operation

Blanks are not allowed in file names

File names with embedded spaces are not supported

Solution

Remove the spaces and re-try the operation

Directory in path does not exist

The directory specified for the file does not exist.

No filename?!

You must specify a file name.
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Cannot open temporary file

The program could not create a temporary file. 

Solution

Check the following:

1. The TMP environment (set in your AUTOEXEC.BAT) setting to be sure it is a directory 
that exists

2. Check that you have write access to the drive/directory if you are on a network.

If you are still unable to create temporary files, call Customer Support.
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